
Notre Dame Law School Notre Dame Law School 

NDLScholarship NDLScholarship 

Indiana Continuing Legal Education Forum 
2021 Indiana Continuing Legal Education Forum 

1-1-2021 

Making Technology Work For You Making Technology Work For You 

Indiana Continuing Legal Education Forum (ICLEF) 

Follow this and additional works at: https://scholarship.law.nd.edu/iclef_2021 

Recommended Citation Recommended Citation 
Indiana Continuing Legal Education Forum (ICLEF), "Making Technology Work For You" (2021). Indiana 
Continuing Legal Education Forum 2021. 45. 
https://scholarship.law.nd.edu/iclef_2021/45 

This Article is brought to you for free and open access by the Indiana Continuing Legal Education Forum at 
NDLScholarship. It has been accepted for inclusion in Indiana Continuing Legal Education Forum 2021 by an 
authorized administrator of NDLScholarship. For more information, please contact lawdr@nd.edu. 

https://scholarship.law.nd.edu/
https://scholarship.law.nd.edu/iclef_2021
https://scholarship.law.nd.edu/iclef_2021
https://scholarship.law.nd.edu/iclef
https://scholarship.law.nd.edu/iclef_2021?utm_source=scholarship.law.nd.edu%2Ficlef_2021%2F45&utm_medium=PDF&utm_campaign=PDFCoverPages
https://scholarship.law.nd.edu/iclef_2021/45?utm_source=scholarship.law.nd.edu%2Ficlef_2021%2F45&utm_medium=PDF&utm_campaign=PDFCoverPages
mailto:lawdr@nd.edu


____

Making Technology Work For You
May 5, 2021
Index

ICLEF Electronic Publications. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

          I. Notice makes the text look like this:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

MANUAL - Making Technology Work For You  May 5, 2021. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Agenda. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Presenter contact information. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Presenter bio. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
2021-04-29 - How To Format Complex Pleadings.pdf. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
     1. Formatting Complex Pleadings in Microsoft Word. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
     Formatting Complex Pleadings in Microsoft Word Table of Contents. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
     Formatting Complex Pleadings in Microsoft Word. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
     I. Architecture of the Template. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          A. Section 1 - Title Page:  This is the first page of the template and it is not page numbered.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          B. Section 2:  This is comprised of the following.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. Disclosure Statement:  This is page numbered with Romanettes.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Table of Contents:  This is page numbered with Romanettes.  The TOC can be automatically updated to reflect any changes in the document by simply hitting Ctrl+A (which selects the entire document) and hitting the F9 key (which updates all fields).. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               3. Table of Authorities:  This is also consecutively page numbered with Romanettes.  There’s currently no TOA in the template b. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          C. Section 3 - Body of the Brief:  This is the body of the brief which contains titled sections and a 4 level deep, auto-paragraph numbered outline.  The page numbering starts over here at Arabic page 1 and continues consecutively for the rest of the .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. Jurisdictional Statement. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Statement of the Issues. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               3. Statement of the Case. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               4. Summary Of The Argument. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               5. Argument. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               6. Conclusion. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               7. Certificate of Compliance. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               8. Certificate of Service. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               9. Required Short Appendix. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
     II. Styles in General. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          A. What Are Styles?  A style is a set of formatting characteristics that you can apply to text, tables, and lists in your document to quickly change their appearance. When you apply a style, you apply a whole group of formats at once.  A useful way to.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          B. Open The Styles Pane:  In Word for Windows, you can view styles by clicking the Home ribbon ( Styles launcher to reveal the Styles pane (see Figure 1 below).  You can also use the speed key Alt+Shift+Ctrl+S.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          C. All-Important Rules of Styles:  It's critical that you keep the following rules in mind.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. Every Instance of Unique Formatting Requires a Different Style:  When you just type in a document, Word automatically applies the Normal style to the text. However, in order to properly use styles, you need to apply a different style to each type o.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Word Uses Styles Without Your Knowledge or Consent:  When you type text into a document, Word automatically applies a specific style depending upon where your cursor is and what you're doing. For example, if you're in a header, Word automatically a.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               3. There is No Off Button:  I've heard many people tell me that they don't use styles in Word. That's impossible because you can't turn styles off and as described in the previous rule, Word applies them automatically. It's impossible to have text in .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               4. If You Don't Control Styles, They Control You:  This is about as blunt as I can get. Styles will always win the formatting battle. All of the direct formatting in the world isn't going to change that. So you're infinitely better off learning how to.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               5. Every Document Has 247 Styles Built In:  When you create a new document in Word, there are 247 styles already in the document although only a small subset might actually be used. We refer these built-in styles as "System" styles. To see all of thes.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    a. Open the styles pane ( click the Options link (bottom, right corner of the Styles pane) ( under "Select styles to show:" choose All Styles ( under "Select how list is sorted:" choose Alphabetical ( clear every checkbox in this dialog ( click OK. Al.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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               6. You Can't Delete System Styles But You Can Change What They Do:  Any system style can be altered so that it produces the formatting you want.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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               8. The Style Inspector Will Make All Of This Much Easier:  NOTE that this is only available in Word for Windows and not in Word for Mac.  If you're not sure what style is being applied to text in your document, just follow these steps to find out: Ope.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               9. Once a Style Is Applied to Text, You Can Change The Text By Modifying The Style:  Let's say you have 50 footnotes in your document and you don't like how they look. There's a style called Footnote Text which Word automatically applies to every foot.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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          D. Generate a Table of Authorities Based on Your Marked Citations:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. Place the cursor where you want to insert the table of authorities.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Select References ribbon ( Table of Authorities group ( Insert Table of Authorities button.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               3. Pick the desired format.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               4. Deselect the Use passim option.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               5. Deselect the Keep original formatting option.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               6. Select All under Category so that Cases, Statutes, etc. will appear in the table of authorities.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               7. Click OK to insert the table of authorities.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          E. Page Number Warning:  NOTE: When the Table of Authorities fields are visible (Show/Hide is turned on), the page numbers will not accurately reflect the actual page numbers of the document. This is because the Table of Authorities fields, when visib.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          F. Editing Table of Authorities Entries by Editing TOA Fields:  Microsoft Word "marks" entries by placing a Table of Authorities field immediately before or after the citation. There are two types of Table of Authorities fields (1) long citation field.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. Long Citation Fields:  Long citation fields are used by Word to mark the first instance of a citation. Long citation fields have the following format:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    a. TA = the field code for Table of Authorities. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    b. \l "Smith v. Jones (1988), 85 Ohio St.3d 123, 54 N.E.2d 98" = how the Table of Authorities entry should be displayed in the actual Table of Authorities (see Long citation in the adjacent screen shot).. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    c. \s = short citation form that Word will use to search for and mark additional entries.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    d. \c = the category of the citation - for example State Court Cases (see below). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Short Citation Fields:  Short citation fields are used by Word to mark additional instances of a citation in a document. Short citation fields have the following format:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               3. How Word uses Long and Short Citation Fields:  Word uses the long citation field to mark the first instance of a citation, and the short citation field to mark additional instances. Therefore, there should be only one long citation field per unique.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               4. Changing the format or text of the case citation in the Table of Authorities:  Edit the long citation field to change the format or text of a case citation entry in the Table of Authorities. So for example, if the case name has to be in italics in .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               5. Table of Authorities Styles:  There are two Table of Authorities styles to be aware of (1) Table of Authorities, and (2) TOA Heading. These two styles control how the Table of Authorities is actually formatted. So, for example, to add a space betwe.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               6. Changing a Citation's Category:  Sometimes a citation gets placed into the wrong category. For example, a case gets marked as a statute. To change a citation's category, edit the long citation field, and change the category to the correct number. F.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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          C. Click the Next Citation button until you land on the case .  Select Clark v. Cmt’y for Creative Non-Violence, 468 U.S. 288, . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

          E. Spam Getting Through: There are lots of ways to avoid SPAM, and yet it still manages to get into our mailboxes.  What can you do about it?. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

          D. Mark the rest of the citations.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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               2. Check Spelling Automatically:  Under Compose Messages, check Always check spelling…. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               3. Set up your Signature Block:  Click the File menu ( Options button ( Mail tab (left side) ( Signatures button.  It is recommended that you have some kind of signature automatically attached to every new message and every reply/forward.  However, th.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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               5. Tweak The Reading Pane:  If you click on an email to read it in the Reading Pane, Outlook will toggle the email as having been read and it will no longer be bold.  Many people have complained about this.  If you would prefer that emails remain iden.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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               7. Open Email In a New Window:  In Outlook 2016 and more recent, when you reply to an email, it opens it the reading pane rathe. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               8. Close Original Messages When Replying or Forwarding:  Under Replies and forwards, check the box shown below:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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               1. Change Work Start and End Hours:  If you work different hours than Outlook’s defaults, you can change them under Work time.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Default Reminder Timing:  Many people want more than 15 minute reminders for appointments.  Below Calendar Options is where you can change that.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               3. Change Calendar Color:  Under Display Options, you can change the calendar color to another pastel.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               4. Add Second Time Zone To Calendar:  If you often have to set meetings with people in another time zone, you can add that zone to your calendar.  Check the box below, choose the time zone you want and label it.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          C. Changes to People Settings:  Note that you get to this setting by clicking the File menu ( Options ( People.  You’ll probabl. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          D. Changes to Advanced Settings:  Note that you get to these settings by clicking the File menu ( Options ( Advanced.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. AutoArchive Settings:  There are many ways to get to these settings, but click the AutoArchive Settings button will allow you to turn on or off these settings and customize them as well.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Change Your Reminder Sound:  If you would prefer another sound as a reminder, you can make the change under Reminders.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          E. Changes to the Quick Access Toolbar:  Note that you get to this setting by clicking the File menu ( Options ( Quick Access T. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
     II. Outlook Email Interface Improvements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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               1. Turn Off Reading Pane Or Dock It On The Right:  If this is at the bottom of the screen, it is going to occupy a lot of space that could otherwise be showing you email.  To turn it off or move it, click the View ribbon ( Reading Pane button ( Off or.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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          B. Add Conditional Formatting:  This feature allows you to change the color, font or size of your email based upon certain conditions (for example, if the email is from a certain person or group of people, you could have those emails automatically tur.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          C. Sort Your Email:  If you click on a column name, it will sort your email by that criteria (Received, for example).  If you click the same column name again, it will sort in reverse order.  You can also change how email is sorted by clicking the app.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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               4. Difficulties Searching: Many people complain that it's nearly impossible to efficiently search old emails for a particular conversation.  What can you do to make this task easier?. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          B. Start By Organizing Outlook: Setting up folders and using Rules is a great way to start to organize your Outlook.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. How To Set Up a New Email Folder: To Setup a new Subfolder in your Inbox, right-click the Inbox (or your mailbox) ( New Fold. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Outlook Rules: Rules allow you to auto-sort incoming email (among other things).  Here's how you set one up:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               3. Sample Rule - Get Notified If Certain People Email You Even Though Notifications Are Turned Off:  For purposes of this rule, assume I want to be notified if Paul Unger or Debbie Foster send me an email.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               4. Sample Rule - Delay Sent Mail By One Minute (in case you change your mind). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               5. Sample Rule - Keep Track of Delegated Email: Many people forward email to others to deal with but have a difficult time remembering what they delegated for follow up purposes.  Here's a rule that will help.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          C. Outlook Add-On Programs To Help You Sort and Store Your Email: There are many third-party programs that integrate with Outlook which can help you organize, sort and store your email (both incoming and outgoing).  Here are a few to consider:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. SpeedFiler by Claritude: See www.claritude.com.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. SimplyFile by TechHit: See www.techhit.com/simplyfile.  T. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               3. Incoming Mail Organizer Add-In for Microsoft Outlook:  See http://www.sperrysoftware.com/Outlook/Incoming-Mail-Organizer.asp.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               4. NEO Pro:  See http://www.emailorganizer.com/. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               5. Quick File for Outlook:  See http://www.standss.com/quickfile/. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               6. Sanebox:  See http://www.sanebox.com/. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               7. QuickFile4Outlook - Lawyers Edition: See www.outlook4lawyers.com.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          D. Archiving Old Outlook Email: Many Outlook users end up with an enormous accumulation of email in their Sent Mail and Deleted Mail folders.  Furthermore, some mail is sorted into subfolders and forgotten about.  All of this will start to bog down se.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. Turn AutoArchive On or Off. Click the File menu ( Outlook Options ( Advanced (left side) ( AutoArchive Settings button.  At the top of the following dialog, you'll see "Run AutoArchive every __ days."  If you uncheck that box, it will not run.  As .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Control the Archive Settings of a Specific Folder: You can control what any particular folder does in Outlook by following these steps:  Right-click the folder ( choose Properties ( click the AutoArchive tab ( Make your changes and click OK.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          E. Saving Email Messages Outside of Outlook: When an email message is in your Outlook inbox, it is just a record in a database and not a discreet document like a Word file.  That fact is a big part of the problem associated with organizing and storing.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. Saving Email As A Document: The classic problem that law firms have if they do not own a document management system is saving and finding matter-specific email.  Why?  Because people (1) keep them in their individual inboxes, or (2) save them in su.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Saving Email By Dragging Into a Windows Explorer Folder: You can clean out your inbox or subfolders under your inbox by cascading the windows and simply dragging and dropping all of them into the desired folder.  This will COPY the emails over into.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               3. Saving Email With Document Management Programs (DMS): While document management programs (Worldox, iManage Word, NetDocuments, etc.) were originally thought of as only word processing document repositories, that is no longer true.  They can now hol.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               4. Worldox Example: Using Worldox as an example, it provides 3 different ways to save emails (see below).  Once profiled and saved, the emails are stored within the client/matter structure and easily searchable and accessible by anyone who uses the do.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    a. Save Email From Within Outlook - Drag and Drop: Saving to Worldox from within Outlook – Drag and Drop on the Worldox "folder. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    b. Save Email From Within Outlook Using Worldox - Copy or Move Buttons: The Worldox/Outlook integration also provides Copy To Worldox or Move to Worldox buttons (located in the toolbar region of Outlook).  Simply select the email(s) you want to save i.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    c. Save Email From Within Worldox: Saving email from the Worldox Email Tab which allows you to see your Outlook inbox from within Worldox.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               5. Saving Email Using a Case/Practice Management Program: This would include programs like Amicus Attorney, Time Matters, PracticeMaster, etc.  If you have a case management program with Outlook integration, you can streamline the saving of email by s.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               6. Amicus Attorney Example: The following is an example of the Amicus Attorney Communications area which allows you to save and manage email, messages and telephone slips:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               7. Saving Email as PDF Files: If you have a compatible version of Adobe Acrobat, it installs a few buttons and one additional menu in Microsoft Outlook.  For those that wish they had a good way to archive and store emails and attachments, this integra.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    a. Acrobat - Creating PDFs from Individual Emails or Entire Folders: Simply select individual emails (Ctrl + left click) or select entire folders; then click the Adobe PDF menu/ribbon ( Convert Selected Messages ( Create New PDF.  This will create a s.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    b. Acrobat - Adding Subsequent Emails to Existing PDFs: If you receive additional emails which need to be added to an existing PDF archive, simply choose Convert Selected Messages ( Append to Existing Adobe PDF.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    c. Acrobat - Automatic Archival: As you can see from the screen shot, you can also setup folders to automatically archive themselves.  This would be particularly useful if you have setup Outlook rules to automatically sort your email into specific fol.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    d. Saving PDFs Without Acrobat: Other PDF programs that cost a lot less than Acrobat offer similar functionality to that described above with Outlook.  For example, all of the following are fantastic:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
i. Nuance Power PDF Advanced:  Matches features of Acrobat Professional for only $180.  See http://tinyurl.com/zwy2ym9.  Windows only.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
ii. Nuance Power PDF Standard:  Matches features of Acrobat Standard for only $100.  See http://tinyurl.com/nbtnasl.  Windows only.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
iii. Foxit PhantomPDF for Business:  Very strong feature match with Acrobat Pro for $159.  Also includes a 30 day free trial.  For more information, see http://tinyurl.com/7ybcjwu.   Windows only.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
iv. Foxit PhantomPDF Standard:  Strong match with Acrobat Standard for $129.  Free trial - for more information, see http://tinyurl.com/p3znuj3.  Windows only.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
v. Nitro Pro:  Matches the features of Acrobat Professional.  They offer a Nitro Pro+ which is rental only for $7.99/month ($95.88 paid annually - no option to pay monthly) and Nitro Pro (desktop) which is $159.99.  You can buy it here: https://www.go.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          F. Email Storage Tips:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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          W. Default Outlook To Your Contacts Address Book:  When you click the TO button in a new Outlook email, if you have Microsoft Exchange, it defaults to Global Address List which is your internal contact list.  This forces you to switch to "Contacts" fr.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

          H. Outlook Techniques Which Will Help:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. See More Email In One Screen:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    a. Turn Off Viewing Pane: This occupies a lot of screen space that could otherwise be displaying email.  To turn it off in Outlook 2007, click the View menu ( Reading Pane ( Off.  In Outlook 2010/13/16/19/365, click the View ribbon ( Reading Pane butt.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    b. Turn Off Date Grouping: By default, Outlook groups your email by date received.  The date categories just occupy space and prevent you from seeing all of your email on one screen.  To turn it off in Outlook 2007, click the View menu ( Arrange By ( .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Quickly Convert Email to Appointments or Tasks: You can simply drag email onto your calendar or tasks button in Outlook and it will make an appointment or task out of it (but it leaves your original email where it was).. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               3. Tasks in Outlook:  Name your tasks based on Project first, and then a hyphen followed by a description of the work.  Then modify your task list to show only active tasks (not completed).  To do this, select Active Tasks and then Customize Current V.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               4. Use Outlook 2007/10 Categories: This is a new feature in Outlook 2007 and is extremely useful for flagging email.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
     VII. Other Outlook Tips and Tricks:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          A. Outlook 2013/16/19/365 Quick Reference Sheet:  See Exhibit A on page 45 below.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          B. Create Contacts from Email: Drag and drop an email to the Contacts button and Outlook will create a new contact card for that email sender.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          C. Right-Click Email for All Possible Options: Also known as alternate clicking, this feature will present very handy functions such as Open, Reply, Print, Forward, etc.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          D. Rules Creating Flags and Alerts: You can manage multiple email accounts or large numbers of emails from an important client by setting up a Rule that tags the email with a colored flag/alert or plays a special sound upon arrival.  This will enable .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          E. Out of Office Assistant/Automatic Replies: If you're going to be out of the office, this is a way to automatically notify people who send you email.  However, if you're receiving email from a listserv, this may be a problem because every time someo.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          F. Learn To Use Categories:  This feature allows you to color code or tag an appointment, email, contact, or task with a named category which has a color assigned to it.  I find these to be particularly useful with appointments and email.  Assigning a.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. Right-click an appointment you have billed.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Choose Categorize ( All Categories. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               3. Click the NEW button and create a category as follows:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               4. Click OK ( OK.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          G. View Non-Contiguous Days on Your Calendar Side By Side:  A business associate wants to schedule a lunch on a Thursday in Oct. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. Go to your Outlook calendar and click on the DAY button.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Left-click on the first Thursday in October.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               3. Now hold down on the Ctrl key and left click the rest of the Thursdays in October.  You’ll see all of them side-by-side and . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          H. Move An Appointment By Dragging It:  If an appointment gets moved, the easiest way to make the change on your calendar is by. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          I. Saving Attachments to Email:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. One At A Time: Open the email, right click the attachment and choose Save As.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. In Bulk:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          J. Distribution Lists (Outlook 2007)/Contact Groups (Outlook 2010/13/16/19/365): If you routinely send email to a group of people, you can create a distribution list or contact group which will make it much easier.  For example, I have a Contact Group.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          K. Find Contacts Super-Fast: For the Quick Contact Search, just hit the F11 key and type in a first or last name.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          L. Edit The Auto-Complete List: If you send an email to a person one time, then Outlook will remember their email address the next time you start typing anything that begins with the first letters of that person's email address.  This has resulted in .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          M. Use Rules and Alerts: To help you keep your Inbox to a manageable size, use the Rules feature to automatically forward, move to another folder, or delete incoming messages, especially those from email lists. In Outlook 2007, Tools menu ( Rules Wiza.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          N. Mailbox Cleanup: This is an extremely useful tool.  In Outlook 2007, you access it by clicking Tools menu ( Mailbox Cleanup.  In Outlook 2010/13/16/19/365, you access it by clicking File menu ( Info tab (left side) ( Cleanup Tools button.  See belo.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          O. Remove Redundant Messages in Outlook 2010/13/16/19/365:  This is a feature only present in Outlook 2010/13/16/19/365.  An email conversation is also known as a thread.  Many people have multiple emails in their Outlook folders which are earlier pie.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. On the home ribbon, click the Clean Up button in the Delete group.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Click one of the following:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    a. Clean Up Conversation:  The current Conversation is reviewed, and redundant messages are deleted.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    b. Clean Up Folder:  All Conversations in the selected folder are reviewed, and redundant messages are deleted.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    c. Clean Up Folder & Subfolders:  All Conversations in the selected folder and any folder that it contains are reviewed, and redundant messages are deleted.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          P. Open Multiple Time Zones in Your Outlook Calendar:  I'm often trying to schedule phone conferences with people in time zones other than the one I live in (eastern).  Outlook has a great way to make this easier on you by opening another time zone ad.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. Open your calendar in Outlook.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Right-click the vertical time bar on the left side of the calendar and choose Change Time Zone.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               3. Check the Show a second time zone box and choose the time zone you want to show, add a label, and click OK.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               4. Now you'll have two zones side-by-side!. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          Q. Advanced Search Capability: This feature gives you a tremendous number of options for searching through Outlook.  Simply hit Ctrl + Shift + F.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          R. Email Quick Search in Outlook 2010/13/16/19/365:  At the top of each mail folder, you'll see a box like the one below:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          S. Junk Mail Settings: In Outlook 2007, click the Tools menu ( Options ( Preferences tab ( Junk Email button to see all of the settings for this.  You can get to the same dialog in Outlook 2010/13/16/19/365 by clicking on Mail ( Junk button in the Del.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          T. Block Senders:  The easiest way to do this is to right-click an email from a sender you want to block in the future.  In Outlook 2007, choose Junk Email ( Add Sender to Blocked Senders List.  In Outlook 2010/13/16/19/365, right-click the email, cho.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          U. Flags: Flags are a great way to alert you to follow up on an important email, especially if your plan is to delay action with the email for a day or so.  Simply right-click on the desired email and select Follow Up and then select the desired follo.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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          A. Speech Recognition v. Voice Recognition:  Depending on whom you talk to, you may get different definitions for these terms.  Voice recognition is sometimes defined as recognition of individual words or a particular person's voice.  Speech recogniti.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

          C. Office Online:  There are web versions of Word, Excel, etc., that you can use whether or not you have a Microsoft 365 account.  They don't have all of the functionality of the desktop versions, but you can do a lot with them.  See http://tinyurl.co.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          D. Microsoft 365 Security:  You can read all about Microsoft 365's security at https://bit.ly/302P9el.  In a nutshell, Microsoft 365 offers top-notch security.  It has the same user-level security options and Trust Center as the desktop version of Off.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          E. Microsoft 365 Running Offline:  You can use Microsoft 365 offline (without internet access) if you download and install the desktop version of Office with your plan.  You have to connect to the internet every 30 days to maintain your subscription a.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          F. Microsoft 365 Administrative Functions:  As you can see from the screen shot below, the layout is logical and easy to understand.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
     II. Microsoft 365 Versions and Services:  I have given up trying to keep up with the incessant changes Microsoft makes to the O365 plans.  Here is a link to the latest summary of what is included in each of the business plans:  http://bit.ly/2qROE5g. .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
     III. Included Programs and Applications:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          A. Microsoft Exchange: This is included in some of the Microsoft 365 plans.  I would argue that this feature alone is worth the price of admission.  Microsoft Exchange is a program that, among other things, allows Outlook users to back up their data (.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. Share Data:  Exchange also allows users to share information in Outlook.  For example, I could allow someone else in my office to access my calendar electronically and add appointments.  If you're going to use an electronic calendar (which we recom.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Smartphone & Tablet Sync:  Exchange will wirelessly sync with any smartphone or tablet running Android, iOS, Blackberry OS or Windows Phone.  This means that everything in Outlook (contacts, tasks, calendar & email) will be available from any devic.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               3. Anywhere Email Access:  Exchange also allows users to gain access to office email while out of the office in many different devices.  For example, I can see my inbox, calendar & contacts on my iPad (or any tablet), on any Windows or Mac computer co.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               4. Full Back Up: Everything in Outlook is backed up in Exchange (email, contacts, calendar & tasks).. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               5. Operating System Agnostic:  Exchange and Outlook will work with both Windows and Mac computers.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          B. Delve: Office Delve is a cloud-based service powered by Office Graph, which helps users find and discover pertinent information across integrated Microsoft products by pulling user content from Microsoft Exchange, OneDrive for Business, SharePoint .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          C. Dynamics 365:  Microsoft recently took the wraps off of Microsoft Dynamics 365, a new cloud powered service that repackages and rebrands several Microsoft Dynamics programs into an offering that is both. The cloud-enabled Software-as-a-Service proj.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          D. Forms: According to Microsoft, "[w]ith Microsoft Forms, you can create surveys, quizzes, and polls, and easily see results as they come in. When you create a quiz or form, you can invite others to respond to it using any web browser, even on mobile.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          E. Kaizala:  According to Microsoft, "Kaizala is a phone-number based, simple, and secure mobile chat app that enables you to c. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          F. MyAnalytics:  According to Microsoft, "MyAnalytics provides insights into two of the key factors in personal productivity: how people spend their time and who they spend it with. You and your team can get these benefits after an administrator sets .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          G. OneDrive:  According to Microsoft, "Securely store and share files from anywhere. OneDrive offers native desktop, browser and mobile experiences on your devices. Access and make changes that sync automatically in the cloud or sync local copies of f.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          H. OneNote:  "Designed to function as an electronic version of a paper notebook, Microsoft OneNote is a note-taking and personal information management (PIM) application for collecting, organizing and sharing digital information.  By storing text note.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          I. Planner:  Take the chaos out of teamwork and get more done! Planner makes it easy for your team to create new plans, organiz. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. Easy to use:  Launch Planner from the Microsoft 365 app launcher with a single click. You can then create a new plan, build . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Organize work visually:  Each plan has its own board, where you can organize tasks into buckets. You can categorize tasks ba. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               3. Visibility and transparency:  The My Tasks view provides a comprehensive list of all your tasks and their status across all your plans. When working together on a plan, team members always know who is working on what.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               4. Collaborate around tasks:  Built for Microsoft 365, Planner lets you attach files to tasks, work together on those files, an. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               5. Works across devices:  Planner works across all your devices. And with Planner, everyone is always on the same page. A glance at Charts is all it takes to know where things stand and if the team is making enough progress towards their goal.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               6. Email notifications:  With Planner, you’ll never miss a beat! Receive email notifications whenever you’re assigned a new tas. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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          M. SharePoint:  "SharePoint is Microsoft’s premier collaborative server environment, providing tools for sharing documents and . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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                    c. Trigram - probability of three words appearing in a particular order.  Trigrams improve accuracy.  In 300,000,000 words analyzed in the Wall Street Journal there were 65,000,000 Trigrams that occurred only once.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
     II. Software:  There are several software products currently available for speech recognition.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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                    b. Dragon Home (for home and student use):  $75 This is not appropriate for use in a law firm.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    c. Dragon Professional Individual (for professional productivity and small business):  $500 is the list price, but pricing fluctuates wildly on Amazon - With powerful customization features, Dragon Professional Individual is ideal for professional ind.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    d. Dragon Professional Individual Wireless (for professional productivity and small business):  $400 - Same as Dragon Pro Individual above, except it includes a wireless Bluetooth headset.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    e. Dragon Legal Individual (for legal professionals and small practices):  $500 - With a specialized legal vocabulary, Dragon Legal Individual is the fastest way to streamline legal documentation and improve costs, simply by speaking. Whether buying f.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Mac Versions:  Unfortunately, Nuance abandoned speech recognition software for the Mac in 2018.  However, Dragon Anywhere (see next) works on an iPhone.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               3. Dragon Anywhere:  This is an app for any iOS or Android phone which allows you to dictate into your phone and have it automatically transcribed.  According to their website , Dragon Anywhere professional-grade mobile dictation makes it easy to crea.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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                    b. 99% accurate with powerful voice editing and formatting. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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                    d. Share documents by email, Dropbox, Evernote and more. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               4. Recommended Version:  We recommend that you go with Dragon Professional at a minimum.  If you dictate a lot of case & statutory citations and you use a Windows PC, then it would be worth getting Dragon Legal.  Otherwise, you can easily teach Dragon.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          B. BigHand:  BigHand has several speech recognition products that merit consideration.  See https://bit.ly/3dQIR6w for more information.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          C. Office Dictation:  If you subscribe to Microsoft 365, you get this in Word and Outlook for free.  It’s pretty accurate altho. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
     III. Hardware:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          A. Computer Requirements:  In order to use speech recognition software effectively, you will need some advanced hardware.  Comp. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          B. Microphones:  Of course, Dragon can be purchased with a microphone, but the base version does not include one.  Nuance used to publish microphone rankings but has stopped doing so.  They are instead trying to sell you their microphones (see https:/.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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                    b. Changing the Color of Text:  You can change the color of the text itself by either clicking on Font Color button  on the Home ribbon, or opening the Font dialog and changing Font color.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               4. Adding Comments: Comments are another useful way to annotate a document you intend to send to someone else for review.  To insert a written comment, follow these steps:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    a. Select the text you want to comment on.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    b. Go to the Review ribbon, then click New Comment.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    c. Type the comment text in the comment balloon in the right margin.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    d. You'll notice that the initials of the person making the comment are automatically inserted and that they're numbered.  If others add comments, Word will automatically change the color of their comments so that each person's comments are easily dis.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    e. In Word 2013/16/19/365, the comments look a bit different.  It inserts the entire name of the person making the comment and tells you how long ago the comment was inserted.  Furthermore, you can reply to a specific comment by clicking the small ico.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          B. You’ve Received a PDF Document: If you have Acrobat Standard or Pro, then you have plenty of annotation options at your disp. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. Adding a Sticky Note: Just follow these steps:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    a. Open the PDF you want to insert a comment into.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    b. Click the Sticky Note button on the Commenting toolbar (Acrobat 8 or 9) – or - under Comments ( Annotations (Acrobat X & XI). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    c. Click in the PDF document where you want to insert your comment and a comment dialog will appear.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    d. Type your comment, then hit the close X button in the top right hand corner to close it.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    e. After you close the comment, a  icon is left where your comment resides.  Just click on it and your comment will re-appear.  The comment also maintains your name and the date and time you entered it.  You can hold down on your mouse button while ho.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Add Text Edits to a PDF:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    a. First, open the PDF you want to annotate, click the  button and then select the text in the PDF you want to annotate.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    b. In Acrobat 8 or 9, click the Text Edits button and choose an option.  As you can see, there are plenty of choices!. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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               6. Deciding What You Want To See in Acrobat 8 or 9: By clicking the Show button on the Comment and Markup toolbar, you can filt. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

          D. Alternative Programs for Removing Metadata: There are several third party tools that remove metadata from files you email.  More importantly, they all interrupt the send command and ask you if you want to remove metadata.  For those that worry abou.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

               7. Deciding What You Want To See in Acrobat X, XI & DC: Under Comment ( Comments List you have options for filtering the visible comments, printing, etc.  See the screen-shots below for the options under each button.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               8. Typewriter Tool: In Acrobat 8 or 9, open the Typewriter toolbar and you’ll have a tool that will allow you to type on a PDF . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          C. You’ve Received a Paper Document: If you’re more adept at working with a keyboard, you’ll probably be annoyed with hard copi. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. Call Sender And Ask For Electronic Version: This should always be your first response.  The sender may have just thought you would prefer a paper copy.  If you do this a lot, then this is a good reason to have both Word Perfect and Word on your com.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Convert Hard Copy Document To Electronic Document: If the sender won’t give you an electronic version of the document, you n. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    a. The OCR Process: When a scanner captures an image of a document, it is the equivalent of a photograph of the document.  As such, the image can be viewed, printed and stored, but it does not contain text (in its native form) that you can edit.  Befo.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    b. The Problem Most People Experience: The problem that most people experience with this process is a resultant document that contains so many typographical errors that they could have retyped the whole thing themselves by the time they fix all of the.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    c. Factors Affecting the Result:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    d. OCR Software Recommendations: There are several options out there for OCR software.  In order to obtain the best results, you'll need to read the manual and experiment a bit (which of course no one likes to do).  Anyway, here are some recommendations:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
i. OmniPage v18: By Nuance - $49 at www.amazon.com - see http://tinyurl.com/jsojnoa.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
ii. OmniPage Ultimate: By Nuance - Mnfg. part #E709A-G00-19.0 - $468 at www.amazon.com.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
iii. ABBYY FineReader v12 Professional Edition: By Abbyy (mnfg. part #FRPFW12B) - $135 from www.amazon.com.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
                    e. Scanner Recommendations: OmniPage will work with almost any TWAIN compliant scanner directly.  However, you can also simply open any type of image in OmniPage if it were created using some other program (PDF, TIF, JPG, etc.). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
     IV. Ascertaining Changes Between Two Versions of a Document: The problems lawyers typically face related to this issue are expl. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          A. Major Drawbacks to Sending Paper Documents: Of course, you could fax or snail-mail documents to opposing counsel.  If they m. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. The physical trading of documents is very slow and can make the negotiation process take exponentially longer than if it were handled electronically.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. You’ll have to manually recapitulate the proposed changes into your electronic document which takes time and it’s difficult . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               3. It can be very difficult to track changes made by multiple parties when they’re all writing on a document.  It can easily be. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               4. Sometimes opposing counsel will retype the document or scan and OCR it so they can comment and enter proposed changes electronically to the document you sent them in paper form.  If they then print that document and mail/fax it back to you, then yo.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          B. Send an MS Word File - Ask Them To Use Track Changes But Verify: Of course, all versions of MS Word have a wonderful feature called Track Changes which will allow all proposed changes to be identified in the document being reviewed.  The problem is.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. When you receive the email with the attached document, save it as a new version (i.e., Jenco Lease Agreement v2.docx).. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Open the new version of the document and click on the Review ribbon in Word.  Click the bottom of the Accept button and choose Accept All Changes in Document as shown below.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               3. Now you have a "clean" document containing all proposed changes by the other party.  Now we’ll compare it against the first . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               4. Click the Compare button on the Review ribbon and compare the original document against the version 2 you just created.  See the screen shot below for details.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               5. The result of this process is a NEW document showing you the differences between what you send them in the first place and what they sent back.  Save this document as version 3 (Jenco Lease Agreement v3.docx).. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               6. Now you can use the Previous or Next buttons on the Review ribbon to locate each change, and Accept, Reject or Comment (ther. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          C. Send an MS Word File - Turn on Track Changes Before You Send and Lock It On: Rather than trusting the receiving party to con. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. Open up version 1 of the document you’re sending out, click on the Review ribbon in Word, then click the Track Changes butto. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. On the same ribbon (Review), you’ll see a button called Protect Document.  Click that button, check "Allow only this type of. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               3. Now click the button on the right side of the screen that says "Yes, Start Enforcing Protection."  It will now prompt you fo. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               4. Save the document, but do not email it yet.  The recipient cannot edit the document without those changes being shown, but t. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               5. Email the document to the other party with an explanation that you’ve turned on Track Changes and that every change they ent. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               6. When you receive the document back, save it as version 2, unprotect the document (Review ribbon, click the Protect Document button, click the Stop Protection button at the bottom and enter your password).  Now look at the properties again and see i.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          D. Send an MS Word File - But Receive A Word Document Back With No Changes Indicated: In other words, the recipient did not even attempt to use the Track Changes feature.  Instead, they simply entered their changes into the document directly and sent .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          E. Send an MS Word File - But Receive A PDF File Back With No Changes Indicated: This is a problem if all you have is Microsoft Word because Word cannot compare a Word document to a PDF document.  However, there are other applications which can do thi.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. Workshare Compare - https://www.workshare.com/product/compare. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. DocsCorp CompareDocs – see http://tinyurl.com/j24a486. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               3. Another option is to convert your original Word document to a PDF and then use Adobe Acrobat Professional to conduct the comparison between the two PDFs.  In Acrobat 8 & 9, click Advanced menu ( Compare Documents.  In Acrobat X, XI & DC, click View.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          F. Send a PDF File: Of course, if you want to make sure that the recipient cannot edit your document (but only suggest changes), sending a PDF is a good way to do that.  If the recipient has Adobe Acrobat Standard or Professional version 7, 8, 9 or X,.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          G. Alternative Programs for Comparing Documents:  The following are alternatives to Microsoft Word for comparing Word documents to produce a redline.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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               2. DocsCorp CompareDocs – see http://tinyurl.com/j24a486. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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               1. Items You Can Remove:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170
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          A. Using Word, Turn on Track Changes Before You Send The Document and Lock It On: This option is completely explained in paragraph IV.C. on page 18 above.  This is easy on the recipient because all they must do is made their proposed changes to the do.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          B. Using Acrobat, Send a PDF Using Acrobat’s Review and Comment Feature: This option is completely explained in paragraph IV.F.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          C. Go Over The Document Together via Web Meeting: This option is more fully described in paragraph XI which appears on page 38.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
     IX. Protecting Confidentiality: The document is extremely confidential.  What can you do to ensure that only the intended recip. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          A. Use Encrypted Email: You have no expectation of privacy using regular email.  Therefore, if you want privacy, you’re going t. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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               4. Protected Trust:  https://envoy.protectedtrust.com/. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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               1. ShareFile by Citrix:  https://www.sharefile.com/ - This is a fantastic service that allows you to create virtual "rooms" for others and share documents with them securely.  You decide what rights each user has to the collection of documents.  Simpl.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

182

170
171
171
171
171
171
171
171
171
171
172
173
173
173
173
174
174
174
174
175
175
176
176
177
177
178
178
178
178
179
179
180
180
180
181
181
181
181
181
181
181
181
181
181
181
181
181
181
182

               3. Firmex Virtual Data Room:  See https://www.firmex.com/.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182
               4. SmartRoom Virtual Data Room:  See http://smartroom.com/.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182
               5. Ansarada Virtual Data Room:  See https://www.ansarada.com/. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182
               6. IntraLinks Virtual Data Room:  See http://preview.tinyurl.com/lt6d899.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182
               7. Microsoft Office 365 or OneDrive for Business:  OneDrive is Microsoft's cloud storage offering and it comes with nearly every Office 365 plan.  For only $5/user/month (Business Essentials plan), you get 1 TB of online storage.  See this:  http://ti.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182



____

Making Technology Work For You
May 5, 2021
Index

               8. G Suite by Google Cloud:  The Basic edition is $5/user/month and includes 30 GB of cloud storage; the Business edition is $10/user/month and includes unlimited cloud storage.  See your options here:  http://tinyurl.com/kkocuto. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

               2. Meeting Accounts Personal to an Individual: This account is specific to one individual and only they are allowed to host meetings (others cannot use it without violating the license agreement).  These accounts also usually allow up to 15 people in .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

               9. Dropbox Business Standard or Advanced:  Standard is $12.50/user/month and Advanced is $20/user/month.  For an explanation of their business plans, see https://www.dropbox.com/business/plans-comparison.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               10. SpiderOak Professional:  This service offers complete encryption so thorough that not even SpiderOak employees can get to your data.  For $10/user/month, you get 100 GB of storage.  See this for more:  https://spideroak.com/business_pricing/. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               11. Syncplicity: See  https://www.syncplicity.com/.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               12. Box.com:  https://www.box.com/pricing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               13. TrueShare: http://www.trueshare.com/. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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               15. OneHub:  Secure file sharing - see https://onehub.com.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          D. Encrypt The Files Themselves: Both Word and Acrobat offer ways to encrypt Word and PDF files, respectively.  This simply means that they cannot be opened or read unless the correct password is entered.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. Encrypt Word Files: Simply open the document you would like to encrypt.  In Word 2007, click the Office Button ( Prepare ( Encrypt Document.  Enter a strong password and click OK.  In Word 2010/13/16, click the File menu ( Info (left side) ( Protec.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Encrypt PDF Files: Open the PDF you would like to encrypt.  In Acrobat 8 or 9, click the Secure button at the top of the screen ( choose Password Encrypt.  In the next dialog, check the box that says "Require a password to open the document" and en.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
     X. Digital Signatures:. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          A. What They Are: This is unquestionably one of the most confusing topics I’ve ever encountered in legal technology, mostly bec. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               1. Unlike a handwritten signature, a digital signature is difficult to forge because it contains encrypted information that is unique to the signer.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Recipients can easily verify the authenticity of the digital signature (you simply click on the signature in a PDF to verify it).. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               3. Once digitally signed, neither the signature nor the document signed can be altered without detection.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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          B. Digital Signatures Are Not Electronic Signatures: Digital signatures are created and verified by cryptography, the branch of applied mathematics that concerns itself with transforming messages into seemingly unintelligible forms and back again.  Th.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
          C. How They Work:  An explanation of digital signatures is on SearchSecurity’s website and authored by Ben Lutkevich, Vicki-Lyn. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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          A. What Is a Web Conference? A "web conference" (aka web meeting) is a live meeting (or presentation) wherein the participants are connected via the Internet. As such, it doesn't matter where the participants are physically located as long as they hav.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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               1. Share Documents and Collaborate: When you want to show someone a document you're drafting (to solicit input, discuss something, etc.), web meetings are perfect.  Since most services allow you to give control of your keyboard and mouse to other part.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
               2. Far Less Expensive Than Meeting In Person: Many times it is just very expensive (in terms of travel costs and/or time wasted traveling) to get everyone in the same room.  Web conferencing is wonderful in these situations.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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To get the most out of your ICLEF Electronic Publication, download this material to your PC and use Adobe 
Acrobat® to open the document.  The most current version of the Adobe® software may be found and 
installed by clicking on one of the following links for either the free Adobe Acrobat Reader® or the full 
retail version of Adobe Acrobat®.   
 
Feature list: 
 

1. Searchable – All ICLEF Electronic Publications are word searchable.  To begin your search, click on 
the “spyglass” icon at the top of the page while using the Adobe® software. 

1. Bookmarks – Once the publication is opened using the Adobe Acrobat® software a list of 
bookmarks will be found in a column located on the left side of the page.  Click on a bookmark to 
advance to that place in the document.  

2. Hypertext Links – All of the hypertext links provided by our authors are active in the 
document.  Simply click on them to navigate to the information. 

3. Book Index – We are adding an INDEX at the beginning of each of our publications.  The INDEX 
provides “jump links” to the portion of the publication you wish to review.  Simply left click on a 
topic / listing within the INDEX page(s) to go to that topic within the materials.  To return to the 
INDEX page either select the “INDEX” bookmark from the top left column or right-click with the 
mouse within the publication and select the words “Previous View” to return to the spot within 
the INDEX page where you began your search. 

 
Please feel free to contact ICLEF with additional suggestions on ways we may further improve our 
electronic publications.  Thank you. 
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                9:00 A.M.           Formatting Complex Indiana Pleadings in Microsoft Word  
         One of the most difficult technical tasks one can undertake is formatting a  

                      complex brief in Microsoft Word that has a title page, table of contents, table  
                      of authorities, multi-level paragraph numbering, and page numbering that  
                      starts over in the middle of the document and switches formats (for example,  

         Romanettes to Arabic).  Attend this class and you will receive a 7th Circuit  
         Court of Appeals brief template, and an Indiana Court of Appeals brief  
         template.  During the class, you will learn how to customize the templates,  
         use them to control formatting perfectly and generate a table of authorities  
         and table of contents automagically (without manually typing them).  The  

                      templates as the starting point for your next brief, you’ll shave many hours  
                      off the process because the formatting will just work. 
 
                    Inbox Ninja - Using Outlook To Organize & Manage High Volume Email  
                      Lawyers and staff are generally drowning in email and many feel helpless when  
                      trying to get it under control. This seminar will show you how to use all of  
                      Microsoft Outlook’s feature set to efficiently store, organize email (and  
                      attachments), and successfully deal with high email volume.  We will also show  
                      you how to fix Outlook’s default settings for email, calendar, contacts, and tasks.   
                      Finally, we will explain many amazing and useful Outlook features which most  
                      users do not even know are there. 
 

                12:15 P.M.         Lunch Break (on your own) 
 
                1:15 P.M.          Microsoft 365 - The Value Proposition and the Very Useful Applications It        
                                           Includes That Most Subscribers Are Not Even Aware Of  
                                                Microsoft 365 offers a compelling combination of local software, document/email  
                                                  management and cloud services.  In other words, it is far more than Word, Outlook and  
                                                  Excel.  Even if you already subscribe to Microsoft 365, there are dozens of extra  
                                                  applications that come with it you could be using.  Examples include Teams, Bookings,  
                                                  ToDo, learn how it works, what it does best, and the different plans available.  You  
                                                  will soon see why Microsoft 365 is rapidly taking over the legal market. 
 

                                                  The Evolution of Speech Recognition Software – You Will Not Believe  
                                            How Good It Has Become 
                                                Lawyers have to draft pleadings and documents, capture time entries in accounting  
                                                software, respond to emails, and enter case-related information into a file (or case  
                                                management system).  All those things typically involve a keyboard, and  
                                                unfortunately, many lawyers just aren’t good typists.  Years ago, it was common  
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                                                  for support staff to handle such things.  But today, a high percentage of lawyers have  
                                                  limited or no access to support staff simply due to the cost.  As a result, today’s  
                                                  lawyers must be far more self-reliant in the generation of work product.  Thankfully,  
                                                  speech recognition technology can resolve these issues.  You talk, and the software  
                                                  types exactly what you are saying.  This technology can be used for automatic  
                                                  transcription, time entries, and any drafting task without ever touching the keyboard.   
                                                  Speech recognition has arrived, and this seminar shows you how it works and what  
                                                  you need to incorporate it into your practice.  We will focus on the popular Dragon  
                                                  Professional software application. 
 
                                                  ETHICS -How to Protect Yourself and Preserve Confidentiality When  
                                                  Negotiating Instruments 
                                                  Opposing lawyers routinely email versions of a document back and forth during the  
                                                  negotiation process; and many instruments are never reduced to paper until they are  
                                                  ready to sign. This approach is unquestionably fast and convenient compared to  
                                                  mailing or faxing paper documents.  However, electronic document exchange presents  
                                                  many issues that practitioners need to be aware of and risks to protect against.  In this  
                                                  seminar, you will learn when it is appropriate to use word processor files and when it is                                                    
                                                  appropriate to use PDFs.  We will cover how to track your changes in a document and how  
                                                  to ascertain what changes were made by others (even if there are attempts to conceal those  
                                                  changes).  You will also learn how to add comments and annotations to Word or PDF files,  
                                                  how to lock documents down to prevent further changes, and how to avoid including  
                                                  hidden (and potentially damaging) information in the files you are working with (this  
                                                  hidden information is known as metadata).  Finally, using plain email arguably affords  
                                                  you no reasonable expectation of privacy.  We will also discuss your email encryption  
                                                  options which ensure that only the intended recipient can open your emails and/or                                                    
                                                  attachments thereto.     
             
                4:30 P.M.           Program Adjourns 
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Formatting Complex Pleadings in Microsoft Word 

This seminar is designed to show you how to use a (fully editable) Microsoft Word 7th Circuit Brief 
template which you can download for free here: https://bit.ly/2S5wUUA (no password required).  
There are three versions, one with a table of contents and authorities included, one with a Table 
of contents but not a table of authorities, and one without both tables (which you can use for 
practice). 

I. ARCHITECTURE OF THE TEMPLATE 

The template consists of multiple sections which you can delete, modify or add to: 

A. Section 1 - Title Page:  This is the first page of the template and it is not page 
numbered. 

B. Section 2:  This is comprised of the following. 

1. Disclosure Statement:  This is page numbered with Romanettes. 

2. Table of Contents:  This is page numbered with Romanettes.  The TOC can 
be automatically updated to reflect any changes in the document by simply 
hitting Ctrl+A (which selects the entire document) and hitting the F9 key 
(which updates all fields). 

3. Table of Authorities:  This is also consecutively page numbered with 
Romanettes.  There’s currently no TOA in the template because you have 
to build it (which we’ll do together and the instructions for doing so are 
below). 

C. Section 3 - Body of the Brief:  This is the body of the brief which contains titled 
sections and a 4 level deep, auto-paragraph numbered outline.  The page 
numbering starts over here at Arabic page 1 and continues consecutively for the 
rest of the document.  The following sections exist: 

1. Jurisdictional Statement 

2. Statement of the Issues 

3. Statement of the Case 

4. Summary Of The Argument 

5. Argument 

6. Conclusion 

7. Certificate of Compliance 

https://bit.ly/2S5wUUA


 

Page 2 of 20 

8. Certificate of Service 

9. Required Short Appendix 

II. STYLES IN GENERAL 

A. What Are Styles?  A style is a set of formatting characteristics that you can apply 
to text, tables, and lists in your document to quickly change their appearance. 
When you apply a style, you apply a whole group of formats at once.  A useful way 
to think of styles is like a car radio pre-set button. Every time you push the button, 
you're back on the exact station you programmed the button for. 

B. Open The Styles Pane:  In Word for Windows, you can view styles by clicking the 
Home ribbon  Styles launcher to reveal the Styles pane (see Figure 1 below).  
You can also use the speed key Alt+Shift+Ctrl+S. 

 
Figure 1 

In Word for Mac, there’s a Styles Pane button on the Home ribbon. 

 
Figure 2 

A subset of all of the styles available are also visible in the Styles gallery on the 
Home ribbon.  However, the styles gallery is mostly useless. 

 
Figure 3 

C. All-Important Rules of Styles:  It's critical that you keep the following rules in 
mind. 
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1. Every Instance of Unique Formatting Requires a Different Style:  When 
you just type in a document, Word automatically applies the Normal style 
to the text. However, in order to properly use styles, you need to apply a 
different style to each type of unique formatting within the document. For 
example, in Figure 4 below, there are 4 levels of outline numbered 
paragraphs. Each one is a unique type of formatting and requires a 
different style. The proper way to format such a document would be to 
apply the style called Heading 1 to the Articles, Heading 2 to the 2nd level 
of the outline, Heading 3 to the 3rd level and Heading 4 to the 4th level. Of 
course, if these Heading styles do not currently format the text the way I 
see it, I will have to alter their settings so they match the formatting I'm 
trying to achieve (which you would do by simply right-clicking the style 
name in the style pane or style gallery and choosing "modify" from the 
menu that appears. 

Having said that, if there's a section of easy formatting somewhere in the 
document and that formatting doesn't reappear anywhere else, it's fine to 
manually format those things.  For example, a signature block may not 
require its own style because by the time you create one to handle it, you 
could have already formatted it manually and moved on. 



 

Page 4 of 20 

 
Figure 4 

Therefore, if properly constructed, the paragraphs would have the 
following headings applied (see labels to the left).  In this case, Heading 1 
corresponds to the first level of the outline, Heading 2 corresponds to the 
second, etc. 
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Figure 5 

2. Word Uses Styles Without Your Knowledge or Consent:  When you type 
text into a document, Word automatically applies a specific style 
depending upon where your cursor is and what you're doing. For example, 
if you're in a header, Word automatically applies a style called Header. The 
mere act of typing in a header box causes this to happen. 

3. There is No Off Button:  I've heard many people tell me that they don't use 
styles in Word. That's impossible because you can't turn styles off and as 
described in the previous rule, Word applies them automatically. It's 
impossible to have text in a Word document (any version) to which a style 
is not applied.  

4. If You Don't Control Styles, They Control You:  This is about as blunt as I 
can get. Styles will always win the formatting battle. All of the direct 
formatting in the world isn't going to change that. So you're infinitely 
better off learning how to control styles so you aren't constantly struggling 
against them. They are completely controllable (as is Word in general), 
once you've mastered them. 

5. Every Document Has 247 Styles Built In:  When you create a new 
document in Word, there are 247 styles already in the document although 
only a small subset might actually be used. We refer these built-in styles as 
"System" styles. To see all of these styles, you can either: 

a. Open the styles pane  click the Options link (bottom, right corner 
of the Styles pane)  under "Select styles to show:" choose All 
Styles  under "Select how list is sorted:" choose Alphabetical  
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clear every checkbox in this dialog  click OK. All available styles 
will now appear in the styles pane. 

b. Open the styles pane  click the Manage Styles button (bottom of 
the Styles pane)  click the EDIT tab in the subsequent dialog and 
there you will see all of the available styles. 

6. You Can't Delete System Styles But You Can Change What They Do:  Any 
system style can be altered so that it produces the formatting you want. 

7. You Can Create Your Own Styles:  It's also possible to create your own 
styles by using the New Style button at the bottom of the Styles task pane: 

 

8. The Style Inspector Will Make All Of This Much Easier:  NOTE that this is 
only available in Word for Windows and not in Word for Mac.  If you're not 
sure what style is being applied to text in your document, just follow these 
steps to find out: Open the Styles pane  click the Style Inspector button 

. A panel will open and show you the Paragraph formatting and Text 
level formatting. You are concerned about the Paragraph formatting style. 
Once the Style Inspector is open, you can also modify a style by right-
clicking it and choosing Modify from the menu that appears. 

9. Once a Style Is Applied to Text, You Can Change The Text By Modifying 
The Style:  Let's say you have 50 footnotes in your document and you don't 
like how they look. There's a style called Footnote Text which Word 
automatically applies to every footnote. Therefore, you can change all of 
your footnotes at once by modifying the Footnote Text style. As soon as 
you change the style definition, every footnote will update its formatting 
automatically to match your changes assuming you didn't already apply 
direct formatting. If you had already selected each footnote and applied 
custom formatting (see discussion of Direct Formatting above), then that 
formatting will need to be removed to reveal the default style formatting 
beneath it (see previous rule).  

III. LIST OF STYLES BUILT INTO THE APPELLATE BRIEF TEMPLATE 

A. Block Text makes text look like this (.5” indent left and right, single spaced, 12 pt 
after for vertical spacing): 

A person liable under this section may be charged with and convicted of the crime 

although the person who directly committed it has not been convicted, or has been 

convicted of some other degree of the crime or of some other crime based on the 

same act, or if the person is a juvenile who has not been found delinquent for the 

act. 
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B. Body Text First Indent makes text look like this (double space, first line .5” indent): 

Respondents were sitting at an illuminated kitchen table facing a window of a ground-floor 

apartment and packaging cocaine.  Respondents should have realized that a passerby could have 

looked into the apartment and noticed the illegal activity occurring within the apartment.  Thus, 

Respondents can claim no subjective expectation of privacy. 

C. Body Text makes text look like this (double space, no indent): 

This Court is being asked to reverse a Minnesota Supreme Court judgment that Respondents were 

entitled to suppress evidence on Fourth Amendment grounds.  The issue at hand is the 

constitutionality of an officer’s naked-eye observation of Respondents as they bagged cocaine in 

an apartment in which they were neither residents nor overnight guests. 

D. Disclosure Statement makes text look like this and is used under the heading 
DISCLOSURE OF CORPORATE AFFILIATIONS AND FINANCIAL INTERESTS. 

2. The name of all law firms whose partners or associates have appeared on be- half of the 

party in the case (including proceedings in the district court or before an administrative agency) or 

are expected to appear for the party in this Court: the National Right to Work Legal Defense 

Foundation, Winston & Strawn LLP, and the Liberty Justice Center.  

 
E. Heading 1 makes text look like this.  Any text to which this style is applied gets 

pulled into the Table of Contents. 

STATEMENT OF THE CASE 

F. Heading 2 makes text look like this (automatic paragraph numbering, .5” left 
indent, .5” hanging indent, single spaced, bold, 12 pt after).  Any text to which this 
style is applied gets pulled into the Table of Contents. 

A. The Appellant-Defendants’ Adoption of the New Rules Was an Ultra Vires Act 

Which Precludes Qualified Immunity. 

G. Heading 3 makes text look like this (automatic paragraph numbering, 1” left 
indent, .25” hanging indent, single spaced, bold, 12 pt after).  Any text to which 
this style is applied gets pulled into the Table of Contents. 

1. The Olson rule dictates that only overnight guests have a connection to a 

premises that gives rise to a legitimate expectation of privacy 
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H. Heading 4 makes text look like this (automatic paragraph numbering, 1.25” left 
indent, .25” hanging indent, single spaced, bold, 12 pt after).  Any text to which 
this style is applied gets pulled into the Table of Contents. 

a. Illegal drug distribution is not a longstanding social custom that serves 

functions recognized as valuable by society 

I. Notice makes the text look like this: 

In addition your Fair Share fee includes your pro rata share of the expenses 

associated with the following activities which are chargeable to the extent that they are 

germane to collective bargaining, are justified by the government’s vital policy interest in 

labor peace and avoiding free riders, and do not significantly add to the burdening of free 

speech that is inherent in the allowance of an agency or union shop. 

 

J. Table of Authorities controls how the individual citations look in the TOA. 

K. Title makes text look like this (center, bold, all caps, single spaced, 12 pt after).  
Any text to which this style is applied does not pulled into the Table of Contents. 

TABLE OF CONTENTS 

L. TOA Heading controls how the categories of citations look such as Cases. 

STATEMENT OF THE ISSUES PRESENTED FOR REVIEW 

M. TOC 1, TOC 2, TOC 3, and TOC 4 control how the 4 levels of the table of contents 
look.  Figure 6 is a screen shot of how the 4 levels look in the document. 
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Figure 6 

IV. HOW TO USE THE STYLES BUILT INTO THE TEMPLATE 

It is imperative that you learn to use the styles that are conveniently built into the template and 
which control all of the formatting in it.   

A. Open The Styles Pane:  Open the pleading template and then open the Styles 
Pane.  For instructions, see II.B. on page 2 above. 

B. Click Show Preview:  If you’re using Word for Windows, make sure you check the 
Show Preview box at the bottom of the styles pane so you can see what they look 
like.  This checkbox doesn’t exist in Word for Mac but you can already see what 
the styles look like in the Mac styles pane. 

 
Figure 7 

C. Practice Applying Styles:  For example, click your cursor somewhere in the 
paragraph under Opinions Below on page 1 of the body of the brief.  Do not select 
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even a single character, just put your cursor in the paragraph.  Now single (left) 
click the Block Text style in the Style Pane.  Now click on Body Text First Indent.  
You can see how the text immediately reformats to match the style definition. 

If you want to apply a style to multiple paragraphs at once, select/block the entirety of 
the paragraphs in question and then click the style you want to apply.  If you select only 
a few characters of a paragraph and click a style, it may not work.  Either select nothing, 
or select the entire paragraph.  I know this is a weird rule, but just trust me. 

V. HOW TO CHANGE THE FONT FOR THE ENTIRE TEMPLATE 

The template is obviously set up for Times New Roman, 12 pt, left paragraph alignment.  If you 
want to make the entire template switch to something else (let’s say Arial 14 pt), then do not 
select the entire document and manually switch it to something else using the font drop down 
menu.  Instead, follow these steps: 

A. Open the Styles Pane (Alt + Ctrl + Shift + S). 

B. Right-click the Normal style  choose Modify from the menu that appears. 

C. In the next dialog, click the Format button at the bottom, left corner and then 
choose Font.  Change the Font to Arial and the size to 14, then click OK. 

D. Click OK once more.  This will change all of the styles to Arial. 

VI. HOW TO UPDATE THE TABLE OF CONTENTS 

After you’ve modified the document, make sure that the styles Title, Heading 1, Heading 2, 
Heading 3 or Heading 4 are applied to the text you want to pull into the Table of Contents.  Next, 
select the entire document (Ctrl+A is the easiest way to do this), then hit the F9 key on your 
keyboard.  You’ll likely see a dialog like Figure 8 below.  Choose Update entire table  OK button. 

 
Figure 8 

VII. HOW TO BUILD A TABLE OF AUTHORITIES - GENERAL INSTRUCTIONS 

A. Never Type a Table of Authorities:  Automatically creating a Table of Authorities 
can be very helpful, especially when the document will likely be changed 
subsequently. One minor change can throw off the entire Table. Your options for 
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creating a table of authorities that will automatically update are to use Word's 
built-in feature or purchase a third-party add-in program. 

1. Using a Third-Party Program:  An excellent program for this purpose, 
which is faster, easier and actually provides more flexibility than Word's 
built in functionality, is Litigation Companion by Litera. For more 
information about this program see https://bit.ly/3koLfUT.  Other options 
include Lexis for Microsoft Office (see https://bit.ly/3qA7biT) or Drafting 
Assistant for Litigation Documents by Thomson Reuters (see 
https://tmsnrt.rs/3qyw4eJ). 

2. Using Word's Built-In Feature for TOA:  The process of creating a table of 
authorities using Word's built-in feature involves two steps: 

a. Marking the citations. 

b. Generating the table of authorities based on the marked citations. 

B. Get Your TOA Categories Set Up First: 

1. What Are Categories?  Categories are the groups of citations you want to 
appear in your TOA.   

 
Figure 9 

2. How to Control The Names of the Categories:  Word supports up to 16 
different categories of citations. The labels for these categories can be 
changed from the Mark Citations dialog (References ribbon  Table of 
Authorities group  Mark Citations button). Open the dialog and click 
Category…. 

https://bit.ly/3koLfUT
https://bit.ly/3qA7biT
https://tmsnrt.rs/3qyw4eJ
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Figure 10 

This will open the Edit Category dialog to rename (replace) any of the 16 
categories. To replace the Cases category with "Ohio Case Law", simply 
select Cases (i.e. category number 1), type "Ohio Case Law" in the Replace 
with box, and click the Replace button. Click OK, then Close. 

 
Figure 11 

3. The Order of Categories Matters:  The order that the categories are listed 
in Figure 11 above controls the order in which the groups of citations will 
appear in your TOA.  So in the above example, the Statutes group of 
citations will appear before the Other Authorities group of citations.  
Therefore, it’s important to make sure you not only have the categories 
you need, but also that they’re in the order you would like. 
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C. Mark the Citations: 

1. Click the References ribbon  Table of Authorities group  Mark Citation 
button. A dialog box should appear. 

2. Click on the Next Citation button. 

3. Word will find the first citation in your document. Click back in the 
document and highlight the text with the full citation. 

4. With the citation highlighted, click in the Selected Text area in the dialog 
box. Word will insert the highlighted text. 

5. Select the proper Category (Cases, Statutes, etc.) 

6. In the Short Citations box, edit the cite as it appears in the document as 
the short citation. 

7. Click the Mark button or the Mark All button to mark all citations. Note: 
We believe that Word falls short when it tries to update newly added 
citations. It was inconsistent, at best, when we tested this feature. As such, 
we recommend that you create the table of authorities at the very end of 
the drafting process. 

8. Repeat the above steps to mark all citations and close the Mark Citation 
dialog box. 

D. Generate a Table of Authorities Based on Your Marked Citations: 

1. Place the cursor where you want to insert the table of authorities. 

2. Select References ribbon  Table of Authorities group  Insert Table of 
Authorities button. 

3. Pick the desired format. 

4. Deselect the Use passim option. 

5. Deselect the Keep original formatting option. 

6. Select All under Category so that Cases, Statutes, etc. will appear in the 
table of authorities. 

7. Click OK to insert the table of authorities. 

E. Page Number Warning:  NOTE: When the Table of Authorities fields are visible 
(Show/Hide is turned on), the page numbers will not accurately reflect the actual 
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page numbers of the document. This is because the Table of Authorities fields, 
when visible, take up significant additional space which will make your document 
appear longer than it is (and seemingly make the Table of Contents or Table of 
Authorities page number appear to be incorrect). Simply click the Home ribbon  

Paragraph group  Show/Hide button . This will hide the Table of Authorities 
fields, and display accurate page numbers. Then update your Table of Authority 
page numbers (click in the Table of Authorities and click Update field). 

Sample Paragraph with TOA Fields Showing (bold added for emphasis) 

 
Figure 12 

Same Sample Paragraph with TOA Fields Hidden 

 
Figure 13 

F. Editing Table of Authorities Entries by Editing TOA Fields:  Microsoft Word 
"marks" entries by placing a Table of Authorities field immediately before or after 
the citation. There are two types of Table of Authorities fields (1) long citation 
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fields and (2) short citation fields. Once the fields are in the document, edit the 
fields directly to change the Table of Authorities entry. 

1. Long Citation Fields:  Long citation fields are used by Word to mark the 
first instance of a citation. Long citation fields have the following format: 

{ TA \l "Smith v. Jones (1988), 85 Ohio St.3d 123, 54 N.E.2d 98" \s "Smith" \c 1} 
 

Here's what each part of the foregoing means: 

a. TA = the field code for Table of Authorities 

b. \l "Smith v. Jones (1988), 85 Ohio St.3d 123, 54 N.E.2d 98" = how 
the Table of Authorities entry should be displayed in the actual 
Table of Authorities (see Long citation in the adjacent screen shot). 

c. \s = short citation form that Word will use to search for and mark 
additional entries.  

d. \c = the category of the citation - for example State Court Cases 
(see below) 

 
Figure 14 
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2. Short Citation Fields:  Short citation fields are used by Word to mark 
additional instances of a citation in a document. Short citation fields have 
the following format: 

     { TA \s "Smith"} 

 

 
Figure 15 

3. How Word uses Long and Short Citation Fields:  Word uses the long 
citation field to mark the first instance of a citation, and the short citation 
field to mark additional instances. Therefore, there should be only one 
long citation field per unique citation and multiple short citation fields for 
additional instances of that unique citation. See the example below 
(emphasis added): 

TA is the 
field code 

for Table of 
Authorities 
 

\s is the short citation form 
that Word will use to search 

for and mark additional 
entries.  
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Example Text Showing Long and Short Citation Fields 

Before the Act was adopted to promote this objective, public labor relations were 
characterized by wide and irrational variations among various local governmental entities 
relating to all manner of terms and conditions of employment. Not long ago, this court recalled 
that deplorable time. In Kettering v. State Emp. Relations Bd. (1986), 26 Ohio St.3d 50, 56, 26 
OBR 42, 496 N.E.2d 983{ TA \l "Kettering v. State Emp. Relations Bd. (1986), 26 Ohio St.3d 50, 
56, 26 OBR 42, 496 N.E.2d 983" \s "Kettering" \c 1}, this court stated **** 

The decision below represents precisely the sort of return to the pre-Act "system" that 
this court condemned in Kettering{ TA \s "Kettering" }, supra. This court's holding in Kettering{ 
TA \s "Kettering" } makes clear that, under the Act, a collective bargaining agreement binds the 
municipality and all of its agencies. No municipal agency can operate independently of that 
agreement; nor can it render the agreement a nullity by purporting to assume control over a 
term or condition of employment that is governed by the agreement. 

4. Changing the format or text of the case citation in the Table of 
Authorities:  Edit the long citation field to change the format or text of a 
case citation entry in the Table of Authorities. So for example, if the case 
name has to be in italics in the Table of Authorities, then make the case 
name italics in the long citation field. Select the name of the case contained 
within the quotation marks and make the text italics: 

Change: 

{ TA \l "Smith v. Jones (1988), 85 Ohio St.3d 123, 54 N.E.2d 98" \s "Smith" \c 1} 

To: 

{ TA \l "Smith v. Jones (1988), 85 Ohio St.3d 123, 54 N.E.2d 98" \s "Smith" \c 1} 

This will cause the case name to display with italics in the actual Table of 
Authorities entry. 

To force the case name to be on a separate line within the Table of 
Authorities, you need to insert a line break (SHIFT + ENTER) into the long 
citation field where you want to start a second line. 

Change: 

{ TA \l "Smith v. Jones (1988), 85 Ohio St.3d 123, 54 N.E.2d 98" \s "Smith" \c 1} 

To: 

{ TA \l "Smith v. Jones (1988), 
85 Ohio St.3d 123, 54 N.E.2d 98" \s "Smith" \c 1} 

Don't worry if the field looks strange in your document. The field does not 
print, but it will force a line break in your Table of Authorities. 

Change the text format to italics 
 
Change the text format to italics 

Line Break 
 
Line Break 
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Figure 16 

5. Table of Authorities Styles:  There are two Table of Authorities styles to 
be aware of (1) Table of Authorities, and (2) TOA Heading. These two styles 
control how the Table of Authorities is actually formatted. So, for example, 
to add a space between the word "Cases" and the citations, you need to 
modify the TOA Heading style to add a 12 pt space after the paragraph. 

Similarly, to add a space between each citation, edit the Table of 
Authorities style to add a 12 pt space after the paragraph. 

 
Figure 17 

6. Changing a Citation's Category:  Sometimes a citation gets placed into the 
wrong category. For example, a case gets marked as a statute. To change 
a citation's category, edit the long citation field, and change the category 
to the correct number. For example, if "Cases" is category 1, and "Statutes" 
is category 2, then to change the citation from being listed in "Statutes" to 
being listed in "Cases", change the category from 2 to 1. The category is 
defined in the Long Citation field after the "\c": 

Change: 

{ TA \l "Smith v. Jones (1988), 85 Ohio St.3d 123, 54 N.E.2d 98" \s "Smith" \c 2} 

To: 

{ TA \l "Smith v. Jones (1988), 85 Ohio St.3d 123, 54 N.E.2d 98" \s "Smith" \c 1} 

VIII. STEPS FOR BUILDING A TOA IN THE TEMPLATE: 

A. First, we need to get our Categories in order for this brief.  Click the References 
ribbon  Mark Citation button  Category button.  Whatever appears in your list 
of categories can be changed.  Further, the order that they appear (top to bottom) 

Line Break 
 
Line Break 

Change the 2 to a 1 
 
Change the 2 to a 1 
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dictates the order that each category will appear in your Table of Authorities (as 
discussed above).  For this exercise, we need the categories shown below in the 
order they appear.  After you’re done updating/replacing the categories to reflect 
the 3 below (Cases, Statutes & Other Authorities), click OK. 

 
Figure 18 

B. You should still be in the Mark Citation dialog at this point.  So now click Next 
Citation until you find 42 U.S.C. § 1983.  Follow these steps: 

1. Select the entire citation (42 U.S.C. § 1983) 

2. Switch the Category to Statutes. 

3. Click in the Selected Text box (which will populate that box with that you 
selected). 

4. Leave the short citation the same as the long citation and click the Mark 
All button.  This will turn on Show/Hide so you can see the hidden codes. 

C. Click the Next Citation button until you land on the case .  Select Clark v. Cmt’y for 
Creative Non-Violence, 468 U.S. 288, 104 S.Ct. 3065, 82 L.Ed.2d 221 (1984)  
click in the Selected text box  shorten the Short citation to simply Clark  make 
sure you’ve changed your category to Cases from Statutes  click Mark All. 

D. Mark the rest of the citations. 

E. When you’re done, put your cursor on the third line of the Table of Authorities 
Page (v.)  click the References ribbon  click the Insert Table of Authorities 
button on the right side. 



 

Page 20 of 20 

F. If you want to change the way the categories are showing up, modify the TOA 
Heading style which will appear in your styles pane.  If you want to change the 
entries themselves, then modify the style called Table of Authorities. 

QUESTIONS ABOUT WORD? 
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Inbox Ninja - Using Outlook to Get Email Under Control 

 

I. RECOMMENDED DEFAULT SETTING CHANGES: 

A. Changes to Mail Settings:  Note that you get to all of these in Outlook for Windows 
by clicking the File menu  Options  Mail.  You get to the same settings in 
Outlook for Mac by clicking the Outlook menu  Preferences. 

1. Compose Messages:  Click the Editor button on the right side  UNcheck 
“Ignore words in UPPERCASE”  OK.  This will cause Outlook to spellcheck 
everything you type, even if it’s in all caps. 

 

2. Check Spelling Automatically:  Under Compose Messages, check Always 
check spelling… 

 

3. Set up your Signature Block:  Click the File menu  Options button  Mail 
tab (left side)  Signatures button.  It is recommended that you have some 
kind of signature automatically attached to every new message and every 
reply/forward.  However, the reply/forward signature doesn’t and 
arguably shouldn’t be as detailed as the one you use for new messages. 
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To create a new signature, click the New button (above)  name the 
signature (such as “office”)  OK.  Now create your signature in the Edit 
Signature box and apply formatting as necessary.  When you’re done, click 
the Save button.  If you want to make this the default signature, then 
choose it from the drop-down under Choose default signature.  You can 
make as many signatures as you want. 

 

4. Fix Outlook's Fonts: Click the File menu  Options button  Mail tab (left 
side)  Stationery and Fonts button.  Now make them all the same (they're 
not the same by default): 
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5. Tweak The Reading Pane:  If you click on an email to read it in the Reading 
Pane, Outlook will toggle the email as having been read and it will no 
longer be bold.  Many people have complained about this.  If you would 
prefer that emails remain identified as unread even if you view them in the 
reading pane, then click the Reading Pane button  uncheck the boxes 
identified below. 

 

6. Turn Off Message Notifications:  If you want peace, we recommend 
turning off email notifications (at least try it).  If you’re worried and want 
to make sure you’re notified if certain people send you emails, you can set 
up a Rule in Outlook that notifies you of only certain people sending you 
messages.  For more information on this, see the instructions in paragraph 
V.B.3. on page 14 below. 
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7. Open Email In a New Window:  In Outlook 2016 and more recent, when 
you reply to an email, it opens it the reading pane rather than a new 
window.  If you don’t like that, then under Replies and forwards, check this 
box: 

 

8. Close Original Messages When Replying or Forwarding:  Under Replies 
and forwards, check the box shown below: 

 

9. Mark Messages Read When Deleted:  If you don’t like having unread 
emails in your deleted items folder, check this box: 

 

B. Changes to Calendar Settings:  Note that you get to all of these by clicking the File 
menu  Options  Calendar. 
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1. Change Work Start and End Hours:  If you work different hours than 
Outlook’s defaults, you can change them under Work time. 

2. Default Reminder Timing:  Many people want more than 15 minute 
reminders for appointments.  Below Calendar Options is where you can 
change that. 

3. Change Calendar Color:  Under Display Options, you can change the 
calendar color to another pastel. 

4. Add Second Time Zone To Calendar:  If you often have to set meetings 
with people in another time zone, you can add that zone to your calendar.  
Check the box below, choose the time zone you want and label it. 

 

C. Changes to People Settings:  Note that you get to this setting by clicking the File 
menu  Options  People.  You’ll probably want to make sure your settings are 
the same as shown below: 

 

D. Changes to Advanced Settings:  Note that you get to these settings by clicking the 
File menu  Options  Advanced.   

1. AutoArchive Settings:  There are many ways to get to these settings, but 
click the AutoArchive Settings button will allow you to turn on or off these 
settings and customize them as well. 
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2. Change Your Reminder Sound:  If you would prefer another sound as a 
reminder, you can make the change under Reminders. 

 

E. Changes to the Quick Access Toolbar:  Note that you get to this setting by clicking 
the File menu  Options  Quick Access Toolbar.  Here is where you can add 
buttons which are always visible regardless of what part of Outlook you’re in.  I 
also recommend checking the box at the bottom of the screen that says Show 
Quick Access Toolbar below the Ribbon. 

 

II. OUTLOOK EMAIL INTERFACE IMPROVEMENTS 

A. See More Email On Your Screen:  Generally, you want to see as many email on 
your screen as possible.  If an email slides off the bottom of the screen, you could 
easily forget to respond to it or do the thing it was supposed to remind you to do.  
So here are some techniques for seeing more email at once. 

1. Turn Off Reading Pane Or Dock It On The Right:  If this is at the bottom of 
the screen, it is going to occupy a lot of space that could otherwise be 
showing you email.  To turn it off or move it, click the View ribbon  
Reading Pane button  Off or Right. 

2. Turn Off Date Grouping:  By default, Outlook groups your email by date 
received. The date bars that run across your screen just occupy space and 
prevent you from seeing more email on one screen.  The gray bars that say 
Today, Last Week and Two Weeks Ago are what we’re referring to in the 
screenshot below. 
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To turn it off the date bars, click the View ribbon  View Settings button 
 Group By button  uncheck Automatically group according to 
arrangement. 

3. Turn Off Message Preview:  This just makes each email occupy 2 or more 
lines in your list.  If you have your reading pane open, you can already read 
the whole thing, so this is redundant information and significantly reduces 
the number of emails you can see at once.  You can turn it off by click View 
ribbon  Message Preview button  Off. 

4. Use Tighter Spacing:  If you have Office 365, then you may see the button 
on the View ribbon that looks like the one shown below.  If you click this, 
it will tighten up the spacing between emails and allow you to see more of 
them at once. 

 

5. See Your Column Headings:  I like to see the column headings as shown 
below.  However, if you’re running your computer at low resolution or you 
have a very wide reading pane, then you might not be able to see them. 
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If you want to see the column headings no matter what, then click the View 
Ribbon  View Settings button  Other Settings button  UNcheck Use 
compact layout…  tick the radio button for Always use single-line layout 
 OK button. 

 

6. Get Rid of Columns You Don’t Want:  Outlook email gives users several 
columns that most people don’t want or need.  If you’d like to get rid of 
unnecessary columns in the grid, click the View Ribbon  View Settings 
Button  Columns button  on the right side of the dialog, just remove 
the ones you no longer want. 

7. Compact Your Navigation Options:  With Outlook 2016, Outlook started 
using Words at the bottom left corner of the email screen for allowing 
users to switch between functions in Outlook (see below): 

 

These huge words take up a couple of rows that could be showing you 

email.  If you’d like to reduce the big words to little buttons, click the  
button adjacent to the big words  Navigation options  check Compact 
Navigation  OK button.  This will convert the big words to little buttons 
as follows: 

 



Page 9 

8. Turn Off Favorites:  At the top of the folder tree in Outlook, you’ll see a list 
of Favorites folders.  Of course, they’re duplicates of the folders shown 
below that.  Since you can simply drag folders into the order you want, you 
may find the Favorites idea to be a waste of space (as I do).  If so, it’s easy 
to turn it off and reclaim the space.  Just click the View Ribbon  Folder 
Pane button  uncheck Favorites. 

B. Add Conditional Formatting:  This feature allows you to change the color, font or 
size of your email based upon certain conditions (for example, if the email is from 
a certain person or group of people, you could have those emails automatically 
turn red and bold the second they hit your inbox).  You find this setting by clicking 
the View Ribbon  View Settings button  Conditional Formatting button. 

 

In the screenshot above, you can see why your unread email is blue and bold.  If 
you want to change that, then all you have to do is select a different color, font 
and/or size from the 2nd dialog on the right. 

You can also create your own conditions.  For example, if I want all email from 
Paul to automatically turn red when they arrive, I could click the Add button  
click the Font button and choose Red under the Color drop down  click OK  
click the Condition button  type Paul’s email address in the From field  click 
OK. 
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After the foregoing steps, Paul’s emails will always turn red in my inbox and I’ll be 
able to spot them easier. 

C. Sort Your Email:  If you click on a column name, it will sort your email by that 
criteria (Received, for example).  If you click the same column name again, it will 
sort in reverse order.  You can also change how email is sorted by clicking the 
appropriate buttons in the Arrangement group on the View Ribbon as follows: 

 

III. EMAIL OVERLOAD 

Most current studies indicate that lawyers receive around 120 and send roughly 40 emails 
per day.1  Without question, email is one of the most important technological 
communication advancements of the past 100 years.  It has fundamentally changed the 
way we communicate with clients and do business.  Major corporations and law firms are 
run via email communication instead of face-to-face communication.    

 
1 See https://www.templafy.com/blog/how-many-emails-are-sent-every-day-top-email-statistics-your-business-
needs-to-know/ 

https://www.templafy.com/blog/how-many-emails-are-sent-every-day-top-email-statistics-your-business-needs-to-know/
https://www.templafy.com/blog/how-many-emails-are-sent-every-day-top-email-statistics-your-business-needs-to-know/
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For lawyers, emails present a wide array of issues that most of the business world and 
ordinary consumers will never face.  In this seminar, we will discuss these issues and teach 
you how best to deal with them. 

These issues or problems range from ethical considerations to email overload and time-
management.  While there is no perfect solution, there are many methods to effectively 
handle email.   

The first step to any problem is to understand the problems that exist.  We must  get our 
arms around all the email issues that face lawyers.  The second step is to isolate each 
problem and tackle each problem, without forgetting how that might affect other email 
problems.  For instance, controlling spam email may prevent you from getting an 
important email from a client if your spam filter inadvertently catches an email from a 
client.   In other words, when you solve one problem, it may open up a different can or 
worms. 

IV. MAIN EMAIL PROBLEMS 

A. Torrent of Interruptions:  In an eight (8) hour work day, if we receive 100 emails, 
that equates to receiving one email every 4.8 minutes.  Sound familiar?   It should, 
because that is the world most of us live in.  Combine that with instant messages, 
phone calls and what I call email curiosity interruptions, that equates to one 
interruption every 2-3 minutes!  What can you do to minimize the distraction? 

Take the following quick survey: 

1. Interruption Survey: 

• Average number of Emails you get per day: ................................  

• Average number of Instant messages per day: ...........................  

• Average number of phone calls you get each day:......................  

• Average number of curiosity email or  
internet breaks each day: ............................................................  

• Total  Interruptions Per Day ...................................................   

2. Other Questions To Ask Yourself: 

• How many times do you look at your email each day? ...............  

• What percentage of interruptions really need  
immediate attention? ..................................................................  
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• Has technology simplified your life?  Yes  No 

• Is Technology the Slave or the Master?  Yes  No 

B. Email Storage: What do we do with all of this email?  There are several problems 
related to this: 

• How should you archive old email? 

• How do you deal with attachments and keep from losing them? 

• How do you search for old conversations quickly and efficiently? 

• How do you keep your email but not run out of server space?  Why does the 
IT person keep telling you that you have too much email in your inbox and 
you're clogging up the server? 

C. Too Much Legitimate Email To Deal With Effectively: Many people simply receive 
more email than they can read and keep up with.  How do you sort, store and track 
all of this email? 

D. No Expectation of Privacy: The old saying goes:  You should never send an email 
that would embarrass you were it to appear on the front page of tomorrow's 
paper.  Is there anything you can do to create an expectation of privacy? 

E. Spam Getting Through: There are lots of ways to avoid SPAM, and yet it still 
manages to get into our mailboxes.  What can you do about it? 

F. Are You Using Outlook Effectively? Probably not.  Although millions of people use 
Outlook, most do not use all of its functionality to their advantage.  In this seminar, 
we'll give you some great tips for making better use of Outlook. 

V. EMAIL STORAGE 

A. Main Storage Problems: 

1. Disorganization: Most people have hundreds or thousands of unrelated 
messages in their inboxes.  This is equivalent to taking all of the paper out 
of your files and throwing it on the floor of the file room.  The point is, if 
it's not organized, then it's mostly useless. 

2. Storage Space Limitations: You may have been scolded by your IT folks 
about this.  If you're using Microsoft Exchange on your server, then it can 
get overloaded with the quantity of emails and attachments you keep in 
your inbox and Outlook folder structures.  If you don't have Exchange, then 
all of those emails (and contacts, and appointments and tasks) are stored 
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in a PST file on your hard drive or the server.  The bigger that database, the 
slower your computer will run.  Of course, the database can also over-run 
your storage capacity. 

3. No One Else Can See Your Email But You: In most cases, if you have an 
important client communication in Outlook, no one else in your office can 
see it.  In many cases, lawyers want to share this information, but don't 
know how to do it. 

4. Difficulties Searching: Many people complain that it's nearly impossible to 
efficiently search old emails for a particular conversation.  What can you 
do to make this task easier? 

B. Start By Organizing Outlook: Setting up folders and using Rules is a great way to 
start to organize your Outlook. 

1. How To Set Up a New Email Folder: To Setup a new Subfolder in your 
Inbox, right-click the Inbox (or your mailbox)  New Folder  give it a 
name.  That’s it. 
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2. Outlook Rules: Rules allow you to auto-sort incoming email (among other 
things).  Here's how you set one up: 

• Click the File menu  Info  Manage Rules and Alerts button. 

• Click the New Rule button  Apply rule on messages I receive. 

 

• Follow the steps for selecting the Condition, Action, Exceptions, then 
give it a name and make sure the rule is turned on! 

3. Sample Rule - Get Notified If Certain People Email You Even Though 
Notifications Are Turned Off:  For purposes of this rule, assume I want to 
be notified if Paul Unger or Debbie Foster send me an email. 

• Click the File menu  Info  Rules and Alerts. 
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• Click the New Rule button. 

• Under "Start from a blank rule," choose “Apply rule on messages I 
receive”  Next button. 

• Check “from people or public group” and when the link for that 
appears in the rule builder screen below, click on the blue link for 
people or public group. 

 

• At the bottom of the next screen, enter the email addresses for the 
people you want to be notified and separate each one with a semicolon 
and a space  click the OK button. 
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• Click Next  and in the next screen check “display a Desktop Alert” and 
click Next.   

 

• Assuming there are no exceptions to this rule, in the next dialog, just 
click Next again. 

• In the next dialog, give the rule a name and click the Finish button at 
the bottom - you’re done! 
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4. Sample Rule - Delay Sent Mail By One Minute (in case you change your 
mind) 

• Click the File menu  Info  Rules and Alerts. 

• Click the New Rule button. 

• Under "Start from a blank rule," choose "check messages after 
sending." 

• On the next screen ("which conditions do you want to check"), don't 
check anything (you want this rule to apply to every email you send) 
and click the Next button at the bottom.   

• In the next screen, check "defer delivery by a number of minutes," and 
then click the hyperlink for "a number of" at the bottom of the screen 
and enter the number of minutes you want to delay your email. 

 

• Click Next and add any exceptions (for people you don't want to delay 
email to). 

• Click Next, name your rule Delay and click Finish. 
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5. Sample Rule - Keep Track of Delegated Email: Many people forward email 
to others to deal with but have a difficult time remembering what they 
delegated for follow up purposes.  Here's a rule that will help. 

• First, create a folder in Outlook called Delegated Email. 

• Click the File menu  Info  Rules and Alerts. 

• Click the New Rule button. 

• Under "start from a blank rule," choose "check messages when they 
arrive" and click Next at the bottom of the dialog. 

• Under "check which conditions do you want to check," check BOTH 
"from people or distribution list" and "where my name is in the CC 
box."  At the bottom of the dialog, click the hyperlink for "people or 
distribution list" and add your email address.  We're basically creating 
a rule that will look for emails from you and copied to you.  Click Next. 

• Under "what do you want to do with the message," choose "move it to 
the specified folder."  Make the specified folder your Delegated Mail 
folder.  Click Next and add any exceptions.  Click Next, name it and click 
Finish. 

C. Outlook Add-On Programs To Help You Sort and Store Your Email: There are 
many third-party programs that integrate with Outlook which can help you 
organize, sort and store your email (both incoming and outgoing).  Here are a few 
to consider: 

1. SpeedFiler by Claritude: See www.claritude.com.   

2. SimplyFile by TechHit: See www.techhit.com/simplyfile.  T 

3. Incoming Mail Organizer Add-In for Microsoft Outlook:  See 
http://www.sperrysoftware.com/Outlook/Incoming-Mail-Organizer.asp. 

4. NEO Pro:  See http://www.emailorganizer.com/ 

5. Quick File for Outlook:  See http://www.standss.com/quickfile/ 

6. Sanebox:  See http://www.sanebox.com/ 

7. QuickFile4Outlook - Lawyers Edition: See www.outlook4lawyers.com. 

D. Archiving Old Outlook Email: Many Outlook users end up with an enormous 
accumulation of email in their Sent Mail and Deleted Mail folders.  Furthermore, 
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some mail is sorted into subfolders and forgotten about.  All of this will start to 
bog down servers and PCs as those databases of emails get larger and larger.  
Thankfully, Outlook has an excellent way to dealing with this problem - 
AutoArchive.  In a nutshell, AutoArchive will allow you to a) permanently delete 
expired items; b) delete or c) archive old items to an archive file (archived 
database).  Conveniently, the first time AutoArchive runs, it creates the archive 
database for you.  It is stored on the C:\ by default so you'll either want to move 
it to a server folder or back it up directly from your C:\.  Once it has established 
itself, you'll see the Archive folder in your Outlook Folder List.  There are two sets 
of AutoArchive settings: global settings and per-folder settings. 

1. Turn AutoArchive On or Off. Click the File menu  Outlook Options  
Advanced (left side)  AutoArchive Settings button.  At the top of the 
following dialog, you'll see "Run AutoArchive every __ days."  If you 
uncheck that box, it will not run.  As you can see from the following screen 
shot, you have many options for this: 

 

Note that these are your default (global) AutoArchive settings. 

2. Control the Archive Settings of a Specific Folder: You can control what any 
particular folder does in Outlook by following these steps:  Right-click the 
folder  choose Properties  click the AutoArchive tab  Make your 
changes and click OK. 
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E. Saving Email Messages Outside of Outlook: When an email message is in your 
Outlook inbox, it is just a record in a database and not a discreet document like a 
Word file.  That fact is a big part of the problem associated with organizing and 
storing them.  Email related to a particular matter is stored in one place; and word 
processor files related to that matter are stored somewhere else.  However, you 
can create documents out of those emails and those documents can be stored 
with every other document related to a particular matter or issue. 

1. Saving Email As A Document: The classic problem that law firms have if 
they do not own a document management system is saving and finding 
matter-specific email.  Why?  Because people (1) keep them in their 
individual inboxes, or (2) save them in subfolders within their own inbox 
(which no one else has access to), or (3) delete the email altogether.  Email 
is valuable correspondence that in most circumstances should be saved.  
However, in a law firm or legal department, it should not be saved within 
one's own individual inbox.   

You can save email much like you save a Microsoft Word document by 
clicking the File menu  Save As.  This will default your file type to an MSG 
file.   

 

2. Saving Email By Dragging Into a Windows Explorer Folder: You can clean 
out your inbox or subfolders under your inbox by cascading the windows 
and simply dragging and dropping all of them into the desired folder.  This 



Page 21 

will COPY the emails over into that folder, saving them automatically as 
MSG (native Outlook Message Format) files, which preserves the metadata 
and all attachments. 

 

3. Saving Email With Document Management Programs (DMS): While 
document management programs (Worldox, iManage Word, 
NetDocuments, etc.) were originally thought of as only word processing 
document repositories, that is no longer true.  They can now hold just 
about any type of computer file (word processor, PDF, TIF, email, JPG, etc.).   

4. Worldox Example: Using Worldox as an example, it provides 3 different 
ways to save emails (see below).  Once profiled and saved, the emails are 
stored within the client/matter structure and easily searchable and 
accessible by anyone who uses the document management system 
(Worldox, in this case)..  It's also important to note that you can save them 
one-at-a-time or large quantities of them all at once. 
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a. Save Email From Within Outlook - Drag and Drop: Saving to 
Worldox from within Outlook – Drag and Drop on the Worldox 
"folder" for a particular matter. 

 

b. Save Email From Within Outlook Using Worldox - Copy or Move 
Buttons: The Worldox/Outlook integration also provides Copy To 
Worldox or Move to Worldox buttons (located in the toolbar 
region of Outlook).  Simply select the email(s) you want to save into 
the system, then click the appropriate button shown below. 
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c. Save Email From Within Worldox: Saving email from the Worldox 
Email Tab which allows you to see your Outlook inbox from within 
Worldox. 

 

5. Saving Email Using a Case/Practice Management Program: This would 
include programs like Amicus Attorney, Time Matters, PracticeMaster, etc.  
If you have a case management program with Outlook integration, you can 
streamline the saving of email by saving them directly into the matter 
within the case management program.  You can also auto-associate emails 
by setting up rules within the practice management program based on the 
sender. 
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6. Amicus Attorney Example: The following is an example of the Amicus 
Attorney Communications area which allows you to save and manage 
email, messages and telephone slips: 

 

This is the Outlook view from within Amicus Attorney.  From this view, you can 
select an email and click on the Save and Make Associations button and it will 
save the email in the designated client/matter folder or contact card.  The huge 
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benefit to this is that you can see all relevant client information, documents and 
emails from ONE program.  It is a very nice luxury. 

 

7. Saving Email as PDF Files: If you have a compatible version of Adobe 
Acrobat, it installs a few buttons and one additional menu in Microsoft 
Outlook.  For those that wish they had a good way to archive and store 
emails and attachments, this integration can be a life-saver. 

 

a. Acrobat - Creating PDFs from Individual Emails or Entire Folders: 
Simply select individual emails (Ctrl + left click) or select entire 
folders; then click the Adobe PDF menu/ribbon  Convert Selected 
Messages  Create New PDF.  This will create a single PDF which 
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contains all of the emails you’ve selected and all of the 
attachments thereto.    

b. Acrobat - Adding Subsequent Emails to Existing PDFs: If you 
receive additional emails which need to be added to an existing PDF 
archive, simply choose Convert Selected Messages  Append to 
Existing Adobe PDF. 

c. Acrobat - Automatic Archival: As you can see from the screen shot, 
you can also setup folders to automatically archive themselves.  
This would be particularly useful if you have setup Outlook rules to 
automatically sort your email into specific folders and then use 
Acrobat to automatically archive it. 

 

d. Saving PDFs Without Acrobat: Other PDF programs that cost a lot 
less than Acrobat offer similar functionality to that described above 
with Outlook.  For example, all of the following are fantastic: 
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i. Nuance Power PDF Advanced:  Matches features of 
Acrobat Professional for only $180.  See 
http://tinyurl.com/zwy2ym9.  Windows only. 

ii. Nuance Power PDF Standard:  Matches features of Acrobat 
Standard for only $100.  See http://tinyurl.com/nbtnasl.  
Windows only. 

iii. Foxit PhantomPDF for Business:  Very strong feature match 
with Acrobat Pro for $159.  Also includes a 30 day free trial.  
For more information, see http://tinyurl.com/7ybcjwu.   
Windows only. 

iv. Foxit PhantomPDF Standard:  Strong match with Acrobat 
Standard for $129.  Free trial - for more information, see 
http://tinyurl.com/p3znuj3.  Windows only. 

v. Nitro Pro:  Matches the features of Acrobat Professional.  
They offer a Nitro Pro+ which is rental only for $7.99/month 
($95.88 paid annually - no option to pay monthly) and Nitro 
Pro (desktop) which is $159.99.  You can buy it here: 
https://www.gonitro.com/pro/for-you.  Windows only. 

F. Email Storage Tips: 

1. Store Email With Other Related Files: Store the email in the same location 
as other electronic files related to any particular matter.  Any system that 
requires you to save email separately from other electronic files related to 
a matter is inadequate. 

2. Delete or Archive Email Once Stored: After an email is stored into a folder 
or a document management system, delete or archive it.  Keep Outlook as 
clean as possible. 

3. Always Separately Save Attached Documents: Outlook is NOT a document 
management system and should not be used as a document repository.  
Documents attached to Outlook emails are actually stored in a temporary 
folder structure that is incredibly convoluted and is normally hidden.  For 
example, the attachment to an email I just opened is stored in my hard 
drive under this folder: 

C:\Users\barron\AppData\Local\Microsoft\Windows\Temporary Internet 
Files\Content.Outlook\O0T0A5E5 

For the record, that's 8 folders deep and the structure from \Temporary 
Internet Files down is not even visible in Windows Explorer.  The point is, 

http://tinyurl.com/zwy2ym9
http://tinyurl.com/nbtnasl
http://tinyurl.com/7ybcjwu
http://tinyurl.com/p3znuj3
https://www.gonitro.com/pro/for-you
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it is incredibly easy to lose attached documents that aren't saved 
separately (unless you have a document management system that saves 
attachments at the same time the email itself is saved). 

4. Stop Printing Email: If you've saved email digitally, then they're easily 
searchable and printing them to throw in paper files only makes your paper 
files fatter, harder to manage and harder to search. 

G. Benefits of Storing Email Outside of Outlook: 

1. No Worry About Email Storage Limitations: If you offload the email in your 
Outlook folder structure and save them as separate files or in other 
programs, then you can get them out of Outlook.  As such, the IT folks will 
stop complaining that you're overloading the Exchange server and your 
computer will operate faster. 

2. Everyone Else Can Find Them Too: Once saved as separate files, others in 
your office will be able to find these important client communications.  
You're on your way to building a complete digital file. 

3. Searchable Like All Other Documents: If you're saving into a document 
management system, then the content of all email stored therein is 
searchable.  If the email is stored as separate files (PDFs, MSG files), then 
there are free or very inexpensive search programs that can help you find 
any of them by the words contained inside them. 

VI. DEALING WITH THE OVERLOAD - YOUR EMAIL GAME PLAN 

A. Deal with Email at Set Times: The first problem that we want to deal with is the 
reduction of interruptions so one can be more focused and productive.  After all, 
how on earth can anyone get anything done with an interruption every 2-3 
minutes?   

Ask yourself the following question:  10 years ago, would you have let someone 
walk in your office every 2-3 minutes offering to sell you a sexual enhancement 
product… or asking you for a favor? 

Of course you wouldn't!  So, why do you let it happen now with your email?  Why 
do you drop everything that you are doing to read and/or respond to that email 
that just arrived?!  You have invested thousands of dollars in this wonderful 
technology that is supposed to make you more efficient, but instead it has created 
an interruption hotline going straight to your brain. 

Some time management experts suggest checking email 2 times a day.  While this 
may sound like a good plan, it is probably unrealistic.  When email was just 
becoming popular, there wasn't an expectation of that email would be dealt with 
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immediately, so 2 times per day was probably okay.  However, in today's age that 
has changed to some degree.  Entire companies communicate via email … it’s a 
way of life and the way everyone communicates.  Checking email twice a day isn't 
enough.  I think 3-5 times a day is more realistic … more satisfying to senders … 
and just as important, will make it easier for you to prevent your inbox from 
growing out of control. 

A good way to handle this is deal with email at the same time every day.  For 
example, you could following this schedule and limit yourself to 10-15 minutes. 

1 – Upon arrival at the office:  8:00 am 

2 – Mid morning:  10:30 am 

3 – After lunch:  12:30 pm 

4 – Afternoon:  3:30 pm 

5 – End of day:  5:00 pm 

B. Turn Off Outlook's Notifications About Email: You see that little envelope in the 
bottom, right corner of your screen and you can almost hear it saying, "read me!"  
The constant notifications of new email are one of the primary distractions for 
most people.  So turn them off!  It's amazing how more focused you can be when 
your computer isn't announcing incoming email every few minutes (or seconds).  
To do this, click the File menu  Options (left side)  Mail (left side)  clear all 
of the boxes under Message Arrival. 

 

C. Treat Email Inbox like you U.S. Mail Box – Keep it Empty! Would you ever keep 
your U.S. Mailbox in this condition?  Of course you wouldn't.  So don’t let your 
inbox get that way!  However, for most people, maintaining email is the weakest 
link in their system of organization primarily because of volume and frequency.  
They use it as a holding bucket for undecided and unresolved tasks. 

The key to mastering your inbox is to keep it empty – or under 20.  You certainly 
don't need to keep it at zero.  In fact, if you tried, you would probably be wasting 
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time, not saving time.  Not to mention, you will also be developing bad 
obsessive/compulsive habits.  Every time an email landed in your inbox, you would 
drop everything and try to deal with it.  That would be horribly inefficient. 

The truth is that in order to process email efficiently, you must be able to see your 
emails in a single screen (or close to it).  It is very difficult and overwhelming to 
process emails and tasks when you are staring at a screen with 500 emails. 

So what do you do with your U.S. Mailbox?  One of the best time 
management/organization tips that I learned and implemented nearly ten years 
ago is this:  Throw away your (U.S.) junk mail and advertisements before you get 
into the house.  Only bring mail into your house that you intend to do something 
with! 

D. Delete Whatever You Can Immediately! Learn how to use the DELETE key.  That 
could be the first thing that you do before you start dealing with email … just like 
not bringing junk mail and annoying advertising into your home.  Delete the 
following: 

• All the email that gets past your SPAM filter. 

• Interoffice SPAM that is irrelevant to you. 

• Jokes from annoying friends and c-workers. 

• Email from people you don't like (unless it's important, of course) 

TIP:  Sort email based on the From field (by hitting the From column header).  You 
can often get rid of tons of email sent from the same person.  Remember that you 
can select a chunk of email by single left clicking on the first email – holding the 
Shift-key down and single left click on the last email. 

E. If You Can Deal With It In Under 3 Minutes, Do It Now: The 3-minute rule is gold!  
Any email that can be responded  to or dealt with (saved in a client file, forwarded, 
deleted, etc.) within 3 minutes should be dealt with immediately – the first time 
you lay eyes on it.  This rule is based on the premise that the 2nd time you have to 
deal with the email, it will take you longer than 3 minutes navigate to it, open it, 
read it, comprehend it, re-familiarize yourself with the topic and then handle it.  
So, why not just respond to it if you have the 3 minutes to deal with it! 

TIP:  Don't forget that you may be able to deal with it more quickly by picking up 
the phone or walking around the corner.  

Remember, you are still supposed to be handling these emails only at 
scheduled/set times during the day!  This will be a difficult temptation to 
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overcome – especially if you have email notification turned on and see an email 
that you can dispose of quickly. 

Finally, if it is an email that is going to take a while, you should dispose of it in 
under 3 minutes by adding it to your task list (or calendar) and then saving it into 
the appropriate client/matter file. 

F. Delegate If Appropriate: If someone else should be handling the task or issue in 
the email, then hand it off appropriately.  Don't let someone else put “the 
monkey” back on you, in the words of The One Minute Manager Meets the 
Monkey by Kenneth Blanchard.  Do this immediately unless it is going to take you 
more than 3 minutes to delegate.  You can make this easy to track by setting up 
the Delegated Email rule described in paragraph V.B.5 above (page 18). 

G. Delay If Necessary: Already mentioned in the 3-minute rule above, if it is an email 
that is going to take a while, you should simply dispose of it in under 3 minutes by 
adding it to your task list (or calendar) and then saving it into the appropriate 
client/matter file. 

• Do not use Outlook as your to-do list by leaving unresolved email in your inbox. 

• If you keep a paper-based task list, simply write it in and save the email in 
appropriate place. 

• If you use Outlook to manage your task list, simply drag it over to your Task 
button in the Outlook navigator. 

• In some circumstances, it is okay to set up subfolders under your inbox.  Clean 
them out on a weekly basis. 

• If you schedule your tasks as appointments, add it to your calendar. 

H. Outlook Techniques Which Will Help: 

1. See More Email In One Screen: 

a. Turn Off Viewing Pane: This occupies a lot of screen space that 
could otherwise be displaying email.  To turn it off in Outlook 2007, 
click the View menu  Reading Pane  Off.  In Outlook 
2010/13/16/19/365, click the View ribbon  Reading Pane button 
 Off. 

b. Turn Off Date Grouping: By default, Outlook groups your email by 
date received.  The date categories just occupy space and prevent 
you from seeing all of your email on one screen.  To turn it off in 
Outlook 2007, click the View menu  Arrange By  uncheck Show 
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in Groups.  In Outlook 2010/13/16, click the View ribbon  View 
Settings button  Group By button  uncheck Automatically 
group according to arrangement. 

2. Quickly Convert Email to Appointments or Tasks: You can simply drag 
email onto your calendar or tasks button in Outlook and it will make an 
appointment or task out of it (but it leaves your original email where it 
was). 

 

 

3. Tasks in Outlook:  Name your tasks based on Project first, and then a 
hyphen followed by a description of the work.  Then modify your task list 
to show only active tasks (not completed).  To do this, select Active Tasks 
and then Customize Current View. 

Next, select Sort items by … Subject and then answer No to showing the 
field.  
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4. Use Outlook 2007/10 Categories: This is a new feature in Outlook 2007 
and is extremely useful for flagging email. 

 

VII. OTHER OUTLOOK TIPS AND TRICKS: 

A. Outlook 2013/16/19/365 Quick Reference Sheet:  See Exhibit A on page 45 
below. 

B. Create Contacts from Email: Drag and drop an email to the Contacts button and 
Outlook will create a new contact card for that email sender. 
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C. Right-Click Email for All Possible Options: Also known as alternate clicking, this 
feature will present very handy functions such as Open, Reply, Print, Forward, etc. 

 

D. Rules Creating Flags and Alerts: You can manage multiple email accounts or large 
numbers of emails from an important client by setting up a Rule that tags the email 
with a colored flag/alert or plays a special sound upon arrival.  This will enable you 
to quickly view and group emails from a particular source. 

E. Out of Office Assistant/Automatic Replies: If you're going to be out of the office, 
this is a way to automatically notify people who send you email.  However, if 
you're receiving email from a listserv, this may be a problem because every time 
someone sends a post to the listserv, everyone on the listserv is going to get your 
out of office message.  In any event, to turn on this feature in Outlook 2007, click 
the Tools menu  Out of Office Assistant  Send Out of Office auto-replies and 
set it up.  If you're using Outlook 2010/13/16/19/365, the feature has been re-
named Automatic Replies.  Get to it by clicking the File menu  Info (left side)  
Automatic Replies button. 
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F. Learn To Use Categories:  This feature allows you to color code or tag an 
appointment, email, contact, or task with a named category which has a color 
assigned to it.  I find these to be particularly useful with appointments and email.  
Assigning a category to an appointment turns the entire appointment the color of 
the category.  You can also sort by category which can be useful with email. 

Let’s say you want to create a category called Billed which you will assign to each 
appointment on your calendar AFTER it is billed.  Just follow these steps: 

1. Right-click an appointment you have billed. 

2. Choose Categorize  All Categories 

3. Click the NEW button and create a category as follows: 
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4. Click OK  OK. 

G. View Non-Contiguous Days on Your Calendar Side By Side:  A business associate 
wants to schedule a lunch on a Thursday in October.  You want to see your 
Thursdays side-by-side.  Here’s what you do: 

1. Go to your Outlook calendar and click on the DAY button. 

2. Left-click on the first Thursday in October. 

3. Now hold down on the Ctrl key and left click the rest of the Thursdays in 
October.  You’ll see all of them side-by-side and can easily determine which 
would work best for you. 

H. Move An Appointment By Dragging It:  If an appointment gets moved, the easiest 
way to make the change on your calendar is by dragging it to the new day.  When 
you’re in the calendar in Outlook, the “Folder Pane” on the left side of the screen 
can be re-sized to show you multiple months.  An appointment from the right side 
of your screen can be dragged to any day you see on the left. 
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If you want to COPY the appointment rather than move it, follow the steps above, 
but hold down on the Ctrl key at the same time. 

I. Saving Attachments to Email: 

1. One At A Time: Open the email, right click the attachment and choose Save 
As. 

2. In Bulk: 

• Outlook 2010/13/16/19/365 - File menu  Save Attachments 

• Outlook 2007 – Office button  Save As  Save Attachments 

• Outlook 2003 – File menu  Save Attachments  All Attachments 

J. Distribution Lists (Outlook 2007)/Contact Groups (Outlook 
2010/13/16/19/365): If you routinely send email to a group of people, you can 
create a distribution list or contact group which will make it much easier.  For 
example, I have a Contact Group called Affinity which automatically sends the 
email to 5 other people.  All I have to type in the TO box is Affinity.  To create one 
in Outlook 2007, just click the File menu  New  Distribution List  name the 
distribution list and add the email addresses of the people you want to include.  In 
Outlook 2010/13/16/19/365, go to your Contacts in Outlook  New Contact 
Group button (Home ribbon)  name the group and add the appropriate email 
addresses. 

K. Find Contacts Super-Fast: For the Quick Contact Search, just hit the F11 key and 
type in a first or last name. 

L. Edit The Auto-Complete List: If you send an email to a person one time, then 
Outlook will remember their email address the next time you start typing anything 
that begins with the first letters of that person's email address.  This has resulted 
in lots of email being sent to the wrong person.  Outlook auto-completes an email 
address and it's the wrong one.  In Outlook 2007, if you want to get rid of that 
person from auto complete you only sent one email to, start typing a name in the 
TO box of a new email.  When the list appears, use your arrow keys to highlight 
the one you want to delete, then hit your delete key.   
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They've made this process easier in Outlook 2010/13/16/19/365.  Just start typing 
a name and when the auto-complete list of names appears, you can hover over 
the one you want to remove with your mouse and click the X that appears on the 
right side of each name: 

 

M. Use Rules and Alerts: To help you keep your Inbox to a manageable size, use the 
Rules feature to automatically forward, move to another folder, or delete 
incoming messages, especially those from email lists. In Outlook 2007, Tools menu 
 Rules Wizard  create a new Rule.  In Outlook 2010/13/16/19/365, File menu 
 Manage Rules and Alerts button.  For more information on this, see paragraph 
V.B.2. on page 14 above.  This is especially helpful if you do not have a good SPAM 
filter.  Rules are also great for managing email from Listserves. 

N. Mailbox Cleanup: This is an extremely useful tool.  In Outlook 2007, you access it 
by clicking Tools menu  Mailbox Cleanup.  In Outlook 2010/13/16/19/365, you 
access it by clicking File menu  Info tab (left side)  Cleanup Tools button.  See 
below for all of the options it provides: 
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O. Remove Redundant Messages in Outlook 2010/13/16/19/365:  This is a feature 
only present in Outlook 2010/13/16/19/365.  An email conversation is also known 
as a thread.  Many people have multiple emails in their Outlook folders which are 
earlier pieces of the same thread.  The last email in time contains the entirety of 
the conversation so the older ones aren't needed.  Outlook now has a great 
feature for cleaning up such messes.  Just follow these steps: 

1. On the home ribbon, click the Clean Up button in the Delete group. 

 

2. Click one of the following: 

a. Clean Up Conversation:  The current Conversation is reviewed, and 
redundant messages are deleted. 
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b. Clean Up Folder:  All Conversations in the selected folder are 
reviewed, and redundant messages are deleted. 

c. Clean Up Folder & Subfolders:  All Conversations in the selected 
folder and any folder that it contains are reviewed, and redundant 
messages are deleted. 

P. Open Multiple Time Zones in Your Outlook Calendar:  I'm often trying to schedule 
phone conferences with people in time zones other than the one I live in (eastern).  
Outlook has a great way to make this easier on you by opening another time zone 
adjacent to yours.  Just follow these steps: 

1. Open your calendar in Outlook. 

2. Right-click the vertical time bar on the left side of the calendar and choose 
Change Time Zone. 

3. Check the Show a second time zone box and choose the time zone you 
want to show, add a label, and click OK. 

 

4. Now you'll have two zones side-by-side! 
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Q. Advanced Search Capability: This feature gives you a tremendous number of 
options for searching through Outlook.  Simply hit Ctrl + Shift + F. 
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R. Email Quick Search in Outlook 2010/13/16/19/365:  At the top of each mail 
folder, you'll see a box like the one below: 

 

This will search for words you type in the email address or body of any email 
contained in that folder and it's very fast. 

S. Junk Mail Settings: In Outlook 2007, click the Tools menu  Options  
Preferences tab  Junk Email button to see all of the settings for this.  You can get 
to the same dialog in Outlook 2010/13/16/19/365 by clicking on Mail  Junk 
button in the Delete group of the Home ribbon  Junk Email Options. 

 

T. Block Senders:  The easiest way to do this is to right-click an email from a sender 
you want to block in the future.  In Outlook 2007, choose Junk Email  Add Sender 
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to Blocked Senders List.  In Outlook 2010/13/16/19/365, right-click the email, 
choose Junk  Block Sender.   

U. Flags: Flags are a great way to alert you to follow up on an important email, 
especially if your plan is to delay action with the email for a day or so.  Simply right-
click on the desired email and select Follow Up and then select the desired follow-
up flag.   

 

You can set a custom date as well.  Outlook will notify alert you on the date and 
time specified. 
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V. Make Outlook Show You Names Last Name First:  Outlook will annoyingly show 
you lists of contacts first name first.  So if you want to send an email to someone 
and click the TO: button, you'll see the names are sorted by first name.  To fix this, 
go into Control Panel in Windows  Mail icon  Email Accounts button  Address 
Books tab  single click on Outlook Address Book  Change button (above)  
make the change shown below: 

 

W. Default Outlook To Your Contacts Address Book:  When you click the TO button 
in a new Outlook email, if you have Microsoft Exchange, it defaults to Global 
Address List which is your internal contact list.  This forces you to switch to 
"Contacts" from the drop-down list every time in order to search your Outlook 
contacts for an email address.  Here's how you change the default in Outlook 
2010/13/16/19/365:  Click Mail in Outlook  on the Home ribbon, click the 
Address Book button  Tools menu  Options  under "When opening the 
address book…" choose Contacts.   
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EXHIBIT A 
OUTLOOK 2013/16/19/365 QUICK REFERENCE GUIDE 

Backstage and Options 

Click the FILE tab to see the “backstage” view in Outlook. Backstage commands include the 
following: 

Info: Account Options 

Out of Office Message or Automatic Replies (Click “Send Automatic Replies” in the dialog 
and type in a message for people in your office and out of your office. These can contain 
the same message.) 

Open & Export: Open Calendar (opens a calendar file, not someone else’s calendar) 

Open Outlook Data File (use to open PST files) 

Import/Export (import or export data) 

Other User’s Folder (use to open someone else’s email or calendar) 

Save As: Save an Outlook item to the hard drive or network. 

Print:  Print an Outlook item. 

Office Account: Product information and/or Office 365 information. 

Options: Opens the options dialog. Key options are the following: 

General: Show Mini Toolbar (if checked, shows mini toolbar when selecting 
text) 

Mail: Compose messages in this format (options are HTML, Plain Text 
and RTF. HTML recommended) 

Mail: Always check spelling before sending (recommended) 

Mail: Spelling and Autocorrect (make sure “Ignore words in Uppercase” 
is not checked) 

Mail: Signatures (set up signatures for new and reply emails) 

Mail: Stationary and Fonts (set up default fonts for new and reply emails) 

Mail: Message arrival (set preference for notification of new email) 
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Mail:  Replies and forwards (set preference to quote prior email message) 

Calendar: Work Time (set work week and start and end times for work day) 

Calendar: Calendar Options (set default reminders) 

Calendar:  Display options (set default color and misc. options) 

Calendar:  Time Zones (important:  set time zone, can add second time zone 
to calendar) 

People: (Set name order and check for duplicates) 

Tasks: (Set reminders and colors). 

Search:  (Search defaults) 

Advanced: (Start Outlook in particular folder; empty deleted items when 
exiting Outlook; show reminders; send email immediately when 
connected; prompt for confirmation before permanently deleting 
items. 

Trust Center: Trust Center Settings->Attachment Handling (sets preferences for 
previewing attachments in Outlook) 

OUTLOOK IS ORGANIZED INTO FOLDERS 

All items in Outlook are stored in Folders. Clicking on Mail, Calendar, People, or Tasks changes 
the view to that folder. To see all Outlook folders, click the three dots next to Tasks and choose 
“Folders”. 
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MAIL 

Configuring the Mail View: 

Almost everything in the mail view can be turned on or off from the controls on the View tab. 
The diagram below show the controls for the various panels. 

 

Reading emails:  Double click on an email message or single click the message with the reading 
pane open. 

Reading emails with attachments:  Switch between viewing the email and the attachment using 
the “Message” and attachment buttons above the text of the email. 

 

Reading Emails as Conversations:  In the View tab for Mail, check the “Show as Conversations” 
box and select “This folder” in the dialog that appears. This groups email messages in a chain of 
emails and displays them as an expanding list. Use the “Clean Up” button on the Home tab to 
remove all emails with duplicate content. 
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Ignore Button (don’t use):  **Warning** use this sparingly or not at all. Clicking this will 
automatically move all future emails in a conversation to the deleted items. 

Filing Mailing Lists or Newsletters automatically with Rules:  (1) Create a folder for the mail list 
or newsletter by right clicking on the mailbox folder and selecting “New Folder”. (2) Right click 
on the email and select Rules->Always move messages from and then choose the new folder as 
the location. This will automatically move those messages to the new folder. There is a limit of 
50 rules in Outlook. 

Junk Mail:  To mark an email as junk, right click the email, select Junk and “Block Sender”. To 
change an email in the junk folder from junk to permitted, right click on the email, select Junk 
and then select “Not Junk”. 

Saving Attachments:  Right click on the attachment and select “Save as” or “Save all”. “Save all” 
will save all the attachments at once to a folder. Alternatively, drag and drop the attachments to 
the desired location. 

Editing Attachments:  Always save the attachment first before editing. Double clicking the 
attachment and opening it from Outlook creates a temporary copy of the file. If you edit the file 
and just click “save” (as opposed to “save as”), the changes will only be saved to the temporary 
file. You may or may not be able to recover those changes at a later date. 

Search for Email Messages:  Type search in the search bar at the top of the email list. The Search 
contextual tab will appear to give extra options. To add search criteria, use the “More” button in 
the Refine group of the Search tab. Change the scope as necessary to search in folders besides 
the current folder (change either in the drop down menu on the search bar or in the Scope group 
of the Search tab). 

Search for Email Messages from the Same Person in the Current Message:  Activate the people 
pane. This will display all messages from the individual in the current message. If the message is 
to more than one person, click on the appropriate person icon in the people pane. 

Search Folders for Repetitive Searches:  To reuse the same search over and over, create a search 
folder by going to the Folders tab and clicking “New Search Folder”. This will create a folder in 
the mailbox. When this folder is selected, the search will automatically re-run. 

Flag a Message for Follow Up:  To flag a message, click the flag icon in the mail list or click the 
flag button on the open message. This will appear on the task list, but is not a task. To make it an 
actual task, drag the email to the Task button. 

Sending Email - autocomplete:  To remove names and email addresses from the autocomplete 
feature, hover over the name and click the X. 

Sending Email - adding attachments:  To add an attachment, either click the attachment button 
or drag and drop the attachment into the email. 
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Sending Email - changing signature:  To change the signature to something else, click the 
signature button on the Message ribbon. 

Sending Email - boilerplate text:  To reuse boilerplate text, select the text and save it as a quick 
part in the Insert ribbon. To reuse, click the quick parts button on the Insert ribbon. 

Sending Email BCC:  Activate the BCC line on the Options tab in a new email. 

Quick Steps: Quick steps are used to automate repetitive steps. To create a quick step, click 
“Create New” in the Quick Step gallery. Choose the steps to repeat. This will create a button that 
will execute those steps. Examples for quick step use are to move the selected email to a folder, 
to send an email to a particular person or group, or to convert an email to a task or appointment. 

Convert Email to Task:  Drag the email to the Task button. 

Convert Email to Appointment:  Drag email to Calendar icon, to time on the calendar or onto a 
date in To-Do bar. 

CALENDAR 

Configuring the Calendar View: 

Almost everything in the calendar view can be turned on or off from the controls on the View 
tab. The diagram below shows the controls for the various panels. 

 

To see tasks underneath the calendar, activate the “Daily Task List” on the View tab. 
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Create New Appointment:  Click on calendar and start typing, click the “New Appointment” 
button on the Home tab, click “Actions->New Appointment” on the Home tab, drag and drop and 
email onto the calendar or press SHIFT+CTRL+A. 

Duplicate an Appointment:  Hold down the control key and drag the appointment to a different 
date. 

Make Appointment Private:  Right click on calendar and select “Private.” No one you share your 
calendar with will be able to see the details of the appointment. Outlook will continue to show 
the time of the appointment as busy. 

Add a Second Time Zone:  Right click on time bar, select “Change Time Zone”, and add a second 
time zone. 

Display Non-Consecutive Days:  Click on the first day, then CTRL+ click on the next days in the 
calendar on the left-hand side. 

Send a Meeting Request:  Either click the new meeting button on the Home tab or, in an 
appointment, click “Invite Attendees” to convert the appointment to a meeting. 

Add Attachment to Appointment:  Drag and drop the document into the Notes field. 

Open a Shared Calendar:  Click “Open Calendar” on the Home tab and then “Open Shared 
Calendar” or File->Open->Other User’s Folder. 

Share Your Calendar:  Click “Share Calendar” on the Home tab to send an invitation. 

Give Elevated Permissions:  Click “Calendar Permissions” on the Home tab, click the user, then 
set the permissions and click “OK”. 

Create Calendar Group:  Select Calendar Groups on the Home tab and Create new calendar 
group. Add calendars or rearrange calendars by dragging and dropping from another group. 

View Email and Calendar in Separate Windows:  Right click on Calendar button and select “Open 
in New Window”. 

Printing Calendars:  Use regular print, but Calendar Printing Assistant is available from Microsoft 
for custom printing. 

Searching for Appointments:  Type in the search box at the top of the calendar. 
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TASKS 

Configuring the Tasks View: 

Almost everything in the tasks view can be turned on or off from the controls on the View tab. 
The diagram below show the controls for the various panels. 

 

Tasks vs To-Do List:  A task is a separate item in a task folder. One or multiple task folders can be 
created (for example a task folder could be created for an individual project). The To-Do List 
aggregates all of the flagged items (emails) and all of the tasks from all of the folders into one list. 
Think of the To-Do List as a “master task list.” 

Creating Tasks:  Click “New Task” on the Home tab, “New Items” then Task, or drag and drop 
email to Task button or screen. 

Flagging an Email Does NOT Create a Task:  Flagging an email will make the email appear in the 
To-Do list, but that is not the same as creating a task. A flagged email will disappear off the To-
Do list if the email is deleted. However, a task created from an email (via drag and drop) creates 
a separate task item, independent of the email. An independent task item will stay on the task 
list even if the original email is deleted. 

Setting Task Reminder:  Check the Reminder box below the task end date, and set a reminder 
date and time. 
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Hide Completed Tasks:  To hide completed tasks, click “View Settings” on the task View Tab, then 
Filter, then Advanced, and add “Complete equals No” to the list. 

Assigning a Task:  Open the task, click Assign Task, enter an email address, and click send. The 
Assignee now becomes the owner of the task and is the only one that can make changes to it. 
The Assignee can also send status reports back to the Assignor. There is a built in view under 
“Change View” to view assigned tasks in a folder. 

Assign a Category to a Task:  Click the Categorize button to add a category (or right click on the 
task). Go to Categorize->All Categories to add, delete, or rename categories. After assigning 
categories to tasks, create a view to sort the tasks by category. Examples of categories might be 
phone call, email, draft, etc. 

PEOPLE 

Create a new Contact:  Click “New Contact” on the Home tab, “New Items,” and then “Contact,” 
drag and drop email on People button, right click on email address and select “add to contacts”. 

Quick Search for a Contact:  Click F11 and then type the name of the contact. F11 will put the 
cursor in the contact search box. 

New People View:  Outlook 2013/16/19/365 defaults to the new People view by default. To 
change back to an older view, just click a different view in the “Current View” box on the Home 
tab of Contacts. The new people view has a streamlined interface and a streamlined editing dialog 
box for contacts. The people view also tries to aggregate contacts. So if the same person is in 
Outlook twice, the people pane will recognize the same name, link the contact cards, and present 
them as one card. 
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Microsoft 365 - The Value Proposition and Very Useful 
Applications It Includes That Most Subscribers Are Not Even 

Aware Of 

I. DEFINITIONS AND EXPLANATIONS:  Before I talk about functionality, we first need to 
define a few things to make sure we're on the same page. 

A. Microsoft 365:  I'll let Microsoft describe this for you: 

“With a subscription to Microsoft 365, you can get: 

• The latest Office apps, like Word, Excel, PowerPoint, and 
Outlook. 

• The ability to install on PCs, Macs, tablets, and phones. 

• 1 TB of OneDrive cloud storage. 

• Feature updates and upgrades not available anywhere else.”1 

Furthermore: 

“Microsoft 365 is the productivity cloud designed to help you 
pursue your passion and run your business. More than just apps 
like Word, Excel, PowerPoint, Microsoft 365 brings together best-
in-class productivity apps with powerful cloud services, device 
management, and advanced security in one, connected 
experience. 

Use professional email and calendaring to reach customers and 
coworkers wherever work takes you. 

Store, access, and share files from anywhere with 1 TB of online 
storage per user. 

Keep your team on the same page with group chat, online 
meetings, and calling in Microsoft Teams, the hub for teamwork. 

Help protect your employees, your data, and your customer 
information with advanced security and device management.”2 

 
1 See https://bit.ly/3klvJui 
2 See https://bit.ly/3qSOLLa 

https://bit.ly/3klvJui
https://bit.ly/3qSOLLa
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B. Microsoft Office: "Microsoft Office” is the name we still use for our familiar 
productivity software. Office suites are available as a one-time purchase and 
include applications such as Word, Excel, and PowerPoint, which can be installed 
on only one PC or Mac. The applications are not automatically updated; to get the 
latest version, you can purchase the product again when the new version becomes 
available. The latest versions currently available for one-time purchase are Office 
2019 for Windows and Office 2019 for Mac. These suites are essentially a snapshot 
in time of Office via Microsoft 365 and do not come with any of the cloud-based 
services included in Microsoft 365.3 

C. Office Online:  There are web versions of Word, Excel, etc., that you can use 
whether or not you have a Microsoft 365 account.  They don't have all of the 
functionality of the desktop versions, but you can do a lot with them.  See 
http://tinyurl.com/pbl63mu for more information. 

D. Microsoft 365 Security:  You can read all about Microsoft 365's security at 
https://bit.ly/302P9el.  In a nutshell, Microsoft 365 offers top-notch security.  It 
has the same user-level security options and Trust Center as the desktop version 
of Office. Rights management Service (RMS) supports encryption and lets you set 
permissions. Offsite, files are saved in specialized data centers where security is a 
primary concern. As a result, small to medium businesses will have better security 
using Microsoft 365 than they can probably afford on their own.   

According to Microsoft, here are Microsoft 365's Top 10 Security and Privacy 
Features: 

• We restrict physical data center access to authorized personnel and have 
implemented multiple layers of physical security, such as biometric readers, 
motion sensors, 24-hour secured access, video camera surveillance, and 
security breach alarms. 

• We enable encryption of data both at rest and via the network as it is 
transmitted between a data center and a user. 

• We don't mine or access your data for advertising purposes. 

• We use customer data only to provide the service; we don't otherwise look in 
your mailbox without your permission. 

• We regularly back up your data. 

 
3 See Microsoft 365 for Business FAQ - http://tinyurl.com/k3r2tx5 

http://tinyurl.com/pbl63mu
https://bit.ly/302P9el
http://tinyurl.com/k3r2tx5
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• We won't delete all the data in your account at the end of your service term 
until you have had time to take advantage of the data portability that we offer. 

• We host your customer data in-region. 

• We enforce "hard" passwords to increase security of your data. 

• We allow you to turn off and on privacy impacting features to meet your 
needs. 

• We contractually commit to the promises made here with the data processing 
terms in your volume licensing agreement. For more information, visit the 
Independently verified section of the Microsoft 365 Trust Center.4 

E. Microsoft 365 Running Offline:  You can use Microsoft 365 offline (without 
internet access) if you download and install the desktop version of Office with your 
plan.  You have to connect to the internet every 30 days to maintain your 
subscription and Microsoft 365 tells you when it's time to connect.  To install the 
desktop versions of the software by clicking the Install Office apps button from 
the main Microsoft 365 screen (see below): 

 

F. Microsoft 365 Administrative Functions:  As you can see from the screen shot 
below, the layout is logical and easy to understand. 

 
4 See https://products.office.com/en-us/business/office-365-trust-center-top-10-trust-tenets-cloud-security-and-
privacy 

https://products.office.com/en-us/business/office-365-trust-center-top-10-trust-tenets-cloud-security-and-privacy
https://products.office.com/en-us/business/office-365-trust-center-top-10-trust-tenets-cloud-security-and-privacy


Page 4 

 



Page 5 

II. MICROSOFT 365 VERSIONS AND SERVICES:  I have given up trying to keep up with the 
incessant changes Microsoft makes to the O365 plans.  Here is a link to the latest summary 
of what is included in each of the business plans:  http://bit.ly/2qROE5g.  To see and/or 
buy the O365 plans most of our clients buy, see http://bit.ly/2qTantS (screen shot below).  
The most popular plan among our law firm clients is Business Standard.   

 

http://bit.ly/2qROE5g
http://bit.ly/2qTantS
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If you want to look at the enterprise plans, see http://bit.ly/2HEmhl1.  We subscribe to 
E3 because it includes message encryption, among other things. 

 

III. INCLUDED PROGRAMS AND APPLICATIONS: 

A. Microsoft Exchange: This is included in some of the Microsoft 365 plans.  I would 
argue that this feature alone is worth the price of admission.  Microsoft Exchange 
is a program that, among other things, allows Outlook users to back up their data 
(email, contacts, calendars, tasks, etc.) on a server.  However, there are much 
bigger benefits: 

1. Share Data:  Exchange also allows users to share information in Outlook.  
For example, I could allow someone else in my office to access my calendar 
electronically and add appointments.  If you're going to use an electronic 
calendar (which we recommend), then you need to have an arrangement 
whereby others in your office can access it when you're not around. 

2. Smartphone & Tablet Sync:  Exchange will wirelessly sync with any 
smartphone or tablet running Android, iOS, Blackberry OS or Windows 
Phone.  This means that everything in Outlook (contacts, tasks, calendar & 
email) will be available from any device you own as long as the device is 
connected to the Internet.  If you want to rely on an electronic calendar, 
then you have to be able to take it with you and Exchange allows this. 

3. Anywhere Email Access:  Exchange also allows users to gain access to 
office email while out of the office in many different devices.  For example, 
I can see my inbox, calendar & contacts on my iPad (or any tablet), on any 
Windows or Mac computer connected to the Internet, or on my 
smartphone.  I can use Outlook Web Access (which comes with hosted 

http://bit.ly/2HEmhl1
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Exchange) via a browser; or I can run Outlook natively on my laptop (for 
example) and as long as I'm connected to the Internet, I'm also connected 
to Exchange. 

4. Full Back Up: Everything in Outlook is backed up in Exchange (email, 
contacts, calendar & tasks). 

5. Operating System Agnostic:  Exchange and Outlook will work with both 
Windows and Mac computers. 

B. Delve: Office Delve is a cloud-based service powered by Office Graph, which helps 
users find and discover pertinent information across integrated Microsoft 
products by pulling user content from Microsoft Exchange, OneDrive for Business, 
SharePoint 2019 and Yammer. In addition to traditional search tools, Delve has a 
discover function, which brings potentially relevant information to the attention 
of users, based on relationships and the past activity of other users within the 
same organization. It is important to note that Delve never presents users with 
content they don't have permission to view. 

Delve, which became available to Microsoft 365 subscribers in March 2015, is also 
a collaboration tool that helps users find colleagues through profiles, and it allows 
them to create, edit and share documents, PowerPoint presentations and more 
with other users. It works similarly to Microsoft Sway in that it also allows users to 
embed documents, videos and images.5 

C. Dynamics 365:  Microsoft recently took the wraps off of Microsoft Dynamics 365, 
a new cloud powered service that repackages and rebrands several Microsoft 
Dynamics programs into an offering that is both. The cloud-enabled Software-as-
a-Service project combines the customer relationship management (CRM) and 
enterprise resource planning (ERP) of previous versions of Microsoft Dynamics 
with additional features including Microsoft Flow and Microsoft PowerApps.6 

D. Forms: According to Microsoft, "[w]ith Microsoft Forms, you can create surveys, 
quizzes, and polls, and easily see results as they come in. When you create a quiz 
or form, you can invite others to respond to it using any web browser, even on 
mobile devices. As results are submitted, you can use built-in analytics to evaluate 
responses. Form data, such as quiz results, can be easily exported to Excel for 
additional analysis or grading."7 

E. Kaizala:  According to Microsoft, "Kaizala is a phone-number based, simple, and 
secure mobile chat app that enables you to connect and coordinate work across 

 
5 See http://searchcontentmanagement.techtarget.com/definition/Microsoft-Delve 
6 Microsoft Dynamics 365: Everything You Need to Know by Michael Simmons, 10/31/16, Tom's IT Pro, see 
http://bit.ly/2vCSDHP. 
7 See https://support.office.com/en-us/forms 

http://searchcontentmanagement.techtarget.com/definition/Microsoft-Delve
http://bit.ly/2vCSDHP
https://support.office.com/en-us/forms
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your network — your organization, vendors, partners, suppliers, and customers."8  
Many feel it's a business version of WhatsApp9. 

F. MyAnalytics:  According to Microsoft, "MyAnalytics provides insights into two of 
the key factors in personal productivity: how people spend their time and who 
they spend it with. You and your team can get these benefits after an 
administrator sets up MyAnalytics within your organization."  It essentially mines 
your usage of the Microsoft 365 products to provide feedback.  10  If you have 
Microsoft 365 for business, then you might have noticed that you're getting emails 
containing information like the screenshot below. 

 

If you find the emails annoying, you can turn it off by following these steps.  Log 
into your O365 dashboard ➔ click the All Apps link in the middle of the screen ➔ 
click the MyAnalytics app ➔ click the Gear in the top, right-hand corner ➔ 
Settings ➔Turn it all off ➔ click save. 

 

 
8 See https://products.office.com/en/business/microsoft-kaizala 
9 See https://www.whatsapp.com/ 
10 See https://products.office.com/en-us/business/myanalytics-personal-analytics 

https://products.office.com/en/business/microsoft-kaizala
https://www.whatsapp.com/
https://products.office.com/en-us/business/myanalytics-personal-analytics
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G. OneDrive:  According to Microsoft, "Securely store and share files from anywhere. 
OneDrive offers native desktop, browser and mobile experiences on your devices. 
Access and make changes that sync automatically in the cloud or sync local copies 
of files for offline viewing and editing on your PC or Mac. Confidently share your 
files so other people can access them seamlessly and securely."11 

H. OneNote:  "Designed to function as an electronic version of a paper notebook, 
Microsoft OneNote is a note-taking and personal information management (PIM) 
application for collecting, organizing and sharing digital information.  By storing 
text notes, photos, audio and video snippets, handwriting and similar content, 
Microsoft OneNote collects and organizes the information, making it available for 
searching as well as sharing with others."12  This application is also free regardless 
of whether you subscribe to Microsoft 365. 

I. Planner:  Take the chaos out of teamwork and get more done! Planner makes it 
easy for your team to create new plans, organize and assign tasks, share files, chat 
about what you’re working on, and get updates on progress. 

1. Easy to use:  Launch Planner from the Microsoft 365 app launcher with a 
single click. You can then create a new plan, build a team, assign tasks, and 
update status—in a few easy steps. 

2. Organize work visually:  Each plan has its own board, where you can 
organize tasks into buckets. You can categorize tasks based on their status 
or on whom they’re assigned to. To update the status or change 
assignments, just drag and drop tasks between columns. 

3. Visibility and transparency:  The My Tasks view provides a comprehensive 
list of all your tasks and their status across all your plans. When working 
together on a plan, team members always know who is working on what. 

4. Collaborate around tasks:  Built for Microsoft 365, Planner lets you attach 
files to tasks, work together on those files, and even have conversations 
around tasks without switching between apps. With Planner, all your 
team’s discussions and deliverables stay with the plan and don’t get locked 
away across disparate applications. 

5. Works across devices:  Planner works across all your devices. And with 
Planner, everyone is always on the same page. A glance at Charts is all it 
takes to know where things stand and if the team is making enough 
progress towards their goal. 

 
11 See http://bit.ly/2qT1bFS 
12 See https://www.webopedia.com/TERM/M/microsoft_onenote.html 

http://bit.ly/2qT1bFS
https://www.webopedia.com/TERM/M/microsoft_onenote.html
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6. Email notifications:  With Planner, you’ll never miss a beat! Receive email 
notifications whenever you’re assigned a new task or added to a 
conversation.13 

J. Power Automate:  This app was formerly known as Flow.  “Power Automate is a 
service that helps you create automated workflows between your favorite apps 
and services to synchronize files, get notifications, collect data, and more.”14   

K. Power BI: If you’re wondering, BI stands for Business Intelligence.  “Microsoft 
Power BI is a business intelligence platform that provides nontechnical business 
users with tools for aggregating, analyzing, visualizing and sharing data. Power BI's 
user interface is fairly intuitive for users familiar with Excel and its deep integration 
with other Microsoft products makes it a very versatile self-service tool that 
requires little upfront training.”15  For example, we use it to pull information from 
our accounting system and create useful dashboards and reports that visually 
represent critical data points and progress toward goals. 

L. Project:  “Microsoft Project (MSP) is a project management software made for 
project managers so they can control their projects. Depending on your plan, 
Microsoft Project lets you plan projects, assign tasks, manage resources, make 
reports and more. It offers a full plate of services and was quick to dominate the 
project management software field when it was first introduced.”16   

M. SharePoint:  "SharePoint is Microsoft’s premier collaborative server environment, 
providing tools for sharing documents and data across various organizations 
within a company’s network. Typically deployed on a company’s network as a 
series of intranet sites, SharePoint lets various departments control their own 
security, workgroups, documents, and data. 

As with any other website, a SharePoint site — or an individual page within the 
site — is accessible by way of a URL that the user can access using a standard web 
browser. 

SharePoint is most often used for the storing of version-controlled documents, 
such as Word documents and Excel worksheets. In many environments, email is 
used for passing documents back and forth between users. The potential for 
mixing up different versions of the same document is considerable. Also, storing 
multiple copies of the same document takes up a lot of disk space. Because 

 
13 See https://products.office.com/en-us/business/task-management-software 
14 See https://bit.ly/3sw3Suq 
15 See Microsoft Power BI by Jesse Scardina and Lauren Horwitz, TechTarget - https://bit.ly/2ZQRuZw 
16 See What Is Microsoft Project? Uses, Features and Pricing by Megan Blackburn, March 3, 2020 - see 
https://bit.ly/3szIkga 

https://products.office.com/en-us/business/task-management-software
https://bit.ly/3sw3Suq
https://bit.ly/2ZQRuZw
https://bit.ly/3szIkga
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SharePoint provides a single source for storing, viewing, and updating documents, 
many of these issues are eliminated. 

And because SharePoint easily handles virtually any type of document, it is 
frequently used to consolidate and store various types of documentation (project 
drawings, videos, schematics, photographs, and workbooks, for example) that are 
required for large projects where multiple teams must collaborate."17 

N. Skype For Business:  "Skype for Business, formerly known as Microsoft Lync 
Server, is a unified communications (UC) platform that integrates common 
channels of business communication and online meetings, including instant 
messaging (IM), presence, voice over IP (VoIP), voicemail, file transfers, video 
conferencing, web conferencing and email."18  Note that the VoIP phone capability 
only comes with the Enterprise E5 bundle which is $420/user/year 
($35/user/month).  Note that this is not really bad considering it makes Microsoft 
365 your business phone system as well. 

O. StaffHub:  "Microsoft StaffHub is a cloud-based platform designed for employees 
whose job requires them to be on their feet or on the go. Examples include 
baristas, hair stylists, waiters, bus drivers, and so on. StaffHub helps you create 
and manage work shifts, share files, and communicate important information with 
team members. It's available to Microsoft 365 for business subscribers and comes 
with a web app for managers and mobile app for employees. The mobile app 
supports both iOS and Android."19 

P. Stream: "Microsoft Stream is a cloud video service that provides a secure and easy 
way for employees at organizations of all sizes to upload, watch, share, organize 
and discover all videos within their organization from a single portal."20 

Q. Sway:  According to Microsoft:  Sway makes it quick and easy to create and share 
polished, interactive reports, presentations, personal stories, and more. Add your 
content, and we'll do the rest.  Bring your Sway to life with interactive content. 
Include a video to talk about your idea or add an interactive chart to let others 
dive into the details. Sway suggests searches to help you find relevant images, 
videos, tweets, and other content that you can drag and drop right into your 
creation. No need to juggle apps and web pages to find what you want. You don't 
need to worry about formatting, Sway's built-in design engine takes care of it. If 
the first design isn't right for you, Remix! it to see others or customize it to make 
it your own. It's super easy to share a Sway. Family, friends, classmates, and 

 
17 What Is SharePoint? by Michael Alexander, see http://bit.ly/2qUDiO0  
18 See http://bit.ly/2HJXjR6 
19 See http://bit.ly/2HLT3jY 
20 See http://bit.ly/2qStZOC 

http://bit.ly/2qUDiO0
http://bit.ly/2HJXjR6
http://bit.ly/2HLT3jY
http://bit.ly/2qStZOC
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coworkers can see your creation on the web without signing up or downloading 
additional software. And you can change privacy settings for more control.21 

R. Teams:  This description is from TechTarget:  Launched in beta in November 2016, 
Microsoft Teams is a chat-based collaboration tool that is part of the Microsoft 
365 suite of services. Teams enables remote, global and dispersed teams to work 
together and collaborate through a common workspace, team chat, one-on-one 
chat, document collaboration and more. Teams is integrated with a variety of 
other Microsoft 365 services, including SharePoint, Skype, Yammer and Exchange. 

Teams offers three clusters of functionality and is poised to compete with services 
like Slack, Jive, HipChat, Salesforce Chatter and others. It touts itself as a native 
chat tool for Microsoft shops using other Microsoft 365 services. While the core 
of the tool is real-time chat among teams, Teams enables other core collaboration 
platform functions by using APIs to integrate document management, video and 
other applications.  Teams includes the following core capabilities: 

1. Chat. While conversations are visible to the entire team, they can also be 
made private. Skype video is deeply integrated into the application, and 
team members can add emojis and custom memes to discussions. 

2. Hub. Microsoft Teams provides a consolidated space for various Office 
applications, including Word, Excel, PowerPoint, SharePoint, OneNote, 
Planner, Power BI and Delve. It enables teams to work natively and 
collaboratively, without having to toggle between applications as they 
collaborate. 

3. Easy customization of teams. The tool features APIs that plug into various 
cloud-based documents and cloud services. Microsoft Teams utilizes the 
same Connector model as Exchange, which enables notifications and 
updates from Twitter and other third-party applications.22 

S. To-Do:  This is a fantastic task management application that is actually free 
regardless of whether you have a Microsoft 365 subscription. 

T. Video:  Upload, share and play videos in your organization.  Note that is not for 
sharing videos for people who are not on your Microsoft 365 account. 

U. Whiteboard:  Microsoft Whiteboard is a freeform digital canvas on the Surface 
Hub where people, ideas, and content come together. Whiteboard also comes 
with a virtual lasso that lets you drag and resize content so it's easy to manage 

 
21 See https://sway.com/ 
22 See http://searchcontentmanagement.techtarget.com/definition/Microsoft-Teams 

https://sway.com/
http://searchcontentmanagement.techtarget.com/definition/Microsoft-Teams
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your ideas, and keep things organized for the team.  Think of it as a digital 
sketchpad.  It's a lot more useful if you have a touchscreen device.23 

V. Yammer24:  Here's an explanation from PCWorld.com.  I am friends with a few 
lawyers whose firms use this and it received high praise from them. 

A Social Network for Your Business:  Yammer is essentially a social 
network that’s entirely focused on your business. In order to join your 
business's Yammer network, an applicant must have a working email 
address from your company's domain. You can also create external 
networks to allow non-employees, such as suppliers and customers, to 
communicate with your company. 

The Ticker:  The similarity between the Yammer and Facebook user 
interfaces is surely no accident.  As with Facebook, new posts—complete 
with Likes—appear in Yammer’s primary screen, which is known as the 
Newsfeed. Icons indicating private messages and other notifications 
appear in the upper left-hand corner. You can also create groups, which is 
helpful for segregating talk that's relevant only to specific internal teams. 
If a group conversation takes a turn that requires assistance from other 
employees, you can share it with a specific person via instant message or 
with another group entirely. Sharing a post with specific groups is a breeze 
thanks to handy-dandy drop-down menus below the Update box (which is 
similar to Facebook’s Status box). 

Hashtags:  The overuse of hashtags on Twitter can make your eyes bleed, 
but they're very useful on Yammer. Yammer's robust search function digs 
up hashtagged posts lickity-split, so be sure to slap a #2013projections or 
#KeyCorporateAccount hashtag on the end of your posts for future search 
posterity. @mentions are also supported. 

Contact Coworkers:  You can create external networks and invite non-
employees (suppliers and clients, for instance) to join them.  The People 
Directory automatically creates a searchable database of every person 
enrolled in your Yammer, making it especially easy to find contact 
information for the people in your company. Even better, profiles have 
Skills listings that are also searchable in the People Directory. You'll never 
have to scramble to find the right person for the job again. 

Sharing Files:  Anyone can attach a file to a post to quickly share 
information without forcing recipients to slog through clogged inboxes. 
You can also upload files—including images and videos—to a file 

 
23 See https://products.office.com/en-us/microsoft-whiteboard/digital-whiteboard-app 
24 See https://products.office.com/en-us/yammer/yammer-overview 

https://products.office.com/en-us/microsoft-whiteboard/digital-whiteboard-app
https://products.office.com/en-us/yammer/yammer-overview
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repository, where other Yammerers can download and update them. 
Groups have their own separate file repositories that augment the main 
one, and employees can receive automatic notifications whenever critical 
files are updated. 

Collaborating:  In addition to the previously mentioned file repositories, 
teams can also collaboratively create Pages (Pages are essentially 
documents) in a group setting. Admins have the ability to lock down Pages 
(and all other files) as official or read-only. 

Mobile Platforms:  Yammer has apps for iOS, Android, BlackBerry, and—
of course—Windows Phone. 

Less Email:  Yammer claims that companies using Yammer generate about 
40 percent less email.25 

IV. MANY OTHER PROGRAMS INTEGRATE WITH MICROSOFT 365:  Nearly every legal case 
management system and all document management systems integrate with Microsoft 
365.  For example, this is from Clio's website (a legal case management system): 

 

V. MICROSOFT 365 CONTINUOUSLY UPDATES THE SOFTWARE:  In other words, Microsoft 
will constantly send you updates that will install in the background to the O365 product 
suite.  To get an idea of what I'm talking about, see What's New In Microsoft 365 here 
(http://tinyurl.com/n9x9f4j).  If you scroll down to the bottom of that page, you'll see that 
Microsoft updates Microsoft 365 every month.   

VI. WOULD MICROSOFT 365 WORK FOR YOUR FIRM?  In short, yes.  We have many clients 
using it and loving it.   

 
25 What the Heck Is Yammer? by Brad Chacos, PCWorld, Aug 7, 2012.  See http://tinyurl.com/8plp6xs. 

http://tinyurl.com/n9x9f4j
http://tinyurl.com/8plp6xs
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I. INTRODUCTION: 

A. Speech Recognition v. Voice Recognition:  Depending on whom you talk to, you 
may get different definitions for these terms.  Voice recognition is sometimes 
defined as recognition of individual words or a particular person's voice.  Speech 
recognition is usually somewhat more advanced, and refers to software that picks 
up speech patterns in order to distinguish between words that sound the same 
(like two, too, and to).  

B. Why Lawyers Need Speech Recognition:   

1. Dictation/Transcription Is Expensive:  Payroll is the number one cost of 
every law firm.  Therefore, transcription is expensive because it requires 
the involvement of support staff.  Plus, the transcribed documents is 
typically printed and reviewed on paper by the lawyer.  The further edits 
then have to be re-entered into the word processor document and it's 
often printed yet again.  The cost structure of this approach is just very 
expensive.  With speech recognition, the transcriptionist wouldn't be 
wasting time typing content.  Instead, they can focus just on formatting 
(which takes far less time). 

2. Time Entries:  Lawyers often write down time entries which are entered 
by someone else into the billing system.  This can be completely avoided 
with speech recognition because the lawyers can simply speak their time 
entries directly into the accounting program. 

3. Email:  Many lawyers just aren't good typists and feel frustrated with 
having to constantly draft and send emails all day.  Again, speech 
recognition software can make that easy. 

4. Faster:  Most people can speak 180 words a minute.  Almost no one can 
type that fast. 

C. How Speech Recognition Works:  All of the speech recognition programs require 
three parts to work. 

1. Acoustic Model - this is a model of your voice and is involved in the process 
of converting your voice to a digital form that the computer can analyze. 

2. Vocabulary - list of words that the computer will recognize.  Remember, if 
the word is not in the vocabulary, the program will not know what it is you 
are trying to say. 

3. Language model - the language models are statistical models of the way 
we speak.  The models typically use unigrams, bigrams and trigrams.   
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a. Unigram - probability of a particular word appearing. 

b. Bigram - probability of two words appearing in a particular order. 

c. Trigram - probability of three words appearing in a particular order.  
Trigrams improve accuracy.  In 300,000,000 words analyzed in the 
Wall Street Journal there were 65,000,000 Trigrams that occurred 
only once. 

II. SOFTWARE:  There are several software products currently available for speech 
recognition.   

A. Dragon:  Dragon is owned by Nuance (see www.nuance.com).  Nuance sells the 
software direct, but you can get a better deal by shopping around a bit.   

1. PC Versions and List Prices:   

a. Differences Between Group and Individual: If you go to Nuance’s 
website and browse through their products, you’ll see they offer 
Dragon Professional Group and Dragon Professional Individual. You 
only need Group if you need network support for roaming profiles 
because you’ll be dictating from multiple computers.  Most people 
don’t do that so you can avoid the extra cost of group by buying the 
Individual versions of the software. 

b. Dragon Home (for home and student use):  $75 This is not 
appropriate for use in a law firm.  

c. Dragon Professional Individual (for professional productivity and 
small business):  $500 is the list price, but pricing fluctuates wildly 
on Amazon - With powerful customization features, Dragon 
Professional Individual is ideal for professional individuals or small 
business owners. Create and transcribe documents, use simple 
voice commands to short-cut repetitive steps, like inserting your 
signature, or customize the vocabulary. Synchronize with Dragon 
Anywhere professional-grade mobile dictation, and get paperwork 
done anywhere.  As of 4-27-21, here’s a sample price with headset: 
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d. Dragon Professional Individual Wireless (for professional 
productivity and small business):  $400 - Same as Dragon Pro 
Individual above, except it includes a wireless Bluetooth headset. 

e. Dragon Legal Individual (for legal professionals and small 
practices):  $500 - With a specialized legal vocabulary, Dragon Legal 
Individual is the fastest way to streamline legal documentation and 
improve costs, simply by speaking. Whether buying for individual 
use or your small practice, legal professionals can save time 
creating contracts, briefs and other legal documents, reduce 
transcription costs, and improve overall practice productivity—all 
by voice. 

2. Mac Versions:  Unfortunately, Nuance abandoned speech recognition 
software for the Mac in 2018.  However, Dragon Anywhere (see next) 
works on an iPhone. 

3. Dragon Anywhere:  This is an app for any iOS or Android phone which 
allows you to dictate into your phone and have it automatically 
transcribed.  According to their website1, Dragon Anywhere professional-
grade mobile dictation makes it easy to create documents of any length 
and edit, format and share them directly from your mobile device—
whether visiting clients, a job site or your local coffee shop.   

 
1 See https://www.nuance.com/dragon/dragon-anywhere.html 

https://www.nuance.com/dragon/dragon-anywhere.html
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a. Continuous dictation and no word limits 

b. 99% accurate with powerful voice editing and formatting 

c. Access customized words and auto-text across all devices 

d. Share documents by email, Dropbox, Evernote and more 

The app is free for a week trial, $15/month or $150/year (17% savings over 
going month-to-month).  There’s also a Dragon Legal Anywhere although 
they appear intent on concealing pricing - see https://bit.ly/32RWuPh. 

4. Recommended Version:  We recommend that you go with Dragon 
Professional at a minimum.  If you dictate a lot of case & statutory citations 
and you use a Windows PC, then it would be worth getting Dragon Legal.  
Otherwise, you can easily teach Dragon Professional to correctly spell any 
legal words you use that the Professional version doesn't understand out 
of the box. 

B. BigHand:  BigHand has several speech recognition products that merit 
consideration.  See https://bit.ly/3dQIR6w for more information. 

C. Office Dictation:  If you subscribe to Microsoft 365, you get this in Word and 
Outlook for free.  It’s pretty accurate although you can’t teach it new words or 
how to spell something correctly that it is misinterpreting (like a proper name).  
For more information, see https://bit.ly/30ntVJm.  The button in Word is on the 
home ribbon and looks like this: 

 

III. HARDWARE: 

A. Computer Requirements:  In order to use speech recognition software effectively, 
you will need some advanced hardware.  Completely ignore the system 
requirements on Nuance’s website.  If your computer only satisfies their minimum 
requirements, you will be incredibly frustrated with your experience.  We 
recommend a 9th or 10th gen or more recent Intel i5 or i7 processor, and at least 
16 GB of RAM.  

B. Microphones:  Of course, Dragon can be purchased with a microphone, but the 
base version does not include one.  Nuance used to publish microphone rankings 
but has stopped doing so.  They are instead trying to sell you their microphones 

https://bit.ly/32RWuPh
https://bit.ly/3dQIR6w
https://bit.ly/30ntVJm
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(see https://bit.ly/3dUKvGT). I’m not saying they’re not good, but almost any good 
USB or wireless microphone will work well.  Even though they don’t publish the 
list anymore, the following is still a good list of options from the old Dragon 
microphone compatibility list. 

 

C. Digital Voice Recorder:  There are many digital voice recorders on the market.  
The Olympus DS-9000, and Philips DPM8000 are good generally recognized as the 
best choices, and each has a slide switch that works similar to a handheld tape 
recorder.  Digital voice recorders have many different types of controls.  Try before 
you buy, and make sure that their software integrates with Dragon. 

IV. INSTALLATION:  In older versions of Dragon, you had to read long passages so it could 
learn how you speak.  When I installed Dragon Professional Individual version 15 on my 
Windows 10 laptop, there was no training required at all.  I read a few sentences to set 
up my microphone for proper volume and to make sure it was working correctly, and that 
was it. I immediately started dictating at that point and the accuracy was astonishing.   

V. WHAT YOU CAN DO WITH DRAGON:  People often think that speech recognition is fairly 
limited in its capabilities.  However, here are all of the things you can do: 

A. You Talk - It Types:  Most people think speech recognition is limited to this 
functionality.  The Premium edition is limited to your word processor, but the 

https://bit.ly/3dUKvGT
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Professional and higher versions allow you speak into almost any program that 
will accept text.  Think time-entries, emails and the like. 

B. Control Your Computer:  For example, you can open programs, control them once 
opened, browse the Internet and perform many other functions you would 
otherwise need a mouse and keyboard to perform. 

C. Transcription:  You can dictate using the following methods and Dragon will 
transcribe it for you. 

1. Using an App:  Dragon Remote Microphone App for iOS and now Android: 
Dragon lets you go wireless with an iOS or Android device and the free 
Dragon Remote Microphone App. Turn your compatible iPhone, iPod 
touch (4th gen), iPad or Android device into a wireless microphone for use 
with Dragon over a WiFi network.  

2. Using a Digital Voice Recorder:  For a video on how this works, go here 
(http://www.nuance.com/dragon/transcription-solutions/index.htm) and 
click on the transcription videos shown below. 

 

VI. DRAGON - LEARNING TO DICTATE:  If you want your documents to be perfect, then you 
have to learn to dictate perfectly.  There are a few things you need to keep in mind: 

A. Try To Speak Naturally:  Dragon NaturallySpeaking knows many words. Do not 
wait for them to appear on the screen.  Just keep dictating in a steady, normal 
voice. 
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B. Enunciate! Enunciate! Enunciate!  If you do not enunciate, the computer will 
misinterpret the dictation: 

"Two Thousand Two"  =  "Two Dozen Two" 

"and" = "in" 

C. Pauses Are Significant:  You will achieve the best results when you dictate in 
complete phrases or sentences without pauses.  (Remember Dragon's recognition 
is based on bigrams and trigrams).  However, pauses are very significant.  They can 
signify the end of dictation and the beginning of a command.  They also mark the 
beginning and the end of a phase that can be edited with your voice using the 
word "that". 

1. Example "that" commands: 

a. "Scratch that" - delete the last dictation between pauses. 

b. "Spell that" - spell out the last dictation between pauses. 

c. "Cap that" - capitalize the last dictation between pauses. 

d. "Bold that" - bold the last dictation between pauses. 

e. "All caps that" - capitalize all letters in the last dictation between 
pauses. 

f. "Select that" - select the last dictation between pauses. 

2. Example dictation using pauses: 

Dictation: "I have to scratch that itch" 
Result:  I have to scratch that itch 
 
Dictation:   I have to <pause> scratch that <pause> itch 
Result:  itch 
 
Dictation: I have to <pause> scratch that itch 
Result:  I have to scratch that itch 
 
Dictation:  "This is very important <pause> bold that" 
Result:  This is very important 
 
Dictation:   "This is very <pause> important <pause> bold that" 
Result:  This is very important 
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3. Different Modes:  Dragon has 5 different modes: 

a. Normal Mode.  The default mode.  Switches automatically between 
dictation and commands.  Distinguishes dictation from commands 
by analyzing what you say between pauses 

b. Dictation Mode.  Will interpret all speech as words, and will not 
execute any commands. 

c. Command Mode.  Will interpret all speech as commands, and will 
not interpret any speech as words.  

d. Numbers Mode.  Will interpret all speech  as numbers. 

e. Spell Mode.  Use to dictate letters, digits or symbols. 

4. Switching Between Modes:   

a. Normal Mode On / Normal Mode Off 

b. Start Normal Mode / Stop Normal Mode 

c. Dictation Mode On / Dictation Mode Off 

d. Start Dictation Mode / Stop Dictation Mode 

e. Command Mode On / Command Mode Off 

f. Start Command Mode / Stop Command Mode 

g. Spell Mode On / Spell Mode Off 

h. Start Spell Mode / Stop Spell Mode 

i. Numbers Mode On / Numbers Mode Off 

j. Start Numbers Mode / Stop Numbers Mode 

D. Punctuation:  Some common punctuation and symbol commands: 

. period 
( open paren 
) close paren 
" open quote 
" close quote 
' open single quote 
' close single quote 
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, comma 
@ at sign 
? question mark 
! exclamation mark (or exclamation point) 
: colon 
- hyphen 
§ section sign 
; semi colon 
' apostrophe 
's apostrophe-ess 
$ dollar sign 
& "ampersand" or "and sign" 
%  percent sign 
© copyright sign 
™ trademark sign 
 

E. Capitalization:  Dragon will automatically capitalize the first letter of every 
sentence (unless that feature is turned off), and will capitalize many proper nouns 
that are already in its vocabulary.  For every other situation, use the "cap" 
command.  Using cap before a word will capitalize that word: 

Dictate: "liberty mutual insurance company" 
Result:  liberty mutual insurance Co. 
 
Dictate: cap liberty cap mutual cap insurance cap company 
Result:  Liberty Mutual Insurance Co. 
 
Dictate: <pause> liberty mutual insurance company <pause> cap that 
Result:  Liberty Mutual Insurance Co. 
(Of course, a better solution would be to just add Liberty Mutual Insurance 
Company to the vocabulary so that it is capitalized correctly every time) 

F. Proper Names:  Proper names can be one of the most frustrating things to dictate 
to a computer.  If the name is fairly common, just say it normally and see if Dragon 
already has it in its vocabulary.  Otherwise you will have to spell it.  Depending on 
how you spell it, it may or may not be added to your vocabulary.  Usually, you 
should just have to spell it once, and then Dragon will type it correctly thereafter. 

There are several ways to spell a name:   
Dictate: "<pause>spell" 

This brings up the spelling window and lets you spell the word by voice.  When 
you are done, say "click ok", and the proper name will be added to the vocabulary 

Dictate: "<pause> <proper name> <pause> spell that" 
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This will bring up the spelling window and lets you spell the word by voice.  When 
you are done, say "click ok", and the proper name will be added to the vocabulary. 

Dictate: "Spell mode on" <spell the name> "Spell mode off" 

This will let you spell the word, but it will not add it to the vocabulary. 

Note on spelling.  Our alphabet has many letters that rhyme or sound the same.  
For example 

b c d e g p t v; a k j; i y; s f; m n;etc. 

Dragon knows and responds to the "international alphabet" which can eliminate 
spelling errors from letters that sound the same.  It is worth learning and 
memorizing these: 

alpha 
bravo 
Charlie 
delta 
echo 
foxtrot 
golf 
hotel 
India 

Juliet 
kilo 
lima 
Mike 
November 
Oscar 
papa 
Quebec 
Romeo 

sierra 
tango 
uniform 
Victor 
whiskey 
xray 
yankee 
zulu 
 

G. Legal Citations:  If you imported the authorities into the vocabulary, case citations 
may be dictated directly (with the possible exception of the actual case name, 
which may have to be spelled): 

Dictate: "Ohio Revised Code Section Thirty Nine Thirty Seven Point One 
Eight" 

Result:  Ohio R.C. § 3937.18 

Dictate: "Two Thousand Two Hyphen Ohio Hyphen Two Zero One Four" or 
"Two Thousand Two Hyphen Ohio Hyphen Two Thousand 
Fourteen" 

Result: 2002-Ohio-2014  

Older versions of Dragon have had trouble with the “v.” in case citations. A 
solution to this is to add a “v.” to the vocabulary with the pronunciation “veedot”.  
You will have to train this word. 
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Dictate: "State Veedot Smith Open Paren Nineteen Ninety Eight Close Paren 
Comma Eighty Six Ohio State Third Two Forty Eight Comma Seven 
Ten North East Second Four Four Four Four" 

Result: State v. Smith (1998), 86 Ohio St.3d 248, 710 N.E.2d 4444. 

(This trick is not necessary in Dragon 11 Legal Edition) 

Another solution is the following, more lengthy pronunciation: 

Dictate: "State <pause> space <pause> Spell Victor Period <pause> Smith 
Open Paren Nineteen Ninety Eight Close Paren Comma Eighty Six 
Ohio State Third Two Forty Eight Comma Seven Ten North East 
Second Four Four Four Four" 

Result: State v. Smith (1998), 86 Ohio St.3d 248, 710 N.E.2d 4444. 

Note the use of the spell command to spell out the "v." in the case name.  The 
reason is that usually Dragon anticipates that an individual letter with a period 
should be capitalized. For example: 

"State Vee Period Smith" = State V. Smith 

H. Turn “On” or “Off” Formatting: 

Bold on   Bold off 

Caps on   Caps off 

All caps on   All caps off 

Italics on   Italics off 

Underline on   Underline off 

I. Proofread Your Document:  Do not rely on your word processor’s spell check 
feature to find errors in your document.  Speech recognition software does not 
misspell any words.  However, it may type the wrong word.  Be careful!! 

J. Voice Macros:  Dragon can insert boilerplate text into a document on command.  
To set this up, first type out the text that you would like to have Dragon insert and 
copy it.  Go to Tools  Add New Command and paste the text into the content 
window: 
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Next give the command a name and click “Save”.  Whenever you state the name 
of the new command, Dragon will insert the content. 

Make sure the command name is something you would not normally say in 
dictation. 
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VII. DRAGON COMMON COMMANDS: 

A. Punctuation: 

. period (or dot or point) 
( open paren 
) close paren 
{ open brace 
} close brace 
[ open bracket 
] close bracket 
< open angle bracket (or 

less than) 
> close angle bracket (or 

greater than) 
" open quote 
" close quote 
' open single quote 
' close single quote 
, comma 

? question mark 
! exclamation mark (or 

exclamation point) 
: colon 
§ section sign 
; semi colon 
' apostrophe 
's apostrophe-ess 
@ at sign 
# pound sign (or number 

sign) 
$ dollar sign 
%  percent sign 
^ caret 
& ampersand (or and 

sign) 

* asterisk 
_ underscore 
- hyphen (or minus sign) 
+ plus sign 
= equal sign 
© copyright sign 
™ trademark sign 
\ backslash 
/ forward slash 
... ellipsis 
º degree sign 
~ tilde 
€ euro sign or euro or 

euros 
£ pound sterling sign 
¥ yen sign or yen 

 
left/right may be substituted for open/close except for single quote 

 
B. Formatting: 

Bold on/Bold off /Bold That/Format that Bold 
Italics on/Italics off/Italicize that/Format that Italics 
Underline on/Underline off/Underline that/Format 
that Underline 
Format that Plain Text 
 
Format that Left Aligned/Left Align that 
Format that Right Aligned/Right Align that 
Format that Centered/Center that 
New Line  1 Enter/Return 
New Paragraph 2 Enter/Returns 
 
Hyphenate that 
Compound that 
 
Set Font Times 
Set Font Size 12 Points 
Format That Courier 18 Points Bold 
Format That Arial 12 Points 
 

Initial Caps (Title Case) 
Cap <word>   
Caps on/Caps off/Cap that/Format that Caps 
 
Uppercase 
All Caps <word> 
All Caps on/All Caps off/All caps that/Format that 
Uppercase 
 
Lowercase 
No Caps <word> 
No Caps on/No Caps off/No Caps that/Format that 
Lowercase 
 
No spaces 
No Space <word> 
No Space on/No Space off 
 
unbreakable space or no break space  
or nonbreakable space 
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C. Spelling:  There are several ways to spell a name or word: 

Dictate:  "spell <letters>" 

This will spell the letters but will not add the word to your vocabulary. Good for 
dictating non-words like product numbers or license plates. 

Dictate: "<pause>spell<pause>" 

This brings up the spelling window and lets you spell the word by voice.  When 
you are done, say "click ok", and the proper name will be added to the vocabulary 

Dictate: "<pause> <word or proper name> <pause> spell that" 

Dictate: "<pause> <work or proper name> <pause> correct that" 

This will bring up the spelling window and lets you spell the word by voice.  When 
you are done, say "click ok", and the proper name will be added to the vocabulary. 

Dictate: "Spell mode on" <letters> "Spell mode off" 

This will let you spell the word, but it will not add it to the vocabulary. 

International Alphabet 

alpha 
bravo 
Charlie 
delta 
echo 
foxtrot 
golf 
hotel 
India 
 

Juliet 
kilo 
lima 
Mike 
November 
Oscar 
papa 
Quebec 
Romeo 
 

sierra 
tango 
uniform 
Victor 
whiskey 
xray 
yankee 
zulu 
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D. Numbers:   

Numbers Mode on/Numbers Mode off 

Start Numbers Mode/Stop Numbers Mode 

Numeral <numbers> 

Examples: 
4  "four" or "numeral four"  
23  "twenty three"  
179  "one hundred seventy nine," "one 

hundred and seventy nine," or 
"one seventy nine"  

5423 "five thousand four hundred 
twenty three"  

5,423  "five comma thousand four twenty 
three"  

142,015  "one hundred forty two thousand 
and fifteen"  

127,400,042  "one hundred twenty seven 
million four-hundred thousand 
forty-two"  

127 billion  "one hundred twenty seven 
billion"  

0.03  "zero point zero three" or "oh 
point oh three"  

2 ¾  "two and three fourths"  
11/32  "eleven over thirty two"  

555-5200  "nine six five fifty two hundred"  
617-555-5200  "six one seven nine six five five two 

hundred"  
$45  "forty five dollars"  
$99.50  "ninety nine dollars and fifty 

cents"  
€1.7 billion  "One point seven billion Euros"  
8:30 p.m.  "eight thirty pm"  
200 kg  "200 kilograms"  
50 meters  "50 meters"  
May 15, 2003  "May fifteen comma two thousand 

three" (note: saying "comma" is 
optional)  

MMIV  "Roman numeral two thousand 
four"  

iii (lowercase Roman)  "Roman numeral three" "No Caps 
That"  

Boston, MA 02460  "Boston Massachusetts 02460"  
Oakland, CA 99077  "Oakland California 99077"  

 

Format that Number - Changes "twenty-fifth" to "25th" or "5 million" to 
"5,000,000 

Format that Spelled Out - Changes "5 million" to "five million" or "25" to "twenty-
five" 

E. Hotkeys: 

1. + on numeric keypad  Turn microphone on/off 

2. - on numeric keypad Opens correction menu 

3. CRTL key Force command mode 

4. SHIFT key Force dictation mode 

F. Dictation Box: 

1. Show Dictation Box 

2. Tools->Dictation Box 
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3. CTRL+SHIFT+D 

G. General Commands: 

1. Scratch that:  Deletes last phrase 

2. Select that or Select <word or phrase>:  Selects word or phrase 

3. Select Again:  Selects next instance of previously selected word or phrase 

4. Undo that or Undo Last Action :  Undo (sends CTRL+z to program) 

5. Choose <number>:  Select item in correction dialog box 

6. Click OK:  Clicks OK in a dialog box 

7. Move Left/Right/Forward/Back <1-20> <Words or Characters> 

8. Move Up/Down <1-20> <Lines or Paragraphs> 

9. Insert Before <text> 

10. Insert After <text> 

11. Go to/Move To Top/Bottom 

Top of Document/Bottom of Document 

Start of Document/End of Document 

Beginning of Line 

Start of Line/End of Line 

12. Press/Type <key>:  Press a key on the keyboard 

13. Start Normal Mode/Normal Mode On 

14. Start Dictation Mode/Dictation Mode On/Dictation Mode Off 

15. Start Command Mode/Command Mode On/Command Mode Off 

16. Start Spell Mode/Spell Mode On/Spell Mode Off 

17. Start Numbers Mode/Numbers Mode On/Numbers Mode Off 
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H. Microsoft Word Commands: 

Creating, opening, and closing a document 

Create a new document "Create New File" or "Open New File"  

Open an existing document 

"Open File"  
"<file name> dot <file extension>", for example, "My 
Document Dot Doc"  
"Press Enter"  

Close a document "Close File" or "Close Document" 

Saving a Document 

Save a document as a .doc file 

"Save Changes"  
Dictate a file name (only needed if this is the first time the file 
has been saved)  
"Click Save"  

Save a document with a new file 
name and file type 

"Save Document As"  
Dictate a file name  
"File Type <file type from list>", for example, "RTF"  
"Click Save"  

Save a document in HTML 
format 

"Save Document as Web Page"  
"Click Save"  
If a dialog box appears warning of a text format loss, "Click 
Continue"  

Save as document template "Save the Page Settings as Default 

Page Setup 

Set the page orientation 
"Set Page Orientation to Landscape"  
"Set Page Orientation to Portrait"  

Set the size 

"Set Page Width to <number> Inches/Centimeters", for 
example, "Set Page Width to Eight Inches"  
"Set Page Height to <number> Inches/Centimeters", for 
example, "Set Page Height to Eleven Inches"  

 

"Set Left/Right Margin to <number> Inches/Centimeters", for 
example, "Set Left Margin to Two Inches"  
"Set Top/Bottom Margin to <number> Inches/Centimeters", 
for example, "Set Bottom Margin to Five Centimeters"  

Number pages 
"Add Page Numbers"  
"Create Page Numbers"  

Create headers and footers 
"Go To Header/Footer"  
Dictate text to appear in the header or footer  
"Close Header/Footer"  

Add footnotes 

Move the insertion point to the location where you want the 
footnote  
"Insert Footnote Here"  
Dictate the footnote text  
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"Close Footnotes"  

Viewing the Document 

View the document 

"Preview the File"  
"View Master Document"  
"Preview Document as HTML"  
"Close the Preview"  
"Set View to Normal"  

Enlarge or reduce the document 
view 

"Zoom to <number> Percent", for example, "Zoom to Fifty 
Percent"  
"Set Zoom to Page Width/Height"  

Change the display 
"Show/Hide Headers and Footers"  
"Show/Hide the Ruler"  
"Show/Hide Paragraph Marks"  

Printing 

Print a range of pages 
"Print Pages <number> to <number>", for example, "Print 
Pages One to Three" 

Print part of a page 
"Select <First/Last> paragraph", for example, "Select the Last 
Paragraph"  
"Print the Paragraph" or "Print the Selection"  

Check Spelling and Grammar 

Check spelling 

"Check Spelling"  
"Click Change" or "Click Ignore" depending on how you want 
to respond  
"Click Close" when the spelling check is complete  

Check grammar 

"Check Grammar"  
"Click Change" or "Click Ignore" depending on how you want 
to respond.  
"Click Close" when the grammar check is complete.  

Searching and Replacing 

Search for text 

"Find a Word"  
Dictate the word or phrase you want to find in the Find dialog 
box  
"Click Find"  

Replace all instances of a word 
or phrase 

"Find Text"  
Dictate the word or phrase you want to find  
"Click Replace"  
"Click Replace With" (to move the insertion point to the 
Replace With field)  
Dictate the replacement word or phrase  
"Click Replace All"  
"Click Close" (to close the Find and Replace dialog box)  

Inserting Document Segments 
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Add a page 

"Go To <location>" (to move the insertion point to where you 
want to insert the new page). For example, "Go To Bottom" to 
add a new page at the end of the current document.  
"Add a New Page"  

Create a line break 

"Go To <location>" (to move the insertion point to the location 
where you want the text to break). For example, "Go To third 
line" to add a line break at the end of the third line in the 
current paragraph.  
"Insert Hard Line Break"  

Create a page break 

"Go To <location>" (to move the insertion point to the location 
where you want the text to break). For example, "Go To third 
paragraph" to add a page break at the end of the third 
paragraph in the current page.  
"Insert Page Break"  

Add the date and time 
"Go To <location>" (to move the insertion point to the location 
where you want to place the information)  
"Insert Date and Time" or "Insert Date" or "Insert Time"  

Moving Text 

Move a word 

Move the insertion point to the word you want to move  
"Select Word"  
"Move Word Forward/Back <number> Words/Lines", for 
example, "Move Word Forward Five Lines"  

Move a line 

Move the insertion point to the line you want to move  
"Select Line"  
"Move Line Forward/Back <number> Lines" or "Move Line to 
the Beginning/End of Paragraph/Document", for example, 
"Move Line to the End of Paragraph"  

Move a paragraph 

Move the insertion point to the paragraph you want to move  
"Select Paragraph"  
"Move Paragraph Forward/Backward <number> paragraphs" 
or "Move Paragraph to the Beginning/End of Document", for 
example, "Move Paragraph to the Beginning of Document" or 
"Move Paragraph Backward Six Paragraphs"  

Switching Between Open Documents 

Switch between open 
documents 

1. "Say "List windows for Microsoft Word" 
Do one of the following: 
Say "Choose n", where n is the number of the window you 
want to switch to. For example, say "Choose 2" 
OR 
Choose the number of the program from the list and click OK 

Changing Text Properties 
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Change text properties "Set Word/Line/Paragraph to Strikeout"  
"Underline this Word/Line/Paragraph"  
"Italicize Next <number> Words"  
"Bold This Page"  

Changing Font and Point Sizes 

Change font name and point 
size 

"Set the Font to Twenty Four Points Times in the 
Word/Line/Paragraph"  
"Increase/Decrease the Font Size to Eighteen Points in the 
Word/Line/Paragraph"  
"Set the Font to Courier in the 
Selection/Word/Line/Paragraph/Page/Section/Document"  
"Decrease Selection by Two Points"  

Changing Font Properties 

Change font properties "Turn on Bold and Italics"  
"Format That Regular"  
"Italicize the Next <number> Words/Lines/Paragraphs," for 
example, "Italicize the Next Five Lines"  
"Unitalicize That"  

Changing Capitalization 

Change case "Capitalize the First/Last/Next <number> 
Words/Lines/Paragraphs," for example, "Capitalize the Next 
Five Words"  
"Lowercase the First/Last/Next <number> 
Words/Lines/Paragraphs," for example, "Lowercase the Last 
Ten Words"  
"Toggle the Case of the Word"  

Changing Font Color 

Change font color "Set Font Color to Green in This Line"  
"Set the Color to Red in the Selection"  
"Set It to Dark Blue" (refers to current word or selection)  

Changing Line Spacing 

Change line and paragraph 
spacing 

"Double Space the Paragraph"  
"Single Space Selection"  
"Increase Paragraph Spacing to <number> 
Inches/Centimeters"  

Changing Text Justification 

Change text justification "Justify the Document"  
"Right Justify It" or "Right Align Selection"  
"Left Align This Line/Paragraph"  
"Set Initial Indent to <number> Inches/Centimeters"  
"Set Hanging Indent to <number> Inches/Centimeters on This 
Page"  
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Creating Bulleted or Numbered Lists 

Create and delete bullet points 
or list numbers 

"Set the paragraph to Bulleted/Numbered"  
"Delete Bullets From the Document"  
"Unnumber the Selection"  

Working With Outlines 

Create an outline "Set View to Outline"  

Set, expand, or collapse heading "Make It Heading"  
"Set Style Heading Three"  
"Expand Previous Heading <number> Levels"  
"Collapse the Next Heading"  
"Promote the Next Paragraph into Heading"  
"Demote the Paragraph"  
"Autoformat This Paragraph"  

I. Microsoft Outlook Commands (Dragon Professional or Legal Only): 

Start Microsoft Outlook  
Go To Inbox  
Check Mail  
Open Mail Message:  Read first unread message  
View Next Unread Message:  Open the next message  
Reply to Message  
Reply to This Message 
Reply to All 
Send Message 
Create E-mail  
Subject  
Text Field or Move to Text  
Send Message 
Mark the Message as Unread  
Copy this Message to a Folder  
Flag Message for Followup  
Close All Items 
View Calendar 

Compose New All Day Event  
Set Start Time to <day> 
Press Tab Key   
Move to the text box  
Invite People to This Event  
Send this appointment 
Make This an Online Event  
Set Reminder On  
Show Time as Tentative  
Decline This Event  
Mark This Appointment as Unread  
Forward This Appointment  
View Address Book 
Create New Contact  
Press Alt Yankee :  Open the Company field  
Click Business:  Open the telephone number field  
Save and Close This 
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How To Protect Yourself While Trading Documents Electronically 

How To Protect Yourself and Preserve Confidentiality When 
Negotiating Instruments 

 
I. ISSUES TO ADDRESS: Lawyers who need to exchange documents with clients and other 

attorneys run into a host of document-related issues and can expose themselves to a lot 
of risk.  This seminar is designed to let you know what tools exist to help you deal with 
the issues and risk factors.  From a word processing perspective, we’ll focus on the tools 
available in Word 2007/2010.  The following are a few scenarios that we’ll cover directly: 

A. You Have Received a Document To Review:  Now you want to indicate your 
proposed changes and add comments: 

1. You Have Received A Microsoft Word Document: What tools are available 
to you for this task? 

2. You Have Received A PDF Document: What tools are available to you for 
this task? 

3. You Have Received A Paper Document via US Mail or Fax: What tools are 
available to you for this task? 

B. You Need Feedback or Proposed Changes from Others On a Document: You have 
a document and need to send it to someone (or multiple parties) for comment or 
proposed edits.  The recipients could be anyone from a client, someone within 
your own office or opposing counsel.  Questions lawyers often have about this 
process: 

1. Ensuring All Proposed Changes Are Caught: 

• The document needs to be sent to opposing counsel.  If you don’t trust 
opposing counsel to clearly identify his/her proposed changes, what 
can you do to protect yourself and ensure that you find every proposed 
change in the document I receive back? 

• What if opposing counsel just edits the Word document and sends it 
back to you without any indication of the changes made?  How will you 
find out what modifications were made to the document? 

• What if opposing counsel edits the Word document and sends you 
back a PDF rather than the original Word document?  How can you 
determine what changes were made in the PDF? 
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2. Avoid the Metadata Problem: You have heard about "metadata." What 
can you do to avoid revealing any personal or hidden information that 
might be buried in the document? 

3. Consolidate Proposed Changes From Many People Into a Single 
Document: You are going to route the document to many recipients and 
need a way to consolidate all of the recipient comments back into a single 
document so you can easily see all proposed changes.  How can this be 
done? 

4. Avoid Version Confusion: 

• You want to obtain feedback from others but don’t want to modify the 
original document you’re sending out.  What can you do to make sure 
that the original isn’t accidentally over-written with the modified one 
you receive back? 

• You are creating more and more versions of a document as it goes 
through the negotiation/revision process.  How do you keep track of 
all of the versions and not make a mistake regarding which version is 
current? 

5. Making It Easy for the Non-Technical Person You're Working With:  You 
don’t think the recipient knows how to use Word’s "track changes" 
feature.  How can you make it as easy as possible for the recipients to enter 
proposed changes and get them back to you? 

6. Protecting Client Confidentiality: The document is extremely confidential.  
What can you do to ensure that only the intended recipient receives the 
document if you’re sending it via email? 

C. You Need Real Time Collaboration: You’re drafting a document and would like 
someone’s input on it immediately.  How can that be accomplished quickly, even 
if the person whose input you seek is not in your office? 

D. Document Is Final and You Need To Prevent Future Editing: If you have to email 
a document out for signature, how do you ensure that the recipient(s) cannot 
make further changes to it? 

II. RELEVANT ETHICS RULES:  There are many relevant rules, but I want to focus on our duty 
to maintain confidentiality. 

A. IN RULE 1.1 - Competence:  A lawyer shall provide competent representation to a 
client. Competent representation requires the legal knowledge, skill, 
thoroughness and preparation reasonably necessary for the representation. 
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B. ABA Rule 1.1 Comment 6:  

[6]     To maintain the requisite knowledge and skill, a lawyer should keep 
abreast of changes in the law and its practice, including the benefits and risks 
associated with the technology relevant to the lawyer’s practice, engage in 
continuing study and education and comply with all continuing legal education 
requirements to which the lawyer is subject. 

C. IN RULE 1.6 - Confidentiality of Information:   

(a)     A lawyer shall not reveal information relating to representation of a client 
unless the client gives informed consent, the disclosure is impliedly authorized in 
order to carry out the representation or the disclosure is permitted by paragraph 
(b). 

… 

D. ABA Model Rule 1.6 - Confidentiality of Information: 

(a)  A lawyer shall not reveal information relating to the representation of a 
client unless the client gives informed consent, the disclosure is impliedly 
authorized in order to carry out the representation or the disclosure is permitted 
by paragraph (b). 

(c)   A lawyer shall make reasonable efforts to prevent the inadvertent or 
unauthorized disclosure of, or unauthorized access to, information relating to 
the representation of a client. 

E. IN RULE 1.6 Comment 16 - Acting to Preserve Confidentiality: 

[16]  A lawyer must act competently to safeguard information relating to the 
representation of a client against inadvertent or unauthorized disclosure by the 
lawyer or other persons who are participating in the representation of the client 
or who are subject to the lawyer's supervision. 

F. ABA Rule 1.6 Comment 18 - Acting Competently to Preserve Confidentiality: 

[18]   Paragraph (c) requires a lawyer to act competently to safeguard information 
relating to the representation of a client against unauthorized access by third 
parties and against inadvertent or unauthorized disclosure by the lawyer or other 
persons who are participating in the representation of the client or who are 
subject to the lawyer’s supervision. See Rules 1.1, 5.1 and 5.3.  The unauthorized 
access to, or the inadvertent or unauthorized disclosure of, information relating 
to the representation of a client does not constitute a violation of paragraph (c) 
if the lawyer has made reasonable efforts to prevent the access or disclosure.  
Factors to be considered in determining the reasonableness of the lawyer’s efforts 
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include, but are not limited to, the sensitivity of the information, the likelihood 
of disclosure if additional safeguards are not employed, the cost of employing 
additional safeguards, the difficulty of implementing the safeguards, and the 
extent to which the safeguards adversely affect the lawyer’s ability to represent 
clients (e.g., by making a device or important piece of software excessively difficult 
to use). A client may require the lawyer to implement special security measures 
not required by this Rule or may give informed consent to forgo security measures 
that would otherwise be required by this Rule.   

G. IN Rule 1.6 Comment 17:    

[17]  When transmitting a communication that includes information relating to 
the representation of a client, the lawyer must take reasonable precautions to 
prevent the information from coming into the hands of unintended recipients. 
This duty, however, does not require that the lawyer use special security 
measures if the method of communication affords a reasonable expectation of 
privacy. Special circumstances, however, may warrant special precautions. 
Factors to be considered in determining the reasonableness of the lawyer's 
expectation of confidentiality include the sensitivity of the information and the 
extent to which the privacy of the communication is protected by law or by a 
confidentiality agreement. A client may require the lawyer to implement special 
security measures not required by this Rule or may give informed consent to the 
use of a means of communication that would otherwise be prohibited by this Rule. 

III. INDICATING YOUR PROPOSED CHANGES TO A DOCUMENT: 

A. You Received a Microsoft Word Document: 

1. Tracking Changes as you Edit:  Use this if someone sends you a first draft 
and you would like to courteously mark your proposed changes to the 
document.  To have Word track your proposed changes as you make them, 
follow these steps: 

a. Open a document. 

b. Click Review ribbon  Tracking group  top of the Track Changes 
button. 

c. As long as Track Changes is on, all insertions, deletions and 
alterations to the document will be tracked automatically. 

2. Fix Default Settings with Track Changes: Here are some recommended 
changes to the way Word handles this feature. 

a. Fix Balloons Problem with Word 2007/2010: The best tool for 
editing a document is Word’s "Track Changes" feature.  However, 
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by default, Word shows deleted text in balloons in the right margin 
of the document (rather than struck through in the body of the 
document).  Most people find this annoying.  If you would like to 
see deleted text red-lined in the body of the document, click the 
Review Ribbon  click the bottom half of the Track Changes button 
 Change Tracking Options  choose "Only for 
comments/formatting" for the Use Balloons option. 

 

b. Fix Balloons with Word 2013/16/19/365:  Click the Review ribbon 
 Show Markup button  Balloons  Show only comments and 
formatting in balloons. 

 

3. Emphasizing Text in a Document: If you want to draw someone's attention 
to text in a Word document, there are several ways to do it.  Some 
methods of emphasis only appear in the electronic document (i.e., when 
you're viewing it in Word) and some appear both electronically and when 
it is printed. 

a. Highlighting Text:  You can highlight text with the on-screen 
highlighter button, which is located in the Font group of the Home 
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ribbon.  Be aware that the highlights will print (in shades of gray if 
using a monochrome printer).  In order to apply highlighting, select 
the text and then click the highlighter button on the Home ribbon.   

You can change colors by clicking the drop down arrow to the right 
of the button: 

 

If you want to remove the highlighting you or someone else has 
applied, select the highlighted text, click the down arrow adjacent 
to the highlighter button, as show above, and choose Stop 
Highlighting. 

b. Changing the Color of Text:  You can change the color of the text 

itself by either clicking on Font Color button  on the Home 
ribbon, or opening the Font dialog and changing Font color. 

 



Affinity Consulting Group Page 7 

How To Protect Yourself While Trading Documents Electronically 

 

4. Adding Comments: Comments are another useful way to annotate a 
document you intend to send to someone else for review.  To insert a 
written comment, follow these steps: 

a. Select the text you want to comment on. 

b. Go to the Review ribbon, then click New Comment. 

c. Type the comment text in the comment balloon in the right margin.  
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d. You'll notice that the initials of the person making the comment are 
automatically inserted and that they're numbered.  If others add 
comments, Word will automatically change the color of their 
comments so that each person's comments are easily discernible. 

e. In Word 2013/16/19/365, the comments look a bit different.  It 
inserts the entire name of the person making the comment and 
tells you how long ago the comment was inserted.  Furthermore, 
you can reply to a specific comment by clicking the small icon in the 
right-side of the comment. 

 

B. You’ve Received a PDF Document: If you have Acrobat Standard or Pro, then you 
have plenty of annotation options at your disposal.  In Acrobat versions 8 and 9, 
click the View menu  Toolbars  check Comment & Markup.  In Acrobat X and 
XI, these tools are available under the Comment button on the right side of the 
screen (see the Annotations subheading in the pane that opens when you client 
the Comment button).  This will open a toolbar which gives you all sorts of 
annotation options.  Here are some of the tools you’ll have: 

1. Adding a Sticky Note: Just follow these steps: 

a. Open the PDF you want to insert a comment into. 

b. Click the Sticky Note button on the Commenting toolbar (Acrobat 
8 or 9) – or - under Comments  Annotations (Acrobat X & XI) – or 
– under Tools  Comment (Acrobat DC). 

c. Click in the PDF document where you want to insert your comment 
and a comment dialog will appear.   

d. Type your comment, then hit the close X button in the top right 
hand corner to close it. 
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e. After you close the comment, a  icon is left where your 
comment resides.  Just click on it and your comment will re-appear.  
The comment also maintains your name and the date and time you 
entered it.  You can hold down on your mouse button while 
hovering over it and move its location. 

2. Add Text Edits to a PDF: 

a. First, open the PDF you want to annotate, click the  button and 
then select the text in the PDF you want to annotate. 

b. In Acrobat 8 or 9, click the Text Edits button and choose an option.  
As you can see, there are plenty of choices! 

 

c. In Acrobat X, you'll see separate buttons for each option under 
Comment  Annotations: 



Affinity Consulting Group Page 10 

How To Protect Yourself While Trading Documents Electronically 

 

d. In Acrobat XI, you'll see separate buttons for each option under 
Comment  Annotations (there are 2 more buttons than in X): 

 

e. In Acrobat DC, you'll see a whole row separate buttons for each 
option under Tools  Comment: 

 

3. Other Annotations in Acrobat 8 or 9: The following buttons are also 
located on the Comment and Markup Toolbar. 

 

 

1. Stamps 
2. Highlighting 
3. Callouts 
4. Text boxes 
5. Clouds (squiggly boxes) 
6. Arrows 
7. Lines 

1 2 3 4 5 6 7 8 9 10 
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8. Boxes 
9. Circles 
10. Pencil (draw free-hand) 

4. Other Annotations in Acrobat X & XI: The following buttons are located 
under Comment  Drawing Markups. 

 

5. Other Annotations in Acrobat DC: The following buttons are located under 
Tools  Comment. 
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6. Deciding What You Want To See in Acrobat 8 or 9: By clicking the Show 
button on the Comment and Markup toolbar, you can filter or display the 
annotations by almost any criteria you’d like: 

 

7. Deciding What You Want To See in Acrobat X, XI & DC: Under Comment 
 Comments List you have options for filtering the visible comments, 
printing, etc.  See the screen-shots below for the options under each 
button.   
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8. Typewriter Tool: In Acrobat 8 or 9, open the Typewriter toolbar and you’ll 
have a tool that will allow you to type on a PDF anywhere you’d like.  Just 
click this button:  

 

In Acrobat X, click Tools  Content  Add or Edit Text Box for the same 
feature. 

 

In Acrobat XI, click Tools  Content Editing  Add Text for the same 
feature.  In Acrobat DC, click Tools  Edit PDF  Add Text button. 
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C. You’ve Received a Paper Document: If you’re more adept at working with a 
keyboard, you’ll probably be annoyed with hard copies of documents you’re 
supposed to edit.  Here are your options: 

1. Call Sender And Ask For Electronic Version: This should always be your 
first response.  The sender may have just thought you would prefer a paper 
copy.  If you do this a lot, then this is a good reason to have both Word 
Perfect and Word on your computer so you can edit either type of 
document.  

2. Convert Hard Copy Document To Electronic Document: If the sender 
won’t give you an electronic version of the document, you need to go to 
Plan B.  Using a scanner and the right software, you can convert paper 
documents into electronic ones.  The primary benefits of this are a) the 
elimination of re-typing, b) the ability to avoid using a typewriter, and c) 
increased accuracy.   

a. The OCR Process: When a scanner captures an image of a 
document, it is the equivalent of a photograph of the document.  
As such, the image can be viewed, printed and stored, but it does 
not contain text (in its native form) that you can edit.  Before you 
can edit the scanned document in Word or WordPerfect, it must be 
converted into text that Word and WordPerfect can use (through a 
process called Optical Character Recognition "OCR").  OCR is simply 
the recognition of printed or written text characters by a computer.   

b. The Problem Most People Experience: The problem that most 
people experience with this process is a resultant document that 
contains so many typographical errors that they could have retyped 
the whole thing themselves by the time they fix all of the mistakes.  
It certainly doesn't have to be like that and there are several factors 
that can be the difference between success and failure. 

c. Factors Affecting the Result: 

• Software: Many people have purchased scanners and tried to 
convert images into text using the OCR software that came with 
their scanner.  Unfortunately, the OCR software included with 
most scanners is a "light" version which has been stripped of 
most of its power and features.  In other cases, the software 
isn't a light version, but it performs poorly even at full strength.    

• Quality of the Original: Another important issue affecting your 
OCR success will be the quality of the document you're 
scanning.  If the original is marked up, has smudges, lines or 
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other clarity problems, you're going to have problems with the 
OCR process.  The cleaner the original, the better luck you're 
going to have with the OCR. 

• Quality of the Scanned Image: If you've scanned something 
that results in an image that is fuzzy, too dark, too light, or too 
pixilated, then your OCR software will have a hard time 
performing properly.  Ultimately, you need the resulting 
scanned document to be fairly clean black and white. 

• Scanner: In most cases, the scanner is blamed when this 
process doesn't go as planned, but in reality it has little to do 
with it.  As long as a document is scanned at 200 dots per inch 
resolution ("dpi") or higher, and black and white (as opposed to 
color or gray-scale), you should have good results.  For 
purposes of OCR, I normally scan at 300 dpi but not higher than 
that. 

d. OCR Software Recommendations: There are several options out 
there for OCR software.  In order to obtain the best results, you'll 
need to read the manual and experiment a bit (which of course no 
one likes to do).  Anyway, here are some recommendations: 

i. OmniPage v18: By Nuance - $49 at www.amazon.com - see 
http://tinyurl.com/jsojnoa. 

ii. OmniPage Ultimate: By Nuance - Mnfg. part #E709A-G00-
19.0 - $468 at www.amazon.com. 

iii. ABBYY FineReader v12 Professional Edition: By Abbyy 
(mnfg. part #FRPFW12B) - $135 from www.amazon.com.  

e. Scanner Recommendations: OmniPage will work with almost any 
TWAIN compliant scanner directly.  However, you can also simply 
open any type of image in OmniPage if it were created using some 
other program (PDF, TIF, JPG, etc.)   

IV. ASCERTAINING CHANGES BETWEEN TWO VERSIONS OF A DOCUMENT: The problems 
lawyers typically face related to this issue are explained in paragraph I.B.1. above.  If 
you’re sending a document to someone else for comment, what can you do to protect 
yourself and make sure that you’re aware of all changes the recipient will make to the 
document you’re sending them?  Here are your options: 

A. Major Drawbacks to Sending Paper Documents: Of course, you could fax or snail-
mail documents to opposing counsel.  If they mark it up with a pen and send it 

http://tinyurl.com/jsojnoa
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back to you, you’ll of course see the proposed changes easily.  However, the 
problems with this approach are: 

1. The physical trading of documents is very slow and can make the 
negotiation process take exponentially longer than if it were handled 
electronically. 

2. You’ll have to manually recapitulate the proposed changes into your 
electronic document which takes time and it’s difficult to identify which of 
the changes you accept and which you reject without long phone 
conferences pouring over the document with opposing counsel. 

3. It can be very difficult to track changes made by multiple parties when 
they’re all writing on a document.  It can easily become unreadable and 
it’s often impossible to determine from looking at the document who 
made what proposed changes.  If done electronically, it’s fairly easy to 
determine who made what proposed change and when. 

4. Sometimes opposing counsel will retype the document or scan and OCR it 
so they can comment and enter proposed changes electronically to the 
document you sent them in paper form.  If they then print that document 
and mail/fax it back to you, then you’ll have to visually compare the hard 
copy to what you sent them in the first place and this can be a nightmare 
and is almost impossible to do accurately.   

B. Send an MS Word File - Ask Them To Use Track Changes But Verify: Of course, all 
versions of MS Word have a wonderful feature called Track Changes which will 
allow all proposed changes to be identified in the document being reviewed.  The 
problem is that by default, one can turn it on and turn it off, thereby tracking some 
changes and not tracking others.  Therefore, you cannot and should not ever trust 
that all changes entered are visible on the face of the document.  Remember the 
mantra, trust but verify.  Just follow these steps: 

1. When you receive the email with the attached document, save it as a new 
version (i.e., Jenco Lease Agreement v2.docx). 

2. Open the new version of the document and click on the Review ribbon in 
Word.  Click the bottom of the Accept button and choose Accept All 
Changes in Document as shown below. 



Affinity Consulting Group Page 17 

How To Protect Yourself While Trading Documents Electronically 

 

3. Now you have a "clean" document containing all proposed changes by the 
other party.  Now we’ll compare it against the first version. 

4. Click the Compare button on the Review ribbon and compare the original 
document against the version 2 you just created.  See the screen shot 
below for details. 

 

5. The result of this process is a NEW document showing you the differences 
between what you send them in the first place and what they sent back.  
Save this document as version 3 (Jenco Lease Agreement v3.docx).   

6. Now you can use the Previous or Next buttons on the Review ribbon to 
locate each change, and Accept, Reject or Comment (there are buttons for 
each of these tasks on the same ribbon) on each one of them.  After you’ve 
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accepted, rejected and commented, save this as version 4 of the document 
and you can send that back to opposing counsel. 

C. Send an MS Word File - Turn on Track Changes Before You Send and Lock It On: 
Rather than trusting the receiving party to consistently use Word’s track changes 
feature for all proposed changes, you can turn it on and prevent the recipient from 
turning it off.  Just follow these steps: 

1. Open up version 1 of the document you’re sending out, click on the Review 
ribbon in Word, then click the Track Changes button.  This simply turns on 
the feature. 

2. On the same ribbon (Review), you’ll see a button called Protect Document.  
Click that button, check "Allow only this type of editing in the document" 
and choose "Tracked changes" from the drop down list below that.   

3. Now click the button on the right side of the screen that says "Yes, Start 
Enforcing Protection."  It will now prompt you for a password.  Enter a 
strong password (mix of numbers, letters and at least one symbol) and 
write it down so you don’t forget it.  Now the recipient will not be able to 
turn off Track Changes unless they can break your password. 
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4. Save the document, but do not email it yet.  The recipient cannot edit the 
document without those changes being shown, but they could copy and 
paste the text from the document you’ve drafted into a new document, 
and only track certain changes.  Therefore, you’ll need some way to verify 
that the document you receive back is the one you emailed in the first 
place.  An easy way to have reasonable assurances that the document you 
receive is the one you sent is to look up the date and time the document 
was created.  To do this in Word 2007, click the Office Button  Prepare 
 Properties.  Under the "Document Properties" drop down in the top, 
left corner of the screen, click the down arrow and choose Advanced 
Properties.  On that page, you’ll see the Created date and time.  Write that 
down as well.  In Word 2010/13/16, click the File menu  Properties 
button on the far right side of the screen  Advanced Properties. 

5. Email the document to the other party with an explanation that you’ve 
turned on Track Changes and that every change they enter will be 
automatically tracked. 

6. When you receive the document back, save it as version 2, unprotect the 
document (Review ribbon, click the Protect Document button, click the 
Stop Protection button at the bottom and enter your password).  Now look 
at the properties again and see if the create date and time is the same.  Of 
course, this could be replicated by a skilled and deceitful receiving party, 
but it’s not likely.  To make absolutely sure that you’re seeing all proposed 
changes in the document you received back, you could also run through 
the process outlined previously of accepting all changes and electronically 
comparing the new version with the one you sent in the first place. 

D. Send an MS Word File - But Receive A Word Document Back With No Changes 
Indicated: In other words, the recipient did not even attempt to use the Track 
Changes feature.  Instead, they simply entered their changes into the document 
directly and sent you back a version they find acceptable.  In order to electronically 
compare what you sent them against the original, see paragraph IV.B. above and 
follow the steps a through f, but you can skip steps b and c since they assume that 
the track changes feature was used. 

E. Send an MS Word File - But Receive A PDF File Back With No Changes Indicated: 
This is a problem if all you have is Microsoft Word because Word cannot compare 
a Word document to a PDF document.  However, there are other applications 
which can do this.  For example, the following two programs can compare Word 
to Word, PDF to PDF or Word to PDF. 

1. Workshare Compare - https://www.workshare.com/product/compare 

2. DocsCorp CompareDocs – see http://tinyurl.com/j24a486 

https://www.workshare.com/product/compare
http://tinyurl.com/j24a486
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3. Another option is to convert your original Word document to a PDF and 
then use Adobe Acrobat Professional to conduct the comparison between 
the two PDFs.  In Acrobat 8 & 9, click Advanced menu  Compare 
Documents.  In Acrobat X, XI & DC, click View menu  Compare 
Documents. 

F. Send a PDF File: Of course, if you want to make sure that the recipient cannot edit 
your document (but only suggest changes), sending a PDF is a good way to do that.  
If the recipient has Adobe Acrobat Standard or Professional version 7, 8, 9 or X, 
they’ll be able to add annotations to your PDF using the Comment & Markup 
features (or toolbar) within Acrobat.  However, your recipient may only have the 
free Adobe Reader which does not provide the ability to annotate a PDF.  
However, you can give recipients the ability to annotate your PDF, regardless of 
whether they have Acrobat or Reader by following these steps (I’m going to use 
Adobe Acrobat 9 Professional to outline these steps): 

• Create a PDF from the original Word document using Acrobat.  There are many 
ways to do this, the easiest of which is to simply use the Create PDF button in 
the Acrobat ribbon that Acrobat installs in Word upon installation. 

• Once the PDF is open in Acrobat Pro, click the Review & Comment button at 
the top of the screen, then choose Attach for Email Review.  On the next 
screen, Acrobat will assume that the document you want to send is the one 
you’ve opened (which is correct).  Click the Next button at the bottom. 

• On the next screen, type the recipient’s email address in the Invite Reviewers 
window and click Next. 

• On the next screen, you’ll see a preview of the email invitation Acrobat will 
send to the recipient and it contains complete instructions.  Just click Send 
Invitation and the PDF will be sent to the recipient along with a full explanation 
of what the user needs to do. 

• Here’s the great part:  When the recipient opens the attached PDF, they’ll be 
presented with the Comment & Markup toolbar in Acrobat, even if they have 
the free Reader program.  In other words, the ability to annotate the PDF is 
built into the PDF and recipients will have the ability to annotate it, even if the 
application they’re using (like Reader) doesn’t have that ability natively.  
Furthermore, they’ll have an additional button that says Send Comments and 
all they have to do is click it in order to send the annotated PDF back to you.  
These features are a result of the "Enable Usage Rights in Adobe Reader" 
function that only exists in the Professional versions of Adobe Acrobat. 
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• NOTE:  To initiate the foregoing process using Acrobat X & XI, click the 
Comment button  Send for Email Review (under the Review subheading).  In 
Acrobat DC, click Tools  Send for Comments. 

G. Alternative Programs for Comparing Documents:  The following are alternatives 
to Microsoft Word for comparing Word documents to produce a redline. 

1. Workshare Compare - https://www.workshare.com/product/compare 

2. DocsCorp CompareDocs – see http://tinyurl.com/j24a486 

3. Diff Doc by Softinterface - see http://tinyurl.com/mr6ff 

4. GroupDocs - see http://www.groupdocs.com/apps/comparison 

V. AVOIDING METADATA:  

A. What Is Metadata? When you create, open, edit or save word processor 
documents, the electronic files may contain information you don't want to share 
with opposing counsel. This information is known as "metadata."  Metadata is 
used for a variety of legitimate reasons to enhance the editing, viewing, filing, and 
retrieval of word processor documents.  Some metadata is readily accessible 
through your word processor, but other metadata is only accessible through 
extraordinary means, such as opening a document in a low-level binary file editor. 
Here are some examples of metadata that may be stored in your documents:  

• Your name  

• Your initials  

• Your company or organization name  

• The name of your computer  

• The name of the network server or hard disk where you saved the document  

• Other file properties and summary information  

• Non-visible portions of embedded OLE objects  

• The names of previous document authors  

• Document revisions (number of revisions and duration of revisions) 

• Document versions  

https://www.workshare.com/product/compare
http://tinyurl.com/j24a486
http://tinyurl.com/mr6ff
http://www.groupdocs.com/apps/comparison
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• Template information  

• Hidden text  

• Comments   

B. Types of Files Which Contain Metadata: In short, just about any type of file you 
can think of from PDFs to Word to WordPerfect.  Since this seminar is focused on 
Word and Acrobat, I’ll discuss your options with respect to those applications. 

C. Word’s Built-In Metadata Removal Tool: To access it, just click the File menu  
Info (left side of the screen)  Check for Issues button  Inspect Document.  

 

D. Alternative Programs for Removing Metadata: There are several third party tools 
that remove metadata from files you email.  More importantly, they all interrupt 
the send command and ask you if you want to remove metadata.  For those that 
worry about forgetting to remove metadata before sending a file, this is a critical 



Affinity Consulting Group Page 23 

How To Protect Yourself While Trading Documents Electronically 

feature.  Highly rated products include docsCorp cleanDocs1, BigHand Scrub2, and 
Litera Metadact3.  Anyway, when you email a Word, Excel or PowerPoint 
attachment, WorkShare Protect intercepts that send command and presents you 
with this: 

E. Adobe Acrobat Metadata Removal Tool:With Acrobat X & XI, you need to click 
the Tools button (right side of the screen)  Protection  Remove Hidden 
Content.  With Acrobat DC, click Tools  Redact  Sanitize Document button.  
When you get to the next dialog (see below), make sure you click Click Here so 
you can see what it finds. 

 

If any hidden items are found, they are listed in the Examine Document dialog box 
with a selected check box beside each item.  Make sure that the check boxes are 
selected only for the items that you want to remove from the document. 

 
1 See https://bit.ly/2OjnovC 
2 See https://bit.ly/3ci9j9D 
3 See https://www.litera.com/products/legal/metadact/ 

https://bit.ly/2OjnovC
https://bit.ly/3ci9j9D
https://www.litera.com/products/legal/metadact/
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1. Items You Can Remove:  

 

a. Metadata: Metadata includes information about the document 
and its contents, such as the author’s name, keywords, and 
copyright information, that can be used by search utilities. To view 
metadata, choose File menu  Properties. 

b. File Attachments: Files of any format can be attached to the PDF 
as an attachment. To view attachments, choose View menu  
Navigation Panel  Attachments. 

c. Annotations And Comments: This includes all comments which 
were added to the PDF using the comment and markup tools, 
including files attached as comments. To view comments, choose 
View  Navigation Panel  Comments. 

d. Form Field Logic Or Actions: This item includes form fields 
(including signature fields), and all actions and calculations 
associated with form fields. If you remove this item, all form fields 
are flattened and can no longer be filled out, edited, or signed.  

e. Hidden Text: This option indicates text in the PDF that is either 
transparent, covered up by other content, or the same color as the 
background. To view hidden text, click Preview. Click the double 
arrow buttons to navigate pages that contain hidden text, and 
select options to show hidden text, visible text, or both.  
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f. Hidden Layers: PDFs can contain multiple layers that can be shown 
or hidden. Removing hidden layers removes these layers from the 
PDF and flattens remaining layers into a single layer. To view layers, 
choose View menu  Navigation Panel  Layers. 

g. Bookmarks: Bookmarks are links with representational text that 
open specific pages in the PDF. To view bookmarks, choose View 
menu  Navigation Panel  Bookmarks. 

h. Embedded Search Index: An embedded search index speeds up 
searches in the file. To determine if the PDF contains a search 
index, choose Advanced menu  Document Processing  Manage 
Embedded Index. Removing indexes decreases file size but 
increases search time for the PDF. 

i. Deleted Hidden Page And Image Content: PDFs sometimes retain 
content that has been removed and which is no longer visible, such 
as cropped or deleted pages, or deleted images. 

2. Select Items to Remove: Click Remove All Checked Items to delete 
selected items from the file, and click OK. When you remove checked 
items, additional items are automatically removed from the document: 
digital signatures; document information added by third-party plug-ins and 
applications; and special features that enable Adobe Reader users to 
review, sign, and fill in PDF documents. 

3. Save File: Choose File menu  Save, and specify a filename and location. 
If you don’t want to overwrite the original file, save the file to a different 
name, location, or both. The selected content is permanently removed 
when you save the file. If you close the file without saving it, you must 
repeat this process, making sure to save the file.  

VI. CONSOLIDATE PROPOSED CHANGES FROM MULTIPLE REVIEWERS: 

A. Nature of the Problem: The common problem here is that a lawyer needs to send 
out a document for comment to multiple people.  Each recipient makes proposed 
changes and then emails them back.  Now the lawyer has to figure out who made 
what changes and encapsulate those changes into a single master document.  This 
task can be accomplished using Word documents or PDFs.  Below, I’ll explain each 
method. 

B. Using Microsoft Word: For purposes of this example, let’s assume my original 
document is called Contract v1.doc and the documents containing comments that 
I received back are Contract v2 - Lisa.doc, Contract v3 - Jim.doc and Contract v4 - 
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Paul.doc.  To combine these proposed changes into a single document, follow 
these steps: 

• First you go to the Review ribbon, then click the Compare button and choose 
Combine. 

 

• Now compare v1 to v2 and note how I’ve chosen to label the changes and very 
importantly, where the "show changes in" will occur: 
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• Word will now open the original document and have transferred Lisa’s 
proposed changes INTO the original.  Just save it.  Now repeat the foregoing 
process comparing v1 with v3.  This adds Jim’s proposed changes to the 
original (and leaves Lisa’s there as well).  Repeat for v4 and you’re done.  Only 
slightly laborious, but the end result is worth the time.  If you have Word set 
to track changes by author, then each person’s proposed changes will show 
up in the final document in a different color. 

C. Using Adobe Acrobat: 

1. Choose a Review Type: There are three types of reviews: 

a. Email Based Reviews: Email-based reviews are ideal for soliciting 
feedback from individuals who either don’t have access to your 
server (such as opposing counsel).  

In an email-based review, the drafter sends a PDF to reviewers as 
an email attachment. Reviewers can add comments (proposed 
changes, etc.) to the PDF and return the document to the originator 
by using the Send Comments button in either the Comment & 
Markup toolbar or the document message bar. When receiving 
these comments, the initiator can merge them into their copy of 
the PDF.  

The primary limitation to email-based reviews is that participants 
can’t view each other's comments during the review. Initiators can 
view comments only after receiving them. 

b. Shared Reviews: Shared reviews are best for groups that work 
behind a firewall and have access to a remote server. Shared 
reviews are the most collaborative form of review because 
participants can read and reply to each other's comments whether 
they review the PDF locally, as an email attachment, or on a remote 
server. Reviewers outside the firewall can also participate by 
sending their comments to a reviewer within the firewall, who then 
publishes them to the shared PDF.  

Of all the managed reviews, shared reviews provide the most 
detailed information about the active review. A notification feature 
lets you know when new comments are available, even when 
Acrobat is closed, and you’re informed of all recent review activity 
each time you open the PDF. Published comments are saved to the 
server and to the local hard drive, and Acrobat synchronizes 
comments between these two locations at regular intervals to 
download all the latest comments and changes.  
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c. Browser Based Reviews: Like shared reviews, browser-based 
reviews are suitable for collaborative groups with access to a 
shared server. Reviewers can view each other's comments during 
the review process. In a browser-based review, the initiator 
uploads a PDF to the server and then sends an email invitation to 
reviewers. The email includes a setup file that, when clicked, opens 
the PDF in the default browser. Reviewers click the Send Comments 
button in the Comment & Markup toolbar to upload their 
comments, which are stored in a comments repository on the 
shared server.  

Browser-based reviews lack many of the advantages of shared 
reviews in terms of setup and tracking tools, and support for 
network folders. In addition, Acrobat must download all comments 
in the PDF each time you join the review, often a time-consuming 
process. For these reasons, Adobe recommends shared reviews as 
the preferred collaborative method. 

2. Send By Email For Review: In order to send a PDF for review by email, just 
follow these steps: 

a. Create PDF: It doesn't matter what method you use for creating the 
PDF in the first place.  This process is a bit easier if you open the 
PDF you want to send in Acrobat first, and then initiate.  However, 
you can also choose the PDF you want to work with after you 
initiate the process.  

b. Initiate Email Review Process: In Acrobat 8 or 9, you do this by 
clicking the Comment button, then choosing Attach for Email 
Review from the menu that appears.   

 

You are now presented with this screen.  If you have already 
opened the PDF you intend to work with, then it will be listed under 
"Specify a PDF...".  Otherwise, you can choose the PDF you want to 
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work with my clicking the Browse button.  After the PDF you want 
is identified, click the Next button. 

 

In Acrobat X & XI, you initiate this process by clicking the Comment 
button  Send for Email Review under the Review subheading. In 
Acrobat DC, click Tools  Send for Comments. 

c. Invite Reviewers: If you click the Address Book button, Acrobat will 
take you to the Outlook address book and you can easily choose 
email addresses for the recipients.  Otherwise, you can simply type 
email addresses in the window to the right of the Address Book 
button. 

 

d. Preview Invitation: Now you'll be presented with the dialog shown 
below.  You'll notice that the instructions for the recipient are 
already setup by Adobe Acrobat.  Click the Send Invitation button. 
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e. Send Invitation: Once you click the Send Invitation button in the 
previous dialog, Acrobat will automatically send out an email to the 
recipient(s). 

When the recipient opens the attachment to the foregoing email, 
they'll see a full explanation in Acrobat of what you've initiated and 
how it works.  

The "Commenting" toolbar automatically opens and gives the user 
the option for adding notes, inserting text, deleting text, etc., even 
if the recipient doesn't own the full version of Adobe Acrobat.  After 
the recipient makes proposed changes, he/she can simply click the 
Send Comments button on the Commenting toolbar and Acrobat 
will attach the annotated PDF to an email and automatically send 
it back to you. 

f. Merge Comments: When the PDF shows up in your inbox, double-
click it.  You'll be presented with the screen below providing you 
options for merging the sender's comments into your master.   
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If the PDF you sent in the first place is still in the same location, you 
can add the sender's comments to your master with one click (or 
not).  So a very important aspect of an email review is that you can 
send the same PDF document to as many people as you want and 
have them review it independently.  Whenever they send back 
their comments, you can just merge them into your master PDF or 
save them as separate PDFs.  Later, you can merge them into your 
master if you'd like (you don't have to do it as soon as the 
annotated PDF shows up).   

Furthermore, if you decide not to merge the comments into the 
master at this point, you can always do it later by choosing "Merge 
Comments into Master PFD" from the Comments menu in Acrobat. 

VII. AVOID CONFUSION WHEN WORKING WITH MULTIPLE VERSIONS: 

A. Common Problems With Version Control: Here are a couple of the problems you 
want to avoid: 

• You want to obtain feedback from others but don’t want to modify the original 
document you’re sending out.  What can you do to make sure that the original 
isn’t accidentally over-written with the modified one you receive back? 

• You are creating more and more versions of a document as it goes through the 
negotiation/revision process.  How do you keep track of all of the versions and 
not make a mistake regarding which version is current? 



Affinity Consulting Group Page 32 

How To Protect Yourself While Trading Documents Electronically 

B. Strategies for Avoiding Versioning Problems: 

1. Tag Every Negotiated File With A Version Number: It’s a good idea to tag 
negotiated electronic documents with a date and a version number.  For 
example, I might have the following series of documents: 

• Jenco Lease v1 2008-12-01.docx 

• Jenco Lease v2 2008-12-01.docx 

• Jenco Lease v3 2008-12-03.docx 

• Jenco Lease v4 2008-12-04.docx 

The date is the date you sent the file or the date it was received.  Since you 
have 255 characters to name a file on a Windows computer, you could also 
expand your file naming convention to provide more information. For 
example, the foregoing files could also look like this: 

• Jenco Lease v1 2008-12-01 - Original Emailed to Jenco Counsel.docx 

• Jenco Lease v2 2008-12-01 - Reflects Language Jenco Will Accept.docx 

• Jenco Lease v3 2008-12-03 - Redline Comparing v1 and v2.docx 

• Jenco Lease v4 2008-12-04 - Version Sent Back to Jenco for 
Comment.docx 

a. Make Sure You Save Every Incoming Document As A New Version: 
If typically receive documents via email and it’s a good idea to get 
in the habit of right-clicking the attached document(s), choosing 
Save As, and giving the document a new version number (Jenco 
Lease v3.docx).Set Password to Modify or Make Your Original 
Document Read Only: If you make your original document "read-
only," then you cannot accidentally over-write it with a more 
recent version.  Just follow these steps in Word 2007:In Word 2007, 
click the Microsoft Office Button  Save As.  In Word 2010/13/16, 
click the File menu  Save As. 

b. Click the Tools button at the bottom of the Save As dialog and 
choose General Options. 
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c. Enter a password to open or simply check Read-only (which we 
recommend). 

 

2. Consider A Document Management System ("DMS"): If your practice 
involves the creation and tracking of many documents on a daily basis, it is 
worth investigating document management systems which can make this 
process bullet proof.  Document Management is the process by which we 
store, classify, search, share, and eventually retrieve our documents.  A 
DMSs are simply hardware/software systems that automate the document 
management process.  Specifically, a DMS provides an organization with 
the tools to create, manage, control, and distribute electronic documents.  
As it relates to version control, all major DMS players offer powerful 
features in this regard; and they allow you to maintain multiple versions 
within a single file so that you don’t end up with a clutter of many versions 
floating around.  For example, we use Worldox (www.worldox.com) for 
this task and it will allow me to save up to 256 versions of every file.  When 
save a document with Worldox, you get the following options every time: 
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VIII. MAKE IT EASY FOR A NON-TECHIE TO PROVIDE FEEDBACK ON A DOCUMENT: Personally, 
I hate it when someone sends me proposed changes which have been hand-written on a 
hard copy of the original document.  These can take a long time to recapitulate into the 
original electronic document, it introduces a big margin for transcription error, and it’s 
often impossible to read someone else’s handwriting.  Therefore, I always request that 
proposed changes be delivered to me electronically.  Unfortunately, you’re going to work 
with non-techie folks who just don’t know how to use tools like "track changes" or 
Acrobat’s annotation features.  Here are some options for making this as easy as possible 
on a non-techie user. 

A. Using Word, Turn on Track Changes Before You Send The Document and Lock It 
On: This option is completely explained in paragraph IV.C. on page 18 above.  This 
is easy on the recipient because all they must do is made their proposed changes 
to the document and Word will track all of those changes as they’re made. 

B. Using Acrobat, Send a PDF Using Acrobat’s Review and Comment Feature: This 
option is completely explained in paragraph IV.F. on page 20  above.  This feature 
makes it very easy on the recipient to electronically annotate the document and 
Acrobat provides full instructions on the sample email that it produces to send the 
document out for review.  As described previously, if this feature is initiated from 
within Acrobat Pro versions 8 or 9, it does not matter what version of Acrobat or 
Reader the recipient is using. 

C. Go Over The Document Together via Web Meeting: This option is more fully 
described in paragraph XI which appears on page 38.  Briefly, if you have a web 
meeting service, then you can easily show someone else the document you’re 
working on real-time while you talk on the phone.  If the other person is not 
particularly tech savvy, this may be an easy way for them to comment directly on 
your document without either of you even getting up from your desks. 
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IX. PROTECTING CONFIDENTIALITY: The document is extremely confidential.  What can you 
do to ensure that only the intended recipient receives the document if you’re sending it 
via email?  There are many options to increase your security and here are a couple of 
good suggestions: 

A. Use Encrypted Email: You have no expectation of privacy using regular email.  
Therefore, if you want privacy, you’re going to need some other tools like an 
encryption program.  Here are a few options for easy email encryption: 

1. EchoWorx Encrypted Mail:  http://tinyurl.com/h6sm668 

2. Hushmail:  https://www.hushmail.com/ 

3. Office 365 Message Encryption:  http://bit.ly/2L8zW2I 

4. Protected Trust:  https://envoy.protectedtrust.com/  

5. RMail:  http://www.rmail.com/ - registered email service which can prove 
delivery + encrypted email 

6. SenditCertified:  http://www.senditcertified.com/ and note that they 
offer discounts through several bar associations. 

7. ShareFile:  https://www.sharefile.com/ 

8. Trustifi:  https://trustifi.com/  

9. ZixMail: https://www.zixcorp.com/ 

B. Use A Document Management System: Most good document management 
systems allow you to securely share documents with individuals inside or external 
to your organization.  For example, Worldox, iManage Work, and NetDocuments 
all allow this. 

C. Use A Subscription Based File Sharing Service: These services allow you to create 
secure places on the web where documents can be shared with others to whom 
you grant access.  My favorite of the options below is ShareFile, but they're all 
good: 

1. ShareFile by Citrix:  https://www.sharefile.com/ - This is a fantastic service 
that allows you to create virtual "rooms" for others and share documents 
with them securely.  You decide what rights each user has to the collection 
of documents.  Simple and powerful. 

2. Merrill DataSite Virtual Data Room:  See http://tinyurl.com/laam53o. 

http://tinyurl.com/h6sm668
https://www.hushmail.com/
http://bit.ly/2L8zW2I
https://envoy.protectedtrust.com/
http://www.rmail.com/
http://www.senditcertified.com/
https://www.sharefile.com/
https://trustifi.com/
https://www.zixcorp.com/
https://www.sharefile.com/
http://tinyurl.com/laam53o
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3. Firmex Virtual Data Room:  See https://www.firmex.com/. 

4. SmartRoom Virtual Data Room:  See http://smartroom.com/. 

5. Ansarada Virtual Data Room:  See https://www.ansarada.com/ 

6. IntraLinks Virtual Data Room:  See http://preview.tinyurl.com/lt6d899. 

7. Microsoft Office 365 or OneDrive for Business:  OneDrive is Microsoft's 
cloud storage offering and it comes with nearly every Office 365 plan.  For 
only $5/user/month (Business Essentials plan), you get 1 TB of online 
storage.  See this:  http://tinyurl.com/h9mdn2v 

8. G Suite by Google Cloud:  The Basic edition is $5/user/month and includes 
30 GB of cloud storage; the Business edition is $10/user/month and 
includes unlimited cloud storage.  See your options here:  
http://tinyurl.com/kkocuto 

9. Dropbox Business Standard or Advanced:  Standard is $12.50/user/month 
and Advanced is $20/user/month.  For an explanation of their business 
plans, see https://www.dropbox.com/business/plans-comparison. 

10. SpiderOak Professional:  This service offers complete encryption so 
thorough that not even SpiderOak employees can get to your data.  For 
$10/user/month, you get 100 GB of storage.  See this for more:  
https://spideroak.com/business_pricing/ 

11. Syncplicity: See  https://www.syncplicity.com/. 

12. Box.com:  https://www.box.com/pricing 

13. TrueShare: http://www.trueshare.com/ 

14. FileGenius:  http://www.filegenius.com/ 

15. OneHub:  Secure file sharing - see https://onehub.com. 

D. Encrypt The Files Themselves: Both Word and Acrobat offer ways to encrypt Word 
and PDF files, respectively.  This simply means that they cannot be opened or read 
unless the correct password is entered. 

1. Encrypt Word Files: Simply open the document you would like to encrypt.  
In Word 2007, click the Office Button  Prepare  Encrypt Document.  
Enter a strong password and click OK.  In Word 2010/13/16, click the File 
menu  Info (left side)  Protect Document button  Encrypt with 
Password. 

https://www.firmex.com/
http://smartroom.com/
https://www.ansarada.com/
http://preview.tinyurl.com/lt6d899
http://tinyurl.com/h9mdn2v
http://tinyurl.com/kkocuto
https://www.dropbox.com/business/plans-comparison
https://spideroak.com/business_pricing/
https://www.syncplicity.com/
https://www.box.com/pricing
http://www.trueshare.com/
http://www.filegenius.com/
https://onehub.com/
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2. Encrypt PDF Files: Open the PDF you would like to encrypt.  In Acrobat 8 
or 9, click the Secure button at the top of the screen  choose Password 
Encrypt.  In the next dialog, check the box that says "Require a password 
to open the document" and enter a password.  In Acrobat X/XI, click the 
Tools button  Protection subheading  Encrypt  Encrypt with 
Password.  In Acrobat DC, click Tools  Protect. 

X. DIGITAL SIGNATURES: 

A. What They Are: This is unquestionably one of the most confusing topics I’ve ever 
encountered in legal technology, mostly because any explanation of it is techno-
babble overload.  So I can’t avoid all of the techno-speak when explaining it, but 
I’ll try to limit this to what you need to know. 

A digital signature is like a conventional handwritten signature in that it identifies 
the person signing a document. Key benefits of digital signatures are: 

1. Unlike a handwritten signature, a digital signature is difficult to forge 
because it contains encrypted information that is unique to the signer. 

2. Recipients can easily verify the authenticity of the digital signature (you 
simply click on the signature in a PDF to verify it). 

3. Once digitally signed, neither the signature nor the document signed can 
be altered without detection. 

4. Digital signatures are legally binding in the U.S. so an electronic signer 
cannot later deny responsibility or that they actually signed the electronic 
document. 

B. Digital Signatures Are Not Electronic Signatures: Digital signatures are created 
and verified by cryptography, the branch of applied mathematics that concerns 
itself with transforming messages into seemingly unintelligible forms and back 
again.  The technology behind digital signatures is an industry standard known as 
Public Key Infrastructure (PKI), which guarantees data integrity and non-
repudiation of transactions. The digital signature cannot be copied, tampered or 
altered. On the other hand, Electronic signatures are electronic images that are 
physically or logically attached to the signed data. Adding a sentence "I, Barron 
Henley, sign this document" is good enough to be considered as an electronic 
signature; however, it is clear that electronic signatures are easy to forge, unlike 
digital signatures. 

C. How They Work:  An explanation of digital signatures is on SearchSecurity’s 
website and authored by Ben Lutkevich, Vicki-Lynn Brunskill and Peter Loshin 
which you can read here:  https://bit.ly/3nFEdg5   

https://bit.ly/3nFEdg5
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D. How You Obtain a Digital Signature: If you have an Adobe Acrobat DC 
subscription, you already have Adobe Sign and you just have to set it up.  
Otherwise, there are many services you can sign up for including: 

1. RightSignature:  www.rightsignature.com 

2. DocuSign:  www.docusign.com 

3. Hellosign:  https://www.hellosign.com/ 

4. Adobe Sign:  http://tinyurl.com/z84af3r 

5. OneSpan:  https://www.onespan.com/products/esignature-professional-
plan 

E. Digital Signatures Should Be On Your Radar:  This is a great way to lock down a 
document, sign yourself and/or get signatures, and expedite the whole process.   

XI. SHOW OTHERS THE DOCUMENT YOU’RE WORKING ON VIA WEB CONFERENCE: 

A. What Is a Web Conference? A "web conference" (aka web meeting) is a live 
meeting (or presentation) wherein the participants are connected via the Internet. 
As such, it doesn't matter where the participants are physically located as long as 
they have a computer and high speed Internet access.  In a web conference, each 
participant typically sits at his/her own computer and is connected to other 
participants via the internet.  Most often, all participants view one participant's 
computer (host or presenter); and the participants can usually hear one another 
(conference call or VoIP conferencing using their computers).  In some cases, 
everyone can hear the presenter but the presenter cannot hear any of the 
participants (typical for a webinar).  Sometimes webcams are utilized so that 
participants can see the presenter's face (or other participants' faces). 

B. Common Uses for Web Conferencing: 

• Collaborating on Documents 

• Staff meetings 

• Webinars (web-based seminars) 

• Presentations 

• In-house training 

• Distance learning 
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• Product demonstrations 

• Technical support 

C. Web Conferencing Primary Benefits: 

1. Share Documents and Collaborate: When you want to show someone a 
document you're drafting (to solicit input, discuss something, etc.), web 
meetings are perfect.  Since most services allow you to give control of your 
keyboard and mouse to other participants in the web meeting, they could 
even deliver their input directly into your document. 

2. Far Less Expensive Than Meeting In Person: Many times it is just very 
expensive (in terms of travel costs and/or time wasted traveling) to get 
everyone in the same room.  Web conferencing is wonderful in these 
situations. 

3. Very Fast: I can set up an impromptu web conference in 90 seconds and 
the person I’m speaking with on the phone will be able to see my 
computer.   

4. Less Disruptive: There's a lot to be said for not having to leave your office 
to attend meetings.  Plus, you can often multi-task while attending a web 
meeting (answer an email, respond to an instant or text message, sign 
something, etc.).  Of course, multi-tasking in a face-to-face meeting is 
often impossible or incredibly rude.  

5. Demonstrate Any Application: It is much more efficient to show someone 
an application on your computer rather than try and describe it to them 
orally. 

D. Web Conferencing Service Features: Note, not all web conferencing systems offer 
all of the following features.  However, this is a good list of what to look for. 

1. Automated Invitations and Scheduling: Many services make it easy to 
design and deliver invitations to a meeting either as a plain email or as a 
Microsoft Outlook Meeting Request.  The meeting request is particularly 
useful since it also puts the meeting on the participants Outlook calendar 
as part of the invitation. 

2. Multiple Presenters: Since meetings frequently include multiple 
participants who need to share their computer with the other attendees, 
most services allow for the meeting organizer to turn the presentation 
over to someone else in the meeting.  Upon doing so, the new presenter's 
computer will become visible to the other attendees. 
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3. Screen-Sharing: Most web conferencing services will let the presenter 
show his/her desktop or certain documents with other meeting 
participants.  Some provide control over what is shared.  For example, 
since I have two monitors connected to my laptop, my GoToMeeting 
account allows me to share either or both monitors, or only specific 
applications (see screen show below): 

 

4. Drawing and Annotation Tools: The presenters almost always have these 
tools (drawing pen, highlighter, spotlight, arrow, digital sticky notes) and 
most services allow the presenter to give those tools to meeting 
participants as well. 

5. Whiteboard: This is the digital equivalent to dry-erase whiteboards.  If you 
use these in your face-to-face meetings, you may want a web conferencing 
system that offers it as well. 

6. Text Chat: Instant-messaging is available in every web conferencing 
system I've looked at.  You can typically text an individual or all attendees 
at once. 

7. Telephone Conferencing: Many web-conferencing products include some 
form of voice-calling feature, allowing you to talk to fellow participants 
while the meeting is in progress. Some services include a free 
teleconferencing option, and others charge to use this feature. 

8. VoIP Communication: Some services also offer audio communication in 
the form of Voice over Internet Protocol (VoIP), a technology that allows 
users to make telephone calls over the Web. Generally speaking, VoIP 
offers cheaper calling rates than teleconferencing services, though the 
quality of the calls is often not as good. Note that in order to use a VoIP 
application, all callers will need to purchase headsets that can be 
connected to their computers (your computer is the phone). 
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9. Videoconferencing: If you need your web meetings to be closer to in-
person meetings, you might want to consider a service that allows 
videoconferencing as well.  Videoconferencing allows participants with 
webcams (small, inexpensive cameras that attach to your computer) to 
broadcast a video image of themselves into the online meeting. There is 
often an additional fee to use this type of service. 

10. Recording: Many services offer the ability to record meetings (audio and 
video) as a video file which can be played in Windows Media Player (for 
example). 

11. Subscription or Per Use Pricing: Some services offer only a flat fee per 
month or year for unlimited meetings.  Others charge only per use or for 
usage time.  Some offer both options.  Make sure you understand the 
arrangement before you sign up. 

E. Categories of Web Conferencing Service: Most web conferencing services offer 
many products.  The basic categories are as follows: 

1. Meeting Accounts You Can Share: This level of service usually 
contemplates multiple meeting organizers within your office and typically 
costs more than the "personal" accounts.  These accounts usually allow up 
to 15 people in the meeting. 

2. Meeting Accounts Personal to an Individual: This account is specific to one 
individual and only they are allowed to host meetings (others cannot use 
it without violating the license agreement).  These accounts also usually 
allow up to 15 people in the meeting. 

3. Accounts Designed to Render Technical Support: This type of service 
allows you to take control of a customer's computer via the Internet to 
resolve technical issues.  This is typically a one to one connection. 

4. Accounts Designed for Remote Control: This is an account like 
gotomypc.com which allows you to remotely control another computer via 
the Internet. 

5. Accounts Designed for Webinars: Many of these will allow up to 1,000 
participants in a webinar.  These are typically used for presentations to 
very large groups.  

6. Accounts Designed for Training: These accounts are more like virtual 
classrooms and offer features like testing, and breakout sessions.  The 
"teacher" often has the ability to observe the screens of the students in 
the class (whether the students want them to or not).  Some training 
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accounts also offer upgrades which allow the training classes to be 
recorded so students can engage in "anytime" learning. 

F. Competitors: 

1. Zoom:  https://zoom.us/ 

2. Join.Me: http://join.me 

3. GoToMeeting:  www.gotomeeting.com 

4. WebEx Meetings: www.webex.com 

5. Microsoft Teams:  https://bit.ly/2KAQXHj 

6. Adobe Connect Meetings:  http://tinyurl.com/y8877ncu 

7. BlueJeans:  https://www.bluejeans.com/ 

8. ClickMeeting:  https://clickmeeting.com/ 

G. We Recommend Zoom: However, all of the services listed above have free trials 
so you can definitely test drive them before you buy. 

XII. SHARE ELECTRONIC DOCUMENTS WITHOUT USING EMAIL: 

A. Microsoft Office 365 or OneDrive for Business:  Not only can you share 
documents with OneDrive, but if a Word, Excel or other MS Office file is stored in 
OneDrive and shared, then multiple users can edit the file simultaneously.  For 
more information on this, see https://onedrive.live.com. 

B. Google Drive:  With Google Drive, you can share documents and work on them 
simultaneously with other users.  See your options here:  
https://www.google.com/drive/ 

C. Dropbox Business:  See https://www.dropbox.com/business/pricing for 
information about plans. 

https://onedrive.live.com/
https://www.google.com/drive/
https://www.dropbox.com/business/pricing
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D. SpiderOak Professional:  This service offers complete encryption so thorough that 
not even SpiderOak employees can get to your data.  For $10/user/month, you 
get 100 GB of storage.  See this for more:  https://spideroak.com/about/price-list 

E. ShareFile by Citrix:  www.sharefile.com - This is a fantastic service that allows you 
to create virtual "rooms" for others and share documents with them securely.  You 
decide what rights each user has to the collection of documents.  Simple and 
powerful. 

F. TrueShare: www.trueshare.com - Similar to ShareFile, a little less expensive, a 
little more difficult to use. 

G. FileGenius:  www.filegenius.com - similar to TrueShare and ShareFile. 

H. OneHub:  Secure file sharing - see https://onehub.com. 

XIII. PREVENTING FUTURE EDITING WHEN DOCUMENT IS IN FINAL FORM: 

A. Problem With Sending Word Files: If you don’t want your document to be edited 
after you send it to someone, then do not send them Word files.  Even if you 
"protect" the document and make it read only, the text can still be copied and 
pasted into a new document, edited, printed and signed. 

https://spideroak.com/about/price-list
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B. Use PDFs Instead: One of the most important characteristics of PDFs is that their 
text cannot be edited or changed.  They can be further locked down to prevent 
text from being copied from them, or from unauthorized persons opening them.   

C. PDF Security: For example, by clicking the File menu, then Properties, then 
Security Tab, you can control the following things: 

1. Prevent Opening of the PDF: For instructions, see paragraph IX.D.2. on 
page 37 above. 

2. Printing: This setting allows you to control whether users can print; and if 
so, what level of printing they're allowed.  Options include: 

• None: Prevents users from printing the document. 

• Low Resolution (150 dpi): Users can print at no higher than 150-dpi 
resolution. Printing may be slower because each page is printed as a 
bitmap image. This option is available only if the Compatibility option 
is set to Acrobat 7 or later. 

• High Resolution: Lets users print at any resolution, directing high-
quality vector output to PostScript and other printers that support 
advanced high-quality printing features. 

3. Changes: This setting controls which editing actions are allowed. 

• None: Prevents users from making any changes to the document, such 
as filling in form fields and adding comments. 

• Inserting, Deleting, And Rotating Pages: Allows users to insert, delete, 
and rotate pages, and create bookmarks and thumbnails. This is only 
available for high (128-bit RC4 or AES) encryption. 

• Filling in Form Fields and Signing Existing Signature Fields: This allows 
users fill in forms and add digital signatures. This option does not allow 
users to add comments or create form fields (only available for high 
encryption). 

• Commenting, Filling In Form Fields, And Signing Existing Signature 
Fields: Allows users to add comments, digital signatures and fill in 
forms. This option does not allow users to move page objects or create 
form fields. 

• Page Layout, Filling in Form Fields, and Signing: This allows users to 
insert, rotate, or delete pages and create bookmarks or thumbnail 
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images, fill out forms, and add digital signatures. This option does not 
allow users to create form fields (only available for low encryption). 

• Any Except Extracting Pages: Allows users edit the document, create 
and fill in form fields, and add comments and digital signatures. 

4. Enable Copying of Text, Images, and Other Content: This option allows 
users to select and copy the contents of a PDF.  If you don’t want recipients 
to be able to copy the text of your PDF into a Word document, then you 
want to make sure this is turned off. 

5. Enable Text Access For Screen Reader Devices For The Visually Impaired: 
This allows visually impaired users to read the document with screen 
readers, but doesn’t allow users to copy or extract the document’s 
contents (only available for high encryption).  
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